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1. MICROSOFT WORD (NC) 

1.1.  Chia Sẻ Và Bảo Quản Dữ Liệu  

Chương này giúp người học nâng cao kỹ năng chia sẻ và bảo quản dữ liệu, biết cách 

tùy chỉnh Ribbon và Quick Access Tool Bar, tạo kiểu mẫu cho tài liệu. Cuối chương giáo 

trình sẽ cung cấp một số cách làm danh thiếp, mẫu đơn xin việc trong ngân hàng... Cụ thể 

người học sẽ được tìm hiểu kỹ về các nội dung: 

 Cấu hình tùy chọn trong Word 

 Thiết lập chế độ bảo vệ tài liệu 

 Thiết lập kiểu mẫu cho tài liệu 

1.1.1.  Cấu Hình Tùy Chọn Trong Word 
 General 

Để định dạng dữ liệu một cách nhanh chóng: Thay đổi font chữ, cỡ chữ, màu chữ… 

khi chúng ta bôi đen một đoạn văn bản nào đó, word cung cấp một công cụ thu nhỏ để hỗ trợ 

chúng ta làm điều này (hình 1.0): 

 

Hình 1.0 

Mặc định khi cài đặt Microsoft Office công cụ thu nhỏ này đã được hỗ trợ, nhưng 

trong một số trường hợp nếu như công cụ thu nhỏ này không hiển thị thì ta sẽ mở màn hình 

Word Option lên để thiết lập, ở đây giáo trình hướng dẫn 2 cách: 

- Cách 1: Vào Tab File / chọn mục Options 

- Cách 2: Nhấn tổ hợp phím Alt+F+T 

Màn hình Word Options sẽ hiển thị ra như bên dưới (hình 1.1): 

 

Hình 1.1 
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Ta tick vào chọn lựa “Show Mini Toolbar on selection” trong  tab General rồi nhấn nút 

OK. 

 Display 

Trong quá trình soản thảo văn bản không tránh khỏi những sai sót về kỹ thuật, Word 

cung cấp cho chúng ta cách nhìn tổng thể về kỹ thuật soạn thảo để chúng ta có thể sửa chữa 

những lỗi kỹ thuật này một cách chính xác: 

 

Hình 1.2 

Tại trang Display, ta tick vào “Show All formatting marks”, hoặc ta có thể chọn 

biểu tượng trực tiếp trong màn hình soạn thảo: 

 

Hình 1.3 

Hình 1.4 là ví dụ cho chúng ta biết các kỹ thuật được sử dụng trong quá trình soạn thảo: 

 

Hình 1.4 
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 Proofing 

Một trong những tính năng tuyệt vời của bộ Office đó là chức năng kiểm tra chính 

tả và ngữ pháp, nó giúp tăng tốc độ soạn thảo của người sử dụng rất nhiều. Trong bản Office 

2013 chúng ta có thể tải công cụ kiểm soát lỗi Tiếng Việt tại địa chỉ: 

http://www.microsoft.com/vi-vn/download/details.aspx?id=35400. 

Trong trang Proofing của màn hình Word Options, ta quan sát mục “When 

correcting spelling and grammar in Word”. Mục này cho phép chọn kiểu kiểm soát lỗi: 

chính tả, ngữ pháp. Muốn chọn kiểm tra chính tả thì ta tick vào các mục có chữ “spelling”, 

muốn kiểm tra ngữ pháp ta tick vào các mục có chữ “gammar” , sau khi chọn lựa xong thì 

nhấn nút OK để lưu thiết lập (hình 1.5) 

 

Hình 1.5 

Những từ sai chính tả sẽ được gạch chân màu đỏ, sai ngữ pháp sẽ gạch chân màu xanh. 

Để chỉnh sửa những từ bị sai này, ta bấm chuột phải vào những từ đó Word sẽ đưa ra 

những đề nghị để thay đổi cho phù hợp (hình 1.6): 

http://www.microsoft.com/vi-vn/download/details.aspx?id=35400
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Hình 1.6 

Như ta thấy, từ “thera” ở trên bị sai chính tả, word gợi ý một số từ mới thay thế cho 

từ sai này. Trong trường hợp này ta sẽ chọn “there”. 

Để có thêm nhiều sự lựa chọn, ta có thể chọn mục “Spelling…” ở cửa sổ trên: 

 

Hình 1.7 

Ở màn hình 1.7, nếu như muốn từ chối sự thay đổi ta chọn Ignore Once (từ chối thay 

đổi từ đang xem xét) hoặc Ignore All (từ chối thay đổi mọi từ trong tài liệu), để chấp nhận sự 

thay đổi ta chọn Change (thay đổi từ đang xem xét) hoặc Change All (thay đổi mọi từ). 
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 Save 

Một trong những chức năng cực kỳ quan trọng và hữu dụng đó là chức năng tự động 

lưu trữ tài liệu của Word. Người sử dụng rất ít khi lưu tài liệu trong quá trình soạn thảo, điều 

này rất nguy hiểm vì có thể máy tính bị tắt bất ngờ (hư máy, cúp điện…) nó sẽ làm mất hết 

dữ liệu. 

Để Word tự động lưu tài liệu đang soạn thảo: Ta tick vào mục “Save AutoRecover 

Information every”, mục này cho phép ta ấn định số phút tự động lưu, ở đây là 10 phút. 

Nếu bạn muốn tự động lưu sau 1 phút thì bạn nhập số 1 vào (hình 1.8): 

 

Hình 1.8 

Mục “AutoRecover file location” là nơi Word tự động lưu tài liệu nếu như tài liệu 

chưa được ta lưu, mục “Default file location” là nơi lưu trữ mặc định khi ta chọn chức năng 

lưu tài liệu. Cả 2 mục này ta đều có thể thay đổi vị trí lưu trữ bằng cách nhấn vào nút 

“Browse…”. 

Một số trường hợp tài liệu phải sử dụng những Font chữ đặc biệt mà các máy tính 

khác không có, nếu ta chép tài liệu này qua máy tính khác thì chắc chắn Font chữ sẽ bị mất 

và có thể  không đọc được dữ liệu. Do đó để các máy tính khác có thể đọc được thì ta tick 

vào mục “Embed fonts in the file”, chức năng này sẽ nhúng Font chữ ta đang sử dụng vào 
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tài liệu nên khi chép qua máy khác thì tài liệu mặc nhiên vẫn đọc được, tất nhiên là dung 

lượng của tài liệu sẽ tăng lên đáng kể và thao tác lưu cũng chậm đi. 

 Customize Ribbon 

Đôi khi ta khởi động Office Word lên nhưng mà không thấy các tab lệnh như hình bên dưới: 

 

Hình 1.9 

Ta không nên lo lắng cho rằng bản Office Word bị hư, trường hợp này là do Ribbon 

bị thay đổi cấu hình. 

Ta mở lại màn hình Word Options/ chọn Customize Ribbon như hướng dẫn ở phần 

trước, hoặc bấm chuột phải vào tab File/ chọn Customize the Ribbon…: 

 

Hình 1.10 

Ta quan sát các tab bên phải màn hình Word Options đã bỏ hết tick, ta muốn hiển thị 

Tab nào lên thì tick vào Tab đó rồi nhấn nút OK.  

 

Hình 1.11 
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Ta cần biết thêm thông tin: 1 Ribbon sẽ có nhiều Tab, 1 Tab sẽ có nhiều nhóm lệnh, 1 

nhóm lệnh sẽ có nhiều lệnh riêng lẻ. Trong một số trường hợp ta cần gom tất cả các lệnh 

thường xuyên sử dụng vào chung 1 Tab để cho việc thao tác định dạng dữ liệu được nhanh 

hơn. Ví dụ ta muốn tạo thêm 1 Tab mới như hình bên dưới: 

 

Hình 1.12 

Như hình 1.12, ta thấy có tab mới tên là “Định dạng”, tab này có 3 nhóm “Nhóm 1”, 

“Nhóm 2” và “Nhóm 3”, mỗi nhóm này có một số lệnh nào đó. 

Các bước để tạo một tab mới như tab “Định dạng” ở trên như sau: 

− Bước 1: Trong màn hình Customize Ribbon, bấm chọn nút “New Tab”. 

− Bước 2: Chọn Tab mới tạo “New Tab” rồi bấm nút “New Group”, ở màn hình 

dưới ta tạo 1 New Tab và 3 New Group (hình 1.13). 

 

Hình 1.13 

− Bước 3: Đổi tên Tab và tên Group theo mục đích sử dụng, chọn các mục cần đổi 

tên rồi bấm nút “Rename…”, màn hình đổi tên hiển thị lên ta nhập tên mới rồi 

nhấn nút OK để đổi (xem hình 1.14): 
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Hình 1.14 

Tương tự như vậy đối với đổi tên Group, chọn từng Group rồi bấm “Rename” để đổi: 

 

Hình 1.15 

Đặt tên và chọn biểu tượng cho Nhóm rồi bấm OK, cứ lặp cho hết các nhóm khác 

cuối cùng ta được như hình bên dưới: 

 

Hình 1.16 

− Bước 4: Thêm các lệnh vào cho các Nhóm ở bước 3 

Trong phần Choose commands (bên trái màn hình) ta chọn bất kỳ lệnh nào đó rồi bấm 

nút “Add>>”, hoặc dùng chuột kéo thả trực tiếp commands vào nhóm lệnh mà ta muốn. 
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Để gỡ bỏ lệnh ra khỏi nhóm, ta chọn lệnh trong nhóm rồi bấm “<<Remove”. Quan 

sát hình 1.17 ta sẽ thấy danh sách các lệnh được đưa vào từng nhóm: 

 

Hình 1.17 

Sau khi kéo thả các command xong, ta bấm “OK” sẽ được kết quả như mong muốn. 

Ta cũng có thể quay trở lại cấu hình ban đầu bằng cách chọn “Reset all customizations”: 

 

Hình 1.18 

 Quick Access Toolbar 

Tương tự như Ribbon, Word cung cấp chức năng Quick Access ToolBar (QAT) để 

hỗ trợ người soạn thảo định dạng văn bản một cách nhanh chóng. 

 

Hình 1.19 
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Như hình 1.19 ta thấy rằng thanh QAT có thể nằm ở bên trên thanh Ribbon hoặc ở 

bên dưới thanh Ribbon tùy vào sở thích của người soạn thảo. 

− Để di chuyển thanh QAT xuống dưới thanh Ribbon: Ta bấm chuột phải vào 

Ribbon/ chọn Show Quick Access Toolbar Below the Ribbon (hình 1.20): 

 

Hình 1.20 

− Để di chuyển thanh QAT lên trên thanh Ribbon: Ta bấm chuột phải vào 

Ribbon/ chọn Show Quick Access Toolbar Above the Ribbon (hình 1.21): 

 

Hình 1.21 

− Ta có thể thêm hoặc xóa các lệnh khỏi thanh QAT. 

− Thêm lệnh vào QAT: Bấm chuột phải vào lệnh bất kỳ trong thanh Ribbon/ chọn 

“Add to Quick Access Toolbar” 

 

Hình 1.22 

− Xóa lệnh khỏi QAT: Bấm chuột vào lệnh bất kỳ trong QAT/ chọn “Remove from 

Quick Access Toolbar” 

 

Hình 1.23 
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1.1.2.  Thiết Lập Chế Độ Bảo Vệ Tài Liệu 
Đối với những tài liệu mang tính nhạy cảm thì việc thiết lập chế độ bảo vệ dữ 

liệu là vô cùng quan trọng. Có nhiều cấp độ bảo vệ tài liệu, ở đây giáo trình sẽ hướng dẫn 

một số cách bảo vệ tài liệu của người sử dụng: 

 Thiết lập thuộc tính chỉ đọc cho tài liệu: 

Tại sao ta phải thiết lập thuộc tính chỉ đọc cho tài liệu? thường thì khi tài liệu là 

phiên bản cuối cùng rồi (tức là đã hoàn chỉnh) thì chủ sở hữu tài liệu sẽ đánh dấu cho người 

đọc biết bằng cách thiết lập Mark as Final. 

Cách thiết lập như sau: Vào tab File/ chọn Info/ chọn Protect Document / chọn Mark 

as Final (hình 1.24): 

 

Hình 1.24 

Sau khi chọn Mark as Final, sẽ có 2 màn hình xuất hiện như bên dưới. Chọn OK để thiết 

lập, chọn Cancel để hủy thiết lập: 

 

Hình 1.25 

Sau khi chọn OK sẽ có thêm một màn hình tiếp theo, ở màn hình này ta tiếp tục chọn 

OK. 

Dưới đây là màn hình của tài liệu được thiết lập là chỉ đọc, chế độ này người sử dụng sẽ 

không thể chỉnh sửa, thêm mới hay là định dạng tài liệu được (hình 1.26): 
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Hình 1.26 

Bấm “Edit Anyway” ở phía bên trên tài liệu để thoát khỏi chế độ chỉ đọc (xem hình 

trên). 

 Thiết lập mật khẩu cho tài liệu: 

Đây là kiểu bảo mật tài liệu mà tới 99.9% người sử dụng chọn lựa để thiết lập cho 

những tài liệu có dữ liệu nhạy cảm, độc giả cũng nên chọn kiểu bảo mật này. 

Cách thiết lập: Vào tab File/ chọn Info/ chọn Protect Document / chọn Encrypt with 

Password (hình 1.27): 

 

Hình 1.27 

Sau khi chọn “Encrypt with Password”, Word sẽ yêu cầu ta nhập 2 lần mật khẩu, tại 

2 lần nhập mật khẩu này ta phải nhập giống nhau. Theo kinh nghiệm thì bạn nên nhập mật 

khẩu có chứa đồng thời: Chữ, số, ký hiệu; tránh lấy mật khẩu là tên hay ngày tháng năm sinh 

hay số điện thoại vì như vậy rất dễ bị lộ: 

− Màn hình nhập mật khẩu lần thứ 1: 
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Hình 1.28 

− Nhập mật khẩu rồi bấm OK sẽ xuất hiện màn hình nhập mật khẩu lần 2: 

 

Hình 1.29 

− Sau khi nhập 2 lần mật khẩu thành công, để kiểm tra lại ta đóng tài liệu hiện tại 

sau đó mở lại tài liệu này, Word sẽ yêu cầu ta nhập mật khẩu để xem: 

 

Hình 1.30 

Bạn chú ý phải nhớ mật khẩu đã nhập, nếu như bạn quên thì không thể mở được tài 

liệu vì Word có cơ chế bảo mật tài liệu rất cao. 

Sau khi thiết lập mật khẩu rồi, nếu muốn tháo bỏ mật khẩu thì ta chỉ cần vào lại màn 

hình thiết lập mật khẩu, ta chỉ việc xóa mật khẩu đi (để trống) rồi nhấn OK. 

 Ngăn chặn chỉnh sửa và định dạng dữ liệu: 

Cấp độ bảo mật này cao hơn “Thiết lập thuộc tính chỉ đọc cho tài liệu”, trường hợp 

này người sử dụng muốn thay đổi hay định dạng lại dữ liệu thì bắt buộc phải nhập mật khẩu. 

Tính năng này rất quan trọng nó giúp bảo quản được thông tin cuối cùng của tác giả, tránh 

được những điều đáng tiếc khi có ai đó cố tình phá dữ liệu. 

Các bước làm như sau:  
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− Bước 1: Vào tab File/ chọn Info/ chọn Protect Document/ chọn Restrict Editing 

(xem hình 1.31): 

 

Hình 1.31 

Sau khi chọn Restrict Editing, Word sẽ cung cấp màn hình Restrict Formating and 

Editing cho phép ta thiết lập chế độ bảo mật tài liệu (hình 1.32): 

− Bước 2: Trường hợp sử dụng nhiều nhất vẫn là không cho phép người đọc chỉnh 

sửa dữ liệu, trong hình 1.32 ta tick vào “Allow only this type of editing in the 

document:” và mục danh sách xổ xuống ta chọn No changes (Read only). 

 

Hình 1.32 
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− Bước 3: Bấm chọn nút lệnh “Yes, Start Enforcing Protection”, Word sẽ yêu cầu 

ta nhập mật khẩu bảo vệ tài liệu: (hình 1.33) 

 

Hình 1.33 

Sau khi bấm chọn OK, tài liệu đã được bảo vệ người sử dụng muốn chỉnh sửa tài liệu 

này thì phải nhập mật khẩu. 

Để có thể chỉnh sửa được nội dung tài liệu thì người sử dụng bắt buộc phải chọn nút 

“Stop Protection” (hình 1.34): 

 

Hình 1.34 

Nếu không thấy màn hình Stop Protection như trên thì ta vào ngược lại bước mở chức 

năng Restrict Editing. 

Khi chọn “Stop Protection”, Word sẽ yêu cầu ta nhập mật khẩu như hình dưới: 

 

Hình 1.35 
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Sau khi nhập mật khẩu và bấm OK thì ta có thể chỉnh sửa tài liệu bình thường, như 

vậy người sử dụng chỉ có thể chỉnh sửa được tài liệu khi có mật khẩu cung cấp từ tác giả tài 

liệu. Chức năng này rất hay, độc giả nên sử dụng. 

Bảng so sánh 3 cấp độ bảo mật ở trên: 

Kiểu bảo mật Cấp độ bảo mật Tóm lược 

Mark as final Thấp nhất Đánh dấu là tài liệu hoàn chỉnh, 

nhưng có thể chỉnh sửa dễ dàng. 

Restrict Editing  Bình thường Đánh dấu chỉ đọc, muốn chỉnh 

sửa phải nhập mật khẩu. 

Encrypt with Password Cao nhất Bảo mật ngay từ đầu, muốn mở 

tài liệu phải nhập mật khẩu. 

 

1.1.3.  Thiết Lập Kiểu Mẫu Cho Tài Liệu 
Khi mới ra trường các sinh viên phải viết đơn tìm việc, hay khi vào làm việc rồi 

công ty giao cho làm những biểu mẫu: Danh thiếp, thư ngỏ, … Không phải ai cũng có kinh 

nghiệm trong việc viết đơn tìm việc hay làm các biểu mẫu, nếu làm không đúng cách đôi khi 

còn lãnh hậu quả nghiêm trọng. Chính vì lý do đó Word đã làm sẵn cho chúng ta các biểu 

mẫu, các quy chuẩn chung nhất cho một nghành nghề nhất định. Chẳng hạn như mẫu đơn 

tìm việc, nếu ứng viên nào trình bày chuyên nghiệp và có đầu tư thì đó là lợi thế của ứng 

viên. Sau đây là một số kiến thức liên quan tới việc thiết lập biểu mẫu. 

 Khái niệm: 

Template là một tập tin mẫu, cho phép tạo một tập tin mới với mẫu đã được tạo sẵn. 

Tập tin mẫu có thể bao gồm tiêu đề, logo, những định dạng khác. Tập tin mẫu có phần đuôi 

là .dotx. 

Trong Word có sẵn các tập tin Template, ta có thể sử dụng bằng cách: 

Chọn File→New→Sample Templates xuất hiện cửa sổ Template, chứa các mẫu Template, 

Chọn một mẫu phù hợp với nội dung của tài liệu sau đó chọn tiếp: 

- Document chọn Create để sử dụng Template. 

- Template chọn Create để sửa Template từ Template có sẵn. 
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Hình 1.36 

 Để tạo kiểu mẫu mới: 

Bạn thiết kế một mẫu để sử dụng làm mẫu cho những tài liệu sau → vào tab File/ Save 

As / chọn nơi lưu 

 

Hình 1.37 – Hộp thoại tạo template mới 

- Trong hộp thoại Save As → Save as type → chọn Word Template (*.dotx). 

- Tự động đường dẫn lưu trữ các Template sẽ được trỏ đến, nhưng bạn cũng có thể lưu 

tại nơi bạn muốn. 

- Và khi bạn muốn sử dụng chỉ cần vào → Tab File → New →Personal → chọn 

Template bạn cần. 

Ví dụ ta cần tạo template cho danh thiếp dưới đây: 
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Hình 1.38 

Giả sử ta lưu mẫu trên với tên “Tao_Template_moi.dotx”, như vậy mỗi lần tạo một 

tài liệu mà ta chọn mẫu là “Tao_Template_moi.dotx” thì ta sẽ có tài liệu giống như mẫu 

trên. 

Xem hình xuất hiện tên mẫu mới sau khi đã lưu template trên (hình 1.39) 

 

Hình 1.39 – Mẫu mới ta vừa tạo 

 Tải kiểu mẫu có sẵn của Microsoft: 

Microsoft cung cấp rất nhiều mẫu cho người sử dụng: Mẫu tổ chức sự kiện, thư ngỏ, 

danh thiếp, đơn tìm việc … (yêu cầu phải kết nối internet). 

Ví dụ tạo mẫu Sơ yếu lý lịch và đơn tìm việc ở Công ty: 

Trong mục Suggested searches , ta tìm tới mục Resume: 
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Hình 1.40 – chọn Resume 

Sau đó tìm tới Job – specific resumes/ chọn Banker resumes: 

 

Hình 1.41 – chọn Sales manager resume 

Sau khi chọn Sales manager resume và bấm “Create”, ta sẽ được mẫu CV tìm việc rất 

chuyên nghiệp. 

Kết quả sau khi tải mẫu CV: 
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Hình 1.42- Mẫu đơn tìm việc với vị trí Sales manager 

1.2. Định Dạng Dữ Liệu 

Chương này giúp sinh viên nâng cao các kỹ năng định dạng văn bản trong Word 

2013, cụ thể sinh viên sẽ được học các kỹ năng sau: 

 Thiết lập font chữ và đoạn văn nâng cao 

 Chia cột cho đoạn văn 

 Công thức toán học 

 Tạo bảng biểu và biểu đồ 

 Cách xây dựng nội dung tái sử dụng trong tài liệu 

 Sử dụng hộp văn bản liên kết và chọn lựa 

1.2.1.  Thiết lập font chữ và đoạn văn nâng cao 
Phần này sẽ ôn tập lại một số định dạng cơ bản, đồng thời hướng dẫn các định dạng 

nâng cao, cụ thể: Cách co giãn và ghép chữ, cách thiết lập các hiệu ứng và kiểu mẫu văn bản. 
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 Định dạng font chữ 

Như ta thường thấy có 3 chức năng định dạng mà trong quá trình soạn thảo văn bản 

chúng ta sử dụng nhiều nhất đó là in đậm (Ctrl +B), in nghiêng (Ctrl+I) và gạch chân 

(Ctrl+U). Và hầu hết các định dạng văn bản thường gặp cũng đã được liệt kê trong nhóm 

lệnh Font của Tab Home: 

 

Hình 1.44 – Các định dạng Font chữ cơ bản 

Ta chỉ cần bôi đen đoạn văn bản cần định dạng sau đó chọn các lệnh ở trong nhóm 

Font như hình 1.44. 

Để thiết lập các kiểu Font chữ đặc biệt, ta chọn biểu tượng Text Effects ( ): 

 

Hình 1.45 – Các hiệu ứng nâng cao cho Font chữ  

 Sử dụng Font Dialog 

Để định dạng Font chữ nâng cao ta cũng có thể mở cửa sổ Font Dialog bằng cách bấm 

vào biểu tượng mở rộng trong nhóm lệnh Font của Tab Home (hoặc nhấn tổ hợp phím 

Ctrl+D hoặc Ctrl+Shift+F): 
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Hình 1.46 – Cửa sổ Font Dialog 

Thông thường khi soạn thảo văn bản ta sử dụng một kiểu định dạng đồng nhất để 

nâng cao tính chuyên nghiệp, do đó ta định dạng hết các thông số rồi chọn chức năng “Set 

As Default”. Ví dụ: Ta thiết lập Font chữ “Time news roman”, Font Style = “Regular”, Font 

Size =13 rồi nhấn nút “Set As Default”, màn hình sau hiển thị: 

 

Hình 1.47 – Thiết lập định dạng mặc định 

Sau khi chọn “All documents  based on the Normal.dotm template” rồi bấm OK, 

Microsoft Word sẽ lưu lại định dạng này, mỗi lần mở một tập tin mới lên thì tập tin mới này 

cũng có định dạng giống như ta đã thiết lập. 

Tab Font: 

Dùng để định dạng Font chữ, kiểu 

chữ, cỡ chữ, màu chữ, gạch chân, chữ 

hoa, chữ thường, Superscript (X2), 

Subscript (H2O). 

Tab Advanced: 

Dùng để hiệu chỉnh co giãn chữ, ghép 

chữ… 

Text Effects: 

Dùng để thiết lập hiệu ứng nâng cao. 

Set As Default: 

Dùng để thiết lập thông số mặc định 

theo ý muốn của người sử dụng. 
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Khi in ấn đôi khi ta gặp trường hợp: Có một 

vài từ rơi xuống trang mới làm xấu trang in, hoặc 

ta muốn dòng cuối cùng chữ được giãn đầy dòng 

cho đẹp thì ta xử trí như thế nào? Khi gặp trường 

hợp này ta sẽ dùng chức năng co giãn chữ ở trong 

tab Advanced của cửa sổ Font Dialog: 

Normal : Chữ để bình thường 

Expanded : Giãn chữ 

Condensed : Co chữ 

 

Ví dụ: Nếu cùng một cụm từ “Không sợ thiếu, chỉ 

sợ không công bằng”, nếu như ta thiết lập 3 kiểu 

khác nhau thì sẽ có 3 kết quả khác nhau:  

        Hình 1.48 – Thiết lập co giãn chữ 

Normal Không sợ thiếu, chỉ sợ không công bằng 

Expanded  Không sợ  thiếu, chỉ  sợ không công bằng 

Condensed  Không sợ thiếu, chỉ sợ không công bằng 

 Chèn biểu tượng và ký tự đặc biệt: 

Đôi khi trong quá trình soạn thảo văn bản, ta cần chèn một số biểu tượng hay ký tự 

đặc biệt nào đó nhưng ta không thể nhập vào từ bàn phím được, Microsoft Word đã cung cấp 

một kho các biểu tượng và ký tự đặc biệt rất phong phú, nó đủ đáp ứng mọi yêu cầu của 

người sử dụng. 

Để hiển thị cửa sổ chèn Biểu tượng và ký tự đặc biệt này ta vào: Tab Insert/ chọn 

Symbol/ More Symbol (Atl+N+U+M): 

Hình 1.49 – Chèn biểu tượng và ký tự đặc biệt 

 Thêm Drop Cap vào tài liệu: 

Trong tab Symbols có danh sách 

Font chữ: Ứng với mỗi loại font chữ 

khác nhau thì có biểu tượng khác 

nhau, các biểu tượng được sử dụng 

nhiều nhất là nằm trong Font 

Wingdings. 

Để chèn các ký tự đặc biệt chẳng 

hạn như (© , ® , ™  , §, …), ta vào tab 

Special Characters. 
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Như ta đã biết, Drop Cap là trong một đoạn văn có 1 ký hoặc 1 một nhóm các ký tự ở 

đầu đoạn văn “rơi” xuống các dòng bên dưới (vào tab Insert/ chọn Drop Cap): 

 

Hình 1.50 – Thêm Drop Cap vào đoạn văn 

Mỗi một đoạn văn có thể thêm 1 Drop Cap. Mặc định ký tự đầu tiên của đoạn văn khi 

thiết lập Drop cap nó sẽ được rơi xuống, nhưng nếu ta bôi đen một từ đầu thì nó sẽ rơi cả từ 

đầu tiên đó xuống (nhiều ký tự như hình trên). Đôi khi đoạn văn lại không cho phép ta thêm 

Drop Cap thì hãy kiểm tra xem đoạn văn đó có bị gõ dư khoảng trắng ở đầu dòng hay không 

hoặc kiểm tra xem con trỏ văn bản có đang đứng trên dòng mà không có chữ nào hay không. 

  Tạo và chỉnh sửa Style 

Trong quá trình soạn thảo văn bản, có những nội dung có định dạng giống nhau, nếu 

định dạng lần lượt cho từng nội dung riêng sẽ mất nhiều thời gian và không nhất quán. Một 

trong những cách đơn giản để thực hiện điều này là dùng Style. 

Style là một tập hợp các định dạng được tạo trước và có một tên. Style rất cần thiết 

khi soạn thảo giáo trình hoặc tài liệu có nhiều mục, nhiều loại văn bản khác nhau. 

Style có thể áp dụng cho cho đoạn văn (Paragraph), cho ký tự (Character) hoặc cả hai 

(Linked). Word có sẵn các Style mặc định, người dùng có thể định nghĩa thêm Style. Các 

Style được chứa trong trong Group Styles trên thanh Ribbon của tab Home. 

 Chọn các Style có sẵn 

Bội đen đoạn văn bản muốn gán Style, trong nhóm lệnh Styles của tab Home nhấn 

chọn kiểu Style mong muốn: 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 29 

 

Hình 1.51 – Chọn Style có sẵn của Microsoft Word 

 Tạo mới Style 

 

 

Hình 1.52 – Tạo một Style mới 

− Name: Nhập tên Style mới (ví dụ trên là dntu_style). 

− Style type: Chọn loại Style (paragraph, character, linked). 

− Style based on: Chọn Style làm cơ sở cho Style đang tạo, Style đang tạo sẽ bao gồm 

các định dạng của Style nền. 

− Style for following paragraph: Chọn Style cho đoạn kế tiếp. 

- Chọn mở rộng Style trong nhóm Styles (số 1) 

- Click biểu tượng New Style (số 2) 
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− Formatting: Chọn các định dạng cho Style. 

− Click nút Format cho phép mở rộng các định dạng như: Font, Paragraph, Tabs, 

Border, Language, Frame, Numbering, Shortcut Key, Text Effects. 

− Bấm OK để tạo Style mới, sau khi bấm OK thì style dntu_style sẽ được đưa vào 

Quick Style Gallery (hình 1.53) 

 

 Gán Style 

- Chọn khối văn bản cần định dạng 

- Chọn Style đã tạo ở trên (dntu_style), lúc này khối văn bản sẽ có định dạng giống như 

được thiết lập trong dntu_style: 

 
Hình 1.53 – Gán Style cho khối văn bản 

 Chỉnh sửa Style 

Để hiệu chỉnh Style, ta bấm chuột phải vào Style/chọn Modify (sẽ xuất hiện màn 

hình chi tiết để thay đổi định dạng giống như ở mục tạo mới Style, tại đây ta đổi các thông số 

theo nhu cầu cụ thể): 

 

Hình 1.54 – Chỉnh sửa Style 

Tương tự ta có các chức năng ở trong màn hình 1.54: 

- Rename…: Đổi tên Style 

- Remove from Quick Style Gallery…: Xóa Style khỏi danh mục 

- Add Gallery to Quick Access Toolbar: Đưa Style này vào thanh Quick Access 

Toolbar 

 

1.2.2. Chia cột cho đoạn văn bản 

Có những văn bản sau khi soạn bạn muốn chia ra làm nhiều cột như các bài báo, MS 

Word sẽ giúp bạn hoàn thành. 

Để chia đoạn văn thành nhiều cột:  
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- Quét chọn đoạn văn muốn chia cột → PageLayout: 

 

Hình 1.55 – Chia cột đoạn văn bản 

 

- Để mở cửa sổ Column → More Columns: 

 

Hình 1.56 – Cửa sổ Column 

− Presets: chọn một trong các mẫu có sẵn hoặc nhập số cột vào ô Number of 

columns. 

− Line between: Kẻ/Không kẻ đường phân cách giữa các cột. 

− Width and spacing: Độ rộng của cột và khoảng cách giữa các cột. 
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− Apply to: Phạm vi chia cột. 

Lưu ý: Khi chia cột người dùng thường mắc các lỗi như chia hai cột dữ liệu nằm 

trọn một cột, không không chia qua cột thứ hai… Các lỗi này xảy ra ở khâu quét chọn dữ 

liệu (thường là không ngắt đoạn). Để chia cột luôn thành công người dùng nên bật nút 

Show/Hide để khi quét chọn dữ liệu không quét phải dấu Enter cuối cùng 

1.2.3. Công thức toán học 
Để thiết lập các công thức Toán hoc, Hóa học,…..trong Word, bạn vào Tab Insert → 

group Symbol → Equation. 

 

 

Hình 4.5.22 

Thanh công cụ để soạn thảo xuất hiện, và bạn bắt đầu thiết kế các công thức. Ta có 

các group: 

 Tool: Chèn và định dạng các mẫu công thức có sẵn. 

 

Hình 4.5.23 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 33 

 

 Symbols: Chèn các ký tự đặc biệt. 

 

Hình 4.5.24 

 Structures: Các cấu trúc công thức có sẵn. 

 

Hình 4.5.25 

Lưu ý: khi tạo các công thức bạn nên tạo trong cùng một Equation, không nên tắch riêng 

từng phần, như vậy sẽ rất khó định dạng cho công thức. 

1.2.4.  Tạo bảng biểu và biểu đồ 
 Bảng biểu trong Microsoft Word 

Bảng (table) là kiểu trình bày văn bản có cấu trúc gồm các cột (column) và các dòng 

(row), giao giữa các dòng và các cột là các ô (cell). 

Vậy khi nào ta nên dùng bảng? Khi ta muốn tổ chức dữ liệu theo dòng và cột, ví dụ: 

Ta cần tạo một bảng điểm chi tiết cho sinh viên, hay bảng lương cho nhân viên, hay phải 

định dạng một biểu mẫu phức tạp nào đó. 

Ví dụ bảng biểu đơn giản: 

Mã Sinh Viên Tên Sinh Viên Điểm Trung Bình 

1123594 Phạm Thị Xuân Diệu 8 

1123584 Nguyễn Văn Hùng 9 

1123574 Trần Duy Thanh 8 

1123564 Nguyễn Thị Cẩm Hương 9 

 

 

Dạng căn 

thức 
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Ví dụ bảng biểu phức tạp: 

Thông báo tuyển sinh 

  ------  ------  
➢ Kính gửi: ...........................................................................................  

➢ Vào lúc: ................................. ngày ...................................................  

➢ Đến phòng: ........................................................................................  

Tại trường PTTH Nguyễn Đình Chiểu để dự thi kỳ thi tuyển sinh đại học năm 

2014. Khi thi nhớ mang theo: 

 Giấy báo thi 

 Giấy chứng minh nhân dân 

 Giấy báo tốt nghiệp PTTH 

Họ tên thí sinh Giờ thi Ngày thi Phòng thi 

Đỗ Công Thành 7h15 02-01-2014 IT01 

 

 Cách tạo bảng biểu 

- Vào Tab Insert/ Table trong nhóm Tables 

 

Hình 1.55 cho ta thấy đang rê chuột để tạo 1 bảng có 7 cột 

và 6 dòng, cách này khá nhanh tuy nhiên nó bị giới hạn số 

cột và số dòng. Còn có các cách tạo khác (Insert Table, 

Draw Table, Convert Text to Table, Excel Spreadsheet, 

Quick Tables) 

 

  

 

Hình 1.55 – Cách tạo bảng biểu 

- Insert Table: Cho phép tạo bảng với số dòng và cột được người dùng nhập vào, sau 

đó Click OK để tạo bảng. 

Hình 1.56 – Thêm bảng biểu 

Number of columns: Nhập số cột 

Number of rows: Nhập số dòng 
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- Draw Table: Cho phép kẻ bảng biểu theo ý muốn tùy thích với cây viết chì. 

- Convert Text to Table: Cho phép chuyển đổi dữ liệu văn bản thông thường thành 

bảng, thông thường các dữ liệu văn bản này được ngăn cách bởi dấu tab, ví dụ nếu như ta 

nhập dữ liệu với dạng sau: 

 

Để chuyển qua bảng ta chỉ cần bôi đen toàn bộ dữ liệu ở trên rồi vào Insert/Table/Convert 

Text To Table... 

Hình 1.57 – Chuyển dữ liệu Text qua bảng 

- Excel Spreadsheet : Nhúng bảng tính Excel vào Words. 

Khi chọn chức năng này, bảng tính Excel sẽ được nhúng vào tài liệu Word mà ta 

đang thao tác. Khi ta double –click vào bảng tính thì các thanh công cụ của Excel sẽ hiển thị 

ra như bên dưới, mọi thao tác trong bảng tính excel này trở lên dễ dàng và quen thuộc giống 

như ta thao tác bằng Microsoft Excel. Khi không muốn thao tác nữa thì ta click chuột ra khỏi 

bảng tính. 

Để mặc định như trên rồi bấm nút Ok 

Chức năng này rất tiện lợi trong việc 

thiết kế bảng dữ liệu đơn giản. 
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Hình 1.58 – Chèn bảng tính Excel vào Word 

Quick Tables: Đôi khi ta cần tạo nhanh một số bảng theo mẫu có sẵn thì sẽ dùng 

chức năng này. Tuy nhiên trong thực tế ta ít sử dụng, vì tùy vào đặc thù của mỗi nghành 

nghề mà ta có các mẫu biểu để thiết kế khác nhau. 

 Hiệu chỉnh bảng biểu 

Click chuột lên bảng để xuất hiện Tab Table Tools chọn Layout 

 

Hình 1.59 – Công cụ hiệu chỉnh bảng 

- Chọn các thành phần trong bảng 

✓ Chọn Ô: Click chuột lên hàng, chọn Tab Layout →Group 

Table → Select chọn Select Cell. 

✓ Chọn cột: Click chuột lên cột, chọn Tab Layout→Group 

Table→Select chọn Select Column. 

✓ Chọn hàng: Click chuột lên hàng, chọn Tab 

Layout→Group Table→Select chọn Select Row. 

✓ Chọn cả bảng: Click chuột lên bảng, chọn Tab Layout→Group Table→Select chọn 

Select Table. 

- Thao tác trên hàng và cột 

Click chuột lên bảng, chọn Layout →Group Row & Column gồm các chức năng sau: 

✓ Insert Above: Thêm một hàng ở phía trên. 

✓ Insert Below: Thêm một hàng ở phía dưới . 

✓ Insert Left: Thêm cột bên trái. 

✓ Insert Right: Thêm cột bên phải. 
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- Delete: 

✓ Delete Cells: Xóa ô. 

✓ Delete Columns: Xóa cột. 

✓ Delete Rows: Xóa hàng. 

✓ Delete Table: Xóa bảng. 

- Trộn hoặc tách các ô 

Chọn các ô cần trộn, chọn Tab Layout→Group Merge có 

các chức năng sau:  

✓ Merge Cell: Trộn các ô đang chọn thành một ô duy nhất. 

✓ Split Cells: Tách thành nhiều ô. 

✓ Split Table: Tách thành hai bảng khác nhau. 

-  Thay đổi độ lớn của các ô 

Click chuột lên bảng, Chọn Tab Layout→Group Cell Size gồm các chức năng sau: 

AutoFit: 

✓ AutoFit Contents: Kích thước bảng 

co giãn theo lượng dữ liệu trong 

bảng. 

✓ AutoFit Window: Kích thước bảng 

mở rộng bằng chiều rộng vùng soạn 

thảo. 

✓ Fixed Column Width: Cố định chiều rộng cột. 

✓ Height: Hiệu chỉnh chiều cao của hàng. 

✓ Width: Hiệu chỉnh chiều rộng của cột. 

✓ Distribute Rows: Hiệu chỉnh cho các hàng có kích thước bằng nhau. 

✓ Distribute Columns: Hiệu chỉnh cho các cột có kích thước bằng nhau. 

- Canh lề cho dữ liệu trong ô 

Chọn các ô cần canh lề dữ liệu, Tab Layout→Group Alignment có các chức năng sau: 

✓ 9 kiểu căn lề như hình 

✓ Text Direction: Thay đổi hướng của dữ liệu trong ô. 

✓ Cell Margins: Thiết lập khoảng cách giữa dữ liệu và lề ô. 

Ví dụ: Trộn ô, đổi hướng chữ, tạo tab (trong bảng phải nhấn 

ctrl+tab) 
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1  ............................ Nguyễn Văn Hùng 

2  ................................ Đỗ Công Thành 

3  ............................... Trần Duy Thanh 

4  ........................ Phạm Thị Xuân Diệu 

 

 Thao tác với dữ liệu trong bảng 

Khi thao tác với bảng biểu thì việc sắp xếp dữ liệu rất quan trọng, nó giúp cho việc 

liệt kê dữ liệu được khoa học hơn, trong bảng biểu đôi khi ta cũng có các dòng/cột phải tính 

toán, bảng biểu trong Word cũng hỗ trợ các chức năng này. 

Click chuột lên bảng, Tab Layout→Group Data gồm các chức năng: 

 

✓ Sort: Sắp xếp dữ liệu trong bảng. 

✓ Repeat Header Rows: Hàng đang được chọn sẽ được lặp lại khi độ lớn của bảng vượt 

quá một trang. 

✓ Convert to Text: Loại bỏ bảng và chuyển dữ liệu bên trong về dạng chuỗi. 

✓ Formula: Thực hiện tính toán với các trường dữ liệu trong bảng 

Ví dụ 1: Cần tính tổng tiền các linh kiện được liệt kê trong bảng sau: 

Thực hiện: Click chuột lên ô cần tính toán chọn Tab Layout→Group Data→Formula 

(biểu tượng có hình fx formula). 

 

Hình 1.60 – Sử dụng thanh công thức 
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Ví dụ 2: Hãy sắp xếp bảng tính dưới đây theo thành tiền tăng dần 

Mã SP Tên Sản Phẩm Số Lượng Đơn Giá Thành Tiền 

R1K  Iphone 5 5 500 2500 

T2K New Ipad 3 400 1200 

G1P SamSung SII 7 450 3150 

X2P SamSung SIII 5 500 2500 

Ta sắp xếp như sau: 

✓ Chọn toàn bộ bảng dữ liệu ở trên 

✓ Click chọn biểu tượng sort sẽ hiển thị cửa sổ như bên dưới: 

 

Hình 1.61 – Sắp xếp thành tiền tăng dần 

✓ Mục Sort by: Click chọn cột thành tiền (vì đề bài yêu cầu sắp xếp cột thành tiền) 

✓ Mục Type: Mặc định là Number vì dữ liệu ở trong cột thành tiền là kiểu số 

✓ Chọn Ascending (sắp tăng dần), chọn Descending (sắp giảm dần) 

✓ Bấm chọn OK để tiến hành sắp xếp, kết quả được như bên dưới: 

Mã SP Tên Sản Phẩm Số Lượng Đơn Giá Thành Tiền 

T2K New Ipad 3 400 1200 

R1K  Iphone 5 5 500 2500 

X2P SamSung SIII 5 500 2500 

G1P SamSung SII 7 450 3150 

Ví dụ 3: Hãy sắp xếp bảng tính dưới đây theo thành tiền tăng dần, nếu thành tiền bằng nhau 

thì sắp xếp theo mã sản phẩm giảm dần. 

Ta tiến hành làm giống như ở ví dụ 2, nhưng trong bảng sắp xếp ta chọn lựa thêm cột mã sản 

phẩm là cột sắp xếp thứ 2. 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 40 

 

Hình 1.62 – Sắp xếp thành tiền tăng dần, mã sp giảm dần 

Mục Then by ý nghĩa là khi phần sort by trùng nhau thì Word sẽ tiến hành sắp xếp theo 

mục then by. Word cho phép sắp xếp liên tiếp 3 cột. 

Mã SP Tên Sản Phẩm Số Lượng Đơn Giá Thành Tiền 

T2K New Ipad 3 400 1200 

X2P SamSung SIII 5 500 2500 

R1K  Iphone 5 5 500 2500 

G1P SamSung SII 7 450 3150 

 

 Thiết kế bảng biểu 

Thực hiện: Click chuột lên bảng chọn Tab Design. 

 

Hình 1.63 – Công cụ thiết kế bảng 

− (Group) Table Styles 

Cho phép tạo ra các bảng dữ liệu đẹp mắt theo mẫu được tạo sẵn. 

Thực hiện: Click chuột lên bảng và chọn Style. Có thể mở rộng Style để có nhiều Style hơn. 

 

✓ Shading: Tô màu nền.  

✓ Borders: Tạo đường viền. 
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− (Group) Borders 

✓ Draw Table: tạo bảng tự do. 

✓ Pen Color: Chọn màu cho đường viền. 

✓ Eraser: Xóa các đường trong bảng. 

 

− (Group) Table Style Options 

✓ Header Row: Nhấn mạnh hàng đầu tiên 

(tiêu đề). 

✓ Total Row: Nhấn mạnh hàng cuối. 

✓ Banded Rows: Tạo sự phân biệt giữa 

các hàng (tô màu cách hàng). 

✓ First Column: Nhấn mạnh cột đầu. 

✓ Last Column: Nhấn mạnh cột cuối. 

✓ Banded Column: Tạo sự phân biệt giữa các cột (tô màu cách cột). 

 Biểu đồ trong Microsoft Word 

Đây là chức năng rất hữu ích mà Word cung cấp cho người sử dụng, ta thường sử 

dụng nó khi làm báo cáo, ví dụ: Báo cáo hoạt động kinh doanh, báo cáo tỉ lệ phân bố dân cư, 

báo cáo tỉ lệ đậu rớt tốt nghiệp… 

 

 

Hình 1.64 – Chèn bảng biểu 

Để chèn biểu đồ ta vào 

tab Insert/chọn Chart trong nhóm 

Illustrations như hình 1.64. 

Trong màn hình Insert Chart có 

rất nhiều loại biểu đồ, tùy vào 

mục đích sử dụng mà ta chọn các 

loại biểu đồ phù hợp (Column, 

Line, Pie, Bar, Area…). Giả sử ta 

chọn một loại Column nào đó rồi 

bấm nút OK, ta được kết quả như 

hình 1.65. 
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Hình 1.65 – hiệu chỉnh thông số cho biểu đồ 

Word sẽ cung cấp thêm cho chúng ta màn hình Excel để thay đổi giá trị, mỗi lần đổi 

giá trị trong Excel thì biểu đồ trong Word sẽ tự động cập nhật. Ta có thể thay đổi kiểu biểu 

đồ, hiệu chỉnh tiêu đề, hiệu chỉnh lưới, định dạng font chữ cũng như màu nền cho biểu đồ… 

 

 Thiết kế biểu đồ 

Khi chọn biểu đồ, Word sẽ cung cấp công cụ Chart Tools cho phép chúng ta thiết 

kế, định dạng, cập nhập dữ liệu lại cho biểu đồ: 

 

Hình 1.66 – Công cụ định dạng, cập nhật dữ liệu cho biểu đồ 

 

 Thay đổi loại biểu đồ 

Để thay đổi loại biểu đồ (ví dụ đổi từ loại dạng Column sang dạng 

Bar), ta click chọn biểu đồ trước và trong nhóm lệnh Type của thanh công cụ, ta 

chọn Change Chart type. Word sẽ mở ra màn hình Insert Chart giống như hình 

1.64, ta chọn dạng Bar rồi nhấn OK sẽ có kết quả như bên dưới: 
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 Cập nhật dữ liệu cho biểu đồ 

Nếu ta muốn thay đổi giá trị trong biểu đồ, chọn Edit 

Data trên thanh công cụ (xem hình), Word sẽ mở cửa sổ giống 

như hình 1.65 cho phép ta chỉnh sửa dữ liệu. 

 Định dạng biểu đồ 

Để thay đổi tiêu đề cho biểu đồ, thay đổi tiêu đề cho trục ngang, trục đứng… ta vào 

tab Layout của công cụ Chart Tool: 

 

 

Ví dụ: Đổi vị trí xuất hiện Legend, hiển thị Axis titles, thay đổi màu các thông số: 
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Hình 1.67 – Ví dụ thay đổi định dạng biểu đồ 

1.2.5.  Cách xây dựng nội dung tái sử dụng trong tài liệu 
Ta biết rằng trong quá trình soạn thảo văn bản, có những cụm từ, những định 

dạng ta thường xuyên sử dụng đi sử dụng lại. Nếu như phải viết lặp lại thì rất mất thời gian 

vì vậy Word cung cấp cho ta chức năng xây dựng nội dung tái sử dụng, chẳng hạn: Building 

Block, Autotext, Header & Footer… 

 Building Block 

Cho phép ta tạo ra và chuẩn hóa các trang bìa, tiêu đề đầu trang, tiêu đề chân trang, và 

các bảng biểu, đây là tính năng mạnh mẽ cho phép tái sử dụng nội dung. 

Hiệu chỉnh Building Block có sẵn 

Vào tab Insert/chọn Quick Parts (nhóm lệnh Text)/chọn Building Blocks Organizer: 

 

Hình 1.68 – Hiển thị Building Blocks Organizer 
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Hình 1.69 – Màn hình Building Blocks Organizer (ví dụ trang bìa) 

- Insert: Cho phép chèn Building Block đang chọn vào tài liệu (ở hình 1.69 nếu ta 

chọn Insert thì trang bìa Grid như trên sẽ được chèn trực tiếp vào tài liệu). 

- Delete: Cho phép xóa Building Block đang chọn. 

 

Chọn Yes để xóa, chọn No để hủy thao tác xóa. 

- Edit Properties: Cho phép hiệu chỉnh 

Building Block đang chọn. 

- Name: Đặt tên cho Building Block (tên 

tùy ý mang tính gợi nhớ) 

- Gallery: Chọn các bộ sưu tập được 

định nghĩa trong Microsoft Word 

- Category: Chọn các danh mục thuộc 

Gallery, ta có thể tạo tên mới (bấm vào 

danh sách kéo xuống dưới cùng rồi 

chọn New Category) 

- Description: Nhập mô tả cho Building 

Block để trợ giúp cho quá trình sử dụng 
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- Save in: Nơi lưu trữ Build Blocks, mặc định là Building Blocks.dotx 

- Sau khi nhập đầy đủ các thông số, bấm Ok để chấp nhận sự hiệu chỉnh. 

- Thêm mới một Building Block 

- Việc thêm mới một Build Block vào Quick Parts Gallery là rất đơn giản: Sau khi đã 

định dạng theo ý muốn, ta bôi đen toàn bộ các định dạng đó rồi vào Quick 

Parts/chọn Save Selection to Quick Parts Gallery, ví dụ: 

 

Hình 1.70 – Đưa định dạng vào Quick Part Gallery 

 

Nhập thông tin cho định dạng ở hình 1.70 

Sau khi bấm Ok để lưu vào Quick Parts Gallery, ở bất kỳ tài liệu nào ta cũng có thể 

chèn được định dạng này, bằng cách: Vào Tab Insert/ chọn Quick Parts/ chọn MauGiayMoi 

như hình dưới. Hoặc  ta chọn Building Blocks Organizer (trong màn hình này ta chọn 

MauGiayMoi rồi nhấn Insert). 
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 Chức năng Autotext 

Trong quá trình soạn thảo văn bản, có những cụm từ ta thường viết lặp lại rất quen 

thuộc, để giảm thiểu thời gian gõ lại, Word cung cấp chức năng Autotext để cải thiện tốc độ 

soạn thảo. Ví dụ ta thường gõ cụm từ “cộng hòa xã hội chủ nghĩa Việt Nam”, hay “Trường 

đại học Công Nghệ Đồng Nai”, hay “Công ty trách nhiệm hữu hạn”… là những cụm từ mà 

ta lặp lại nhiều lần, nếu phải viết lại như vậy thì rất mất thời gian. Đó là lý do ta cần biết 

Autotext: 

- Bôi đen cụm từ muốn làm Autotext, ví dụ “Trường Đại Học Công Nghệ Đồng Nai” 

- Vào Insert/Quick Parts/ Autotext/ chọn Save Selection to Autotext Gallery 

- Cụ thể: 

 

Hình 1.71 – Lưu Autotext 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 48 

 

Đặt tên là dhdn rồi bấm Ok 

− Sử dụng Autotext đã lưu 

Sau khi lưu Autotext, mỗi lần soạn văn bản mà có 

chưa cụm từ giống như ta đặt trong mục name (ví dụ trên 

là dhdn) thì Word sẽ gợi ý cho ta cụm văn bản đó bằng 

cách nhấn phím Enter hoặc gõ phím F3, như vậy sẽ tiết kiệm được thời gian. 

− Xóa Autotext đã lưu 

Tương tự như Building Block đã hướng dẫn ở trên: Ta vào Building block Oganizer, 

chọn tên Autotext đã đặt rồi nhấn nút Delete. 

 Chức năng Header & Footer 

Chức năng này vô cùng quan trọng và hữu ích mà Word đã cung cấp cho người soạn 

thảo văn bản. Trong tất cả các văn bản thì tiêu đề đầu trang (Header) và tiêu đề cuối trang 

(Footer) là phải có. Ví dụ Đầu mỗi trang ta ghi “Giáo Trình Tin Học B – Khoa Công Nghệ 

Thông Tin – ĐH Công Nghệ Đồng Nai”, cuối mỗi trang ta có ghi số trang. 

Cách làm: Có rất nhiều cách làm, có thể vào tab 

Insert/ chọn Header hoặc Footer. Nhưng cách đơn giản 

và nhanh nhất đó là bấm chuột phải vào đầu trang rồi 

chọn Edit Header hoặc bấm chuột phải vào cuối trang 

chọn Edit Footer. 

 

Ví dụ: Header cho tài liệu 
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Trong màn hình Header của tại liệu, ta định dạng giống như soạn  thảo văn bản bình 

thường. Mặc định Header có 3 tab căn lề (lề trái, lề giữa, lề phải). Muốn thoát khỏi chế độ 

này ta bấm vào nút Close Header and Footer ở góc phải màn hình trong công cụ Header & 

Footer Tools. 

 

Ví dụ: Footer cho tài liệu – chèn số trang 

Khi ta định dạng Header và Footer cho một trang bất kỳ trong một tài liệu nào đó, thì 

toàn bộ các trang khác sẽ có Header và Footer giống như trang này (thông thường ta sử dụng 

tính năng này của Header và Footer). 

Tuy nhiên trong một số trường hợp đặc biệt, ta phải phân vùng tài liệu, ứng với mỗi 

vùng khác nhau thì có Header và Footer khác nhau, vậy ta phải làm như thế nào? Ví dụ: 

Luận văn tốt nghiệp của ta có 3 phần, mỗi phần phải làm 3 Header và 3 Footer khác nhau? 

Để làm được yêu cầu này, ta thực hiện các bước sau: 

Bước 1: Di chuyển con trỏ văn bản vào dòng đầu tiên của trang bất kỳ muốn bắt đầu 

phần vùng: Vào Page Layout / Breaks/ chọn Next Page 

 

Bước 2: Vào Edit Header hoặc Edit Footer tại phần vùng mới này 
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Trước khi tiến hành chỉnh sửa Header và Footer cho phân vùng mới, bắt buộc ta phải 

bỏ Link to Previous ở cả header và footer (bỏ tô màu vàng đi). Nếu như ta không bỏ Link 

to Previous thì nó sẽ ảnh hưởng tới các phân vùng khác khi ta tiến hành thay đổi. 

Ta làm tương tự cho các phân vùng khác, khó khăn nhất là hiệu chỉnh số trang, nếu 

muốn phân vùng nào thì số trang đánh dấu từ số 1 ta làm như sau: 

 

- Chọn Format Page Numbers... trong lệnh Page number 

 

- Chuyển qua Start at là 1 rồi bấm OK (mặc định là 

Continue from previous section) 

Như vậy ta đã biết cách sử dụng Header và Footer ở 

trường hợp cơ bản và nâng cao (phân theo các vùng khác 

nhau). 

 

 

 

 

1.2.6.  Sử dụng hộp văn bản liên kết và chọn lựa 
Word cung cấp cho chúng ta chức năng Link TextBox, tức là dữ liệu được hiển thị trong 

1 TextBox nhưng khi hết chỗ chứa nó sẽ tự động nhảy qua Textbox còn lại. 
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Ví dụ: Ta có 2 TextBox ban đầu với dữ liệu như sau: 

 

Khi ta thay đổi kích thước ở TextBox 1 (TextBox chứa dữ liệu), thì phần không có chỗ 

chứa sẽ tự động chuyển qua TextBox bên cạnh: 

 

Để làm được như trên ta thực hiện theo các bước sau: 

Bước 1: Chèn các TextBox vào tài liệu (vào Insert / Text Box/ chọn Draw Text Box) 

 

Hình 1.72 – Chèn TextBox vào tài liệu 
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Bước 2: Bấm chọn Textbox gốc, sau đó chọn Create Link 

trong tab Format của thanh công cụ Drawing Tools. Biểu tượng 

Create Link xuất hiện, bấm chuột vào TextBox muốn link tới 

Bước 3: Bỏ link Textbox, bấm chuột vào Textbox gốc rồi chọn 

Break Link trong tab Format của thanh công cụ Drawing Tools. 

 Sử dụng Bookmark và Hyperlink 

Khi tài liệu chứa rất nhiều trang ta nên sử dụng Bookmark và Hyperlink để giúp 

cho người sử dụng di chuyển tới đoạn văn bản cần thiết một cách vô cùng nhanh chóng. Ta 

cần đánh dấu vị trí để người sử dụng di chuyển con trỏ văn bản tới vị trí mong muốn (vị trí 

này gọi là Bookmark) và nơi cho phép người sử dụng bấm chuột vào để di chuyển tới 

Bookmark đã tạo (nơi người sử dụng bấm chuột vào gọi là Hyperlink). Như vậy ta phải tạo 

Bookmark trước rồi mới tạo Hyperlink sau. 

 

Giả sử ta có 1 tài liệu gồm 62 trang, trang số một chỉ chứa các tiêu đề của các nội dung, 

ví dụ “Đoạn văn 2” là tiêu đề của nội dung nằm ở trang số 36: 

Biểu tượng Create Link 
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Nội dung của đoạn văn 2 (là nội dung của tiêu đề “Đoạn văn 2” ở trang 1) 

Mục tiêu chúng ta cần làm là khi bấm chuột vào “Đoạn văn 2” ở trang 1 thì con trỏ văn 

bản sẽ tự động di chuyển tới trang số 36 (trang chứa nội dung), giúp chúng ta tìm nội dung 

trong tài liệu một cách nhanh chóng. 

Cách làm: 

Bước 1: Tiến hành tạo Bookmark. Di chuyển con trỏ văn bản tới trang số 36 (nơi chứa 

nội dung ta cần tìm). Tại đây ta bấm chuột vào dòng đầu tiên (hoặc bất kỳ vị trí nào trong nội 

dung). Sau đó vào tab Insert/chọn Bookmark: 

 

Hình 1.73 – Tạo Bookmark 
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Nhập tên Bookmark (viết liền, tiếng việt không dấu) rồi nhấn nút “Add”, muốn xóa 

Bookmark nào thì chọn Bookmark đó rồi nhấn nút “Delete”. 

Bước 2: Gán Hyperlink. Sau khi tạo xong Bookmark ở bước số 1, ta trở về trang số 1. 

Tại đây ta bôi đen dòng ghi “Đoạn văn 2” rồi vào tab Insert/chọn Hyperlink: 

 

Hình 1.74 – Gán Hyperlink 
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Ta vào Place in This Document/Trong nút Bookmarks chọn bookmark_doanvan2 

đã tạo ở bước 1 rồi bấm nút OK. Tương tự như vậy mỗi lần tạo thêm Bookmark mới thì nó 

sẽ được hiển thị trong này. 

Bước 3: Kết quả sẽ cho ta thấy như hình bên 

dưới, để di chuyển tới nội dung của đoạn văn ta chỉ 

cần đè phím Ctrl và bấm chuột vào “đoạn văn 2” 

(đoạn văn có định dạng liên kết màu xanh). Chú ý 

là ta nên sử dụng chức năng Bookmark – Hyperlink 

trong trường hợp tài liệu của ta chứa rất nhiều 

trang, vì nếu ít trang mà ta sử dụng thì nó thật không cần thiết. 

 

1.3.  Theo Dõi Và Tham Khảo Tài Liệu 
Phần này ta sẽ đề cập đến các chức năng: Theo dõi sự thay đổi chỉnh sửa dữ liệu, 

trộn tài liệu, tạo các tài liệu tham khảo chẳng hạn như các thư mục, nguồn trích dẫn và lập 

chỉ mục. Cụ thể ta sẽ xem xét 4 chức năng dưới đây: 

 Kiểm tra, so sánh, và kết hợp tài liệu 

 Tạo một trang tài liệu tham khảo 

 Tạo bảng quy phạm pháp luật trong tài liệu 

 Tạo bảng chỉ mục cho tài liệu 

1.3.1. Kiểm tra, so sánh, và kết hợp tài liệu 
Chức năng này rất quan trọng và hữu ích trong quá trình soạn thảo văn bản, giúp 

ta chia sẻ tài liệu, quản lý những thay đổi, những ghi chú, so sánh và kết hợp tài liệu. Word 

cung cấp 4 nhóm lệnh chính trong tab Review: Comments, Tracking, Changes, Compare. 

 

Hình 1.75 – Chức năng Review trong Word 

 Thêm các ghi chú vào tài liệu 

- Trong một số trường hợp để ghi chú cho sự 

thay đổi (lý do của sự thay đổi) ta bôi đen 

cụm từ cần ghi chú rồi bấm chọn New 

Comment trong tab Review. 

- Để xóa ghi chú, bấm chuột vào ghi chú, 

chọn Delete trong tab Review:  

o Delete: Để xóa ghi chú đang chọn. 

o Delete All Comments in Document: Xóa toàn bộ ghi chú. 
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- Previous: Di chuyển tới ghi chú trước đó. 

- Next: Di chuyển tới ghi chú kế tiếp. 

 

Hình 1.76 – Màn hình theo dõi sự thay đổi dữ liệu 

Để hiệu chỉnh theo dõi ta vào Review/ Tracking/ chọn Change Tracking Options/ 

Advanced Options 

 

Màn hình định dạng hiển thị thay đổi (Thêm mới nội dung, sửa đổi nội dụng, xóa nội 

dung, định dạng nội dung), ứng với mỗi định dạng sẽ có màu hiển thị khác nhau để người sử 

dụng dễ xử lý: 
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Hình 1.77 – Màn hình hiệu chỉnh cách thức hiển thị ghi chú 

Ta có thể quy định cách thức hiển thị để theo dõi sự thay đổi nội dung: Ví dụ để hiển 

thị những thay đổi về ghi chú ta tick vào “Comments”, để hiển thị dữ liệu thay đổi ta tick 

vào “Insertions and Deletions”, để hiển thị những định dạng đã thay đổi ta tick vào 

“Formatting” … và các đặc tính khác: 

 

Hình 1.78 – Màn hình lựa chọn hiển thị các thay đổi của tài liệu 

Word cũng cung cấp hai màn hình hiển thị lịch sử của sự thay đổi tài liệu. 
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- Reviewing Pane/Reviewing Pane Vertical..: Hiển thị bên trái tài liệu 

- Reviewing Pane/Reviewing Pane Horizontal…Hiển thị bên dưới tài liệu 

 

Hình 1.79 – Hiển thị lịch sử thay đổi bên trái màn hình 

 

 Chức năng kết hợp (trộn) tài liệu 

Ngoài ra Word còn cung cấp chức năng trộn tài liệu cực kỳ hay, rất tiện lợi cho người 

sử dụng, đó là chức năng cho phép nhiều người cùng soạn thảo trên một tập tin và cung cấp 

chức năng so sánh và kết hợp các phiên bản của tài liệu này thành một tập tin thống nhất. 

Giả sử ta có hai người cùng soạn thảo một nội dung ở hai máy tính khác nhau. Hai 

người soạn thảo được nội dung như sau (để ý có cả sửa lỗi chính tả): 

 

Ta tiến hành kết hợp (trộn) 2 tập tin này như sau: 

- Bước 1: Tại một tập tin Word bất kỳ, ta chọn Compare… trong nhóm Compare của 

tab Review: 
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Hình 1.80 – Chọn 2 tập tin trong danh sách để so sánh 2 (file1.docx và file2.docx).  

 

Hoặc bấm vào biểu tượng thư mục kế bên danh sách để chọn tập tin 

- Original document: Là tên tập tin chứa dữ liệu gốc 

- Revised document: Là tên tập tin chứa nội dung bị thay đổi 

Để mở rộng thiết lập cấu hình so sánh tập tin, ta bấm vào nút “More”: 

 

 

Định dạng như trên rồi bấm OK 
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Hình 1.81 – Màn hình so sánh 2 tập tin 

- Ô ở bên trái màn hình: Cho ta biết lịch sử thay đổi ở tập tin chính. 

- Ô ở giữa màn hình: Cho ta biết quá trình trộn dữ liệu giữa 2 tập tin 

- Ô bên phải màn hình: Cho ta biết nội dung của tập tin gốc và tập tin thay đổi. 

 

- Bước 2 : Ta tiến hành kết hợp dữ liệu như sau 

 

Bôi đen dữ liệu đánh dấu là bị xóa ở màn hình giữa: Bấm chuột phải / chọn Reject 

Deletion. Ta có kết quả như màn hình bên dưới: 
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Tiếp tục bôi đen các dòng dữ liệu đánh dấu là thêm mới: Bấm chuột phải / chọn 

Accept Insertion để chấp nhận thêm mới dữ liệu. Ta có kết quả như hình dưới: 

 

Bôi đen chữ đánh dấu thay đổi (sai chỉnh tả): Bấm chuột phải/ chọn Accept Change để 

chấp nhận sự thay đổi. Vậy ta đã kết hợp xong các phiên bản, tiến hành lưu tài liệu và kết 

thúc. 

1.3.2. Tạo một trang tài liệu tham khảo 
Phần này người học sẽ được làm cách tạo các trích dẫn (citation) và các tài liệu tham 

khảo (Bibliography) mà Word cung cấp sẵn. Các chức năng này rất quan trọng đặc biệt khi 

làm báo cáo, tiểu luận, luận văn; thường cuối mỗi tài liệu ta phải làm trích dẫn và tham khảo, 

ta thường làm cẩu thả và không đúng chuẩn. Chức năng này sẽ giúp người soạn thảo làm 

đúng chuẩn và giảm thiểu thời gian. 

 Các chuẩn trích dẫn và nguồn tham khảo 

Ta cần biết sơ qua một số chuẩn trích dẫn và nguồn tham khảo, hiện nay có nhiều 

chuẩn khác nhau được sử dụng trên thế giới tùy theo quy định của một tập thể, tổ chức nào 
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đó. Ví dụ: APA (American Psychology Association), IEEE Citation Reference, MLA 

(Modern Language Association)… 

Giả sử viết theo chuẩn APA thì: 

- Đối với tài liệu trích dẫn: Sau mỗi đoạn trích dẫn là họ của tác giả, năm xuất 

bản của tài liệu trích dẫn và trị ví trang (nếu có). (Ví dụ Nguyễn, 2013, Tr.13). 

- Đối với nguồn tham khảo: Tùy theo loại tài liệu sẽ có cách viết khác nhau, cụ 

thể: 

- Báo, tạp chí: Họ tên tác giả. (ngày tháng/năm xuất bản). Tên bài báo. Tên tạp 

chí, vị trí trang. 

- Tạp chí khoa học chuyên nghành: họ tên tác giả. (năm xuất bản). Tên bài 

nghiên cứu. Tên tạp chí khoa học, vị trí trang. 

- Tài liệu sách: Họ tên tác giả, (năm xuất bản). Tên sách. Nơi xuất bản (thành 

phố): Nhà xuất bản. 

- Tài liệu từ internet: Họ tên tác giả. (ngày/tháng/năm đăng bài). Tên trang. 

Ngày/tháng/năm truy nhận thông tin, tên Website: URL 

 

 Thêm mới nguồn tham khảo 

Trước tiên ta phải thêm được tập nguồn tham khảo 

sẽ được sử dụng trong tài liệu. Ta vào tab References / chọn 

Insert Citation (trong nhóm lệnh Citations & Bibliography)/ 

chọn Add New Source… 

 

Hộp thoại 

Create Source xuất hiện, 

ta nhập thông tin như tham 

khảo rồi nhấn OK. Để 

nhập thêm các thông tin 

chi tiết khác ta tick vào 

“Show All Bibliography 

Fields” 

- Tuỳ theo loại tài 

liệu mà các thông 

tin phải nhập có thể khác nhau. 

- Đối với tên tác giả (Author) chúng ta nhập theo cú pháp: họ, đệm tên. 

- Nếu tài liệu là của nhóm tác giả chúng ta đánh dấu chọn vào mục: Corporate 

Author. 
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 Hiệu chỉnh nguồn tham khảo 

Để thay đổi thông tin nguồn tham khảo đã tạo 

trước đó, ta chọn Manage Sources kế bên Insert Citation để mở 

màn hình Source Manager. 

 

- Màn hình Source Manager 

Màn hình này cho phép ta tìm kiếm, sắp xếp theo thông tin mong muốn và thực hiện 

một số chức năng liệt kê bên dưới: 

 

- Copy: Sao chép nguồn tham khảo. 

- Delete: Xóa nguồn tham khảo. 

- Edit: Hiệu chỉnh nguồn tham khảo. 

- New: Thêm nguồn tham khảo mới. 

 

 Sử dụng nguồn tham khảo và trích dẫn 

Sau khi đã tạo xong nguồn tham khảo, ta tiến hành sử 

dụng chúng. Trước tiên ta thiết lập kiểu định dạng trong Style như 

hình bên (tùy vào mục đích của người sử dụng), ứng với mỗi kiểu 

khác nhau thì cách thể hiện trong tài liệu sẽ khác nhau. 

Để thêm trích dẫn, ta vào Insert Citation/ chọn danh sách 

mà ta đã tạo lúc trước để thêm trích dẫn. 
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Ví dụ: “Đây là giáo trình tin học B” (Trần, và những tác giả khác, 2013). 

Để thêm tài liệu tham khảo, ta bấm chọn Bibliography/ chọn Insert Bibliography: 

 

Kết quả: 
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Chú ý là mục Current list trong màn hình Soure Manager sẽ hiển thị đầy đủ ở đây 

(cho dù ta có sử dụng hay không). 

 Tạo ghi chú – FootNote, EndNote 

Ngoài ra Word còn hỗ trợ chức năng FootNote (tạo ghi chú ở cuối trang), chức năng 

này cũng rất là hữu dụng trong quá trình làm báo cáo, tiểu luận, luận văn. 

Ví dụ: Nhìn định dạng trong tài liệu dưới đây: 

 

Mẫu tạo ghi chú FootNote (rất thường xuyên được sử dụng) 

Để làm được như trên, ta tiến hành: 

- Bước 1: Di chuyển con trỏ văn bản vào vị trí cụm 

từ bất kỳ cần tạo ghi chú. 

- Bước 2: Vào tab References / chọn Insert Footnote 

(để hiệu chỉnh nâng cao ta có thể bấm chuột vào hình 

mũi tên ở góc phải dưới cùng của nhóm lệnh Footnotes). 

- Bước 3: Word sẽ di chuyển con trỏ văn bản xuống cuối trang và cho phép ta nhập ghi 

chú (xem hình trên). 

Chú ý: Chức năng này được sử dụng rất nhiều và rất thông dụng trong quá trình làm 

báo cáo, tiểu luận, luận văn tốt nghiệp. Ta không cần thiết phải hiệu chỉnh nâng cao vì đây là 

chuẩn được sử dụng nhiều nhất. 

1.3.3. Tạo bảng tác giả trong tài liệu 
Phần này sẽ nói về cách tạo bảng danh sách các 

tài liệu tham khảo dựa vào các trích dẫn đã nói ở phần 

trước. Trước tiên ta chèn danh sách tham khảo vào tài liệu 
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trước, sau đó bôi đen từng dòng tham khảo, rồi tạo “Mark Citation” (vào tab 

References/chọn Mark Citation trong nhóm Table of Authorities như hình trên) 

 Màn hình Mark Citation 

Tại màn hình này ta bấm Mark để thiết lập đánh dấu. Tương tự lặp cho hết các danh sách 

tham khảo trong tài liệu 

 

Sau đó bấm “Insert Table of Authorities” 

 

Bấm OK để chèn bảng danh sách tham khảo: 
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1.3.4. Tạo bảng chỉ mục cho tài liệu 
Chức năng này rất quan trọng, dùng để tạo mục lục cho bài báo cáo, tiểu luận, luận văn. Ví 

dụ ta cần tạo bảng chỉ mục cho đề cương chi tiết dưới đây: 

 

 

Sau đây là các bước tiến hành để tạo mục lục tự động cho đề cương chi tiết: 

- Bước 1: Tiến hành nhập đề cương (hoàn toàn không có bất kỳ định dạng nào cả, nhập 

từ trên xuống dưới) như sau: 
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(Khi ta làm đề cương chi tiết cho tiểu luận cũng nhập tương tự như trên) 

- Bước 2:  Xác định xem đề cương có bao nhiêu cấp (dựa vào tab thụt đầu dòng), trong 

trường hợp này thì ta xác định được đề cương trên có 3 cấp. Word cho chúng ta làm tối đa 

là 9 cấp, nhưng thường thì khi làm luận văn, báo cáo…Ta nên làm tối đa là 4 cấp để tài liệu 

không bị rối. Sát lề giấy bên trái là cấp 1, mỗi lần tăng tab 

lên 1 thì cấp tăng lên theo tỉ lệ thuận (n cấp thì có n-1 tab).  

 

Bước 3: Đề cương có bao nhiêu cấp thì tiến hành 
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làm từng đó Style, tức là trong trường hợp này ta tạo 3 style (cách tạo Style đã được nói 

trong phần thiết lập Font chữ và đoạn văn nâng cao). 

- Tạo style cho cấp 1 (chữ hoa, in đậm) 

- Tạo style cho cấp 2 (chữ thường, in đậm) 

- Tạo style cho cấp 3 (chữ thường) 

Tài liệu sẽ hướng dẫn tạo style cho cấp 1, các cấp khác lặp lại tương tự. Ta vào phần mở 

rộng của Style trong nhóm lệnh Styles của tab Home, bấm tạo mới Style (xem hình bên): 

 

 

 

- Bước 4: Gán Style và cấp. Vào tab View/chọn Outline để mở tài liệu ở chế độ 

Outlining 

 

 

 

Name: Đặt tên mang tính gợi nhớ, 

ví dụ: stylecuacap1 

 

Formatting: Tiến hành định dạng 

cho đúng với yêu cầu (Nút Format 

ở góc trái bên dưới màn hình cho 

phép chúng ta định dạng chi tiết) 

 

Tick vào Automatcally Update để 

tài liệu tự động cập nhật khi có sự 

thay đổi định dạng. 
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Chú ý là sau khi gán Style và cấp xong thì phải thoát khỏi chế độ màn hình này bằng 

cách bấm vào nút “Close Outline View” ở góc trên bên phải màn hình. 

 

 

Hình 1.82 – Màn hình Outlining để gán style và cấp 

Tại bước 4 này ta làm đúng theo trình tự như dưới đây: 

- Bôi đen toàn bộ các dòng cùng cấp (các dòng khác cấp không bôi),  đè phím Ctrl và 

dùng chuột bôi từ phải qua trái (vì ta chưa quen cách bôi, nếu bôi từ trái qua phải rất 

dễ bị mất dữ liệu). 

- Sau đó bấm chọn Style (theo đúng tên đặt mang tính gợi nhớ trong màn hình Style, ví 

dụ ta bôi cấp 2 thì chọn stylecuacap2) 

- Tiếp theo chọn đúng cấp trong mục Outline Tools (xem danh sách xổ xuống), theo ví 

dụ này thì ta phải chọn Level 2. 

- Như vậy ta có 3 cấp thì phải làm lần lượt 3 lần như vậy: Hết cấp 1, cấp 2 rồi tới cấp 3. 

- Sau khi gán xong thì nhớ bấm nút “Close Outline View”. 
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Bước 5: Thiết lập đa cấp cho tài liệu. Vào mục Define New Multilevel List… trong nhóm 

lệnh Paragraph của tab Home: 

 

Màn hình Define new Multilevel list hiển thị ra như bên dưới (ta bấm nút 

“More>>” để hiển thị chi tiết, bấm nút “<<Less” để hiện thị đơn giản. Ở đây ta cần bấm vào 

nút “More>>”) 

 

- Mục cấp từ 1 tới 9: Chọn tuần tự từng cấp để định dạng. 

- Mục danh sach Number style for this level: Chọn đúng kiểu định dạng đánh số mục 

lục (ví dụ cấp 1 thì chọn A,B,C..; cấp 2 thì chọn I,II,III,…; cấp 3 thì chọn 1,2,3…). 
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- Mục Link level to style: Gán đúng tên style cho đúng cấp (ví dụ level 1 thì chọn 

stylecuacap1, level 2 thì chọn stylecuacap2…). 

- Các thông số khác không phải hiệu chỉnh, sau đó bấm nút OK để tạo đa cấp cho tài 

liệu. 

- Kết quả sau khi tạo đa cấp: 

 

Bước 6: Tiến hành tạo mục lục tự động (bảng chỉ mục tự động). Ở đây ta cần hiểu rõ 

là trong một tài liệu thì chỉ có một bảng mục lục mà thôi, bảng này có thể được để ở đầu mỗi 

tài liệu hoặc để ở cuối mỗi tài liệu (bạn có thể xem tham khảo một số sách giáo khoa, có 

cuốn để mục lục đằng trước cuốn sách, có cuốn để mục lục đằng sau cuốn sách). Ta biết rằng 

khi tạo mục lục thì nó phải nằm riêng tại một trang (không nằm lẫn vào phần nội dung): 

- Tạo mục lục ở đằng trước cuốn sách: Di chuyển con trỏ văn bản vào dòng đầu tiên 

của bảng đa cấp ở trên, rồi gõ tổ hợp phím Ctrl + Enter, phần đa cấp (nội dung) sẽ bị 

đẩy xuống trang số 2, trang 1 ta dùng làm mục lục (ta thấy tạo mục lục nằm ở bên trên 

chữ Page Break). 

- Tạo mục lục ở đằng sau cuốn sách: Di chuyển con trỏ văn bản vào ký tự cuối cùng 

của dòng cuối trong bảng đa cấp ở trên, rồi gõ tổ hợp phím Ctrl + Enter, phần đa cấp 

(nội dung) sẽ ở bên trên, trang làm mục lục sẽ tạo thêm ở dưới cùng (ta tạo mục lục 

nằm ở bên dưới chữ Page Break). 

- Để hiển thị Page Break, phần đầu tài liệu có hướng dẫn sử dụng biểu tượng 

Show/Hide. 

Tài liệu này sẽ hướng dẫn cách tạo mục lục đằng trước cuốn sách, trường hợp còn lại 

làm tương tự. Như vậy sau khi đặt đúng vị trí con trỏ văn bản (ở bên trên chữ Page Break), 
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Ta vào tab References/ chọn Table of Contens/chọn Custom Table of Contents.. (xem 

hình): 

 

 

Hình 1.83 – Tạo bảng chỉ mục 

 

Bấm chọn Options để hiển thị bảng Table of Contents Options như bên dưới: 
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Tại mục TOC level, ta xóa toàn bộ những giá trị có sẵn của các styles đi, sau đó nhập 

theo đúng thứ tự từ số 1 cho tới số 3 vào stylecuacap1, stylecuacap2, stylecuacap3, tiếp tục 

bấm các nút OK để tạo bảng chỉ mục, xem kết quả: 

 

Hình 1.84 – Kết quả tạo mục lục tự động 

Như vậy ta được kết quả là: Bảng mục lục sẽ được tự động tạo ra và nằm ở trang số 

1, còn phần nội dung (bảng đa cấp) nằm ở trang số 2. Từ đây ta có thể nhập dữ liệu cho phần 

nội dung. Phần mục lục sẽ được cập nhập bằng thao tác: Bấm chuột phải vào vị trí bất kỳ 

trong mục lục/ chọn Update Field (hình 1.84): 
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- Update page numbers only: Cập nhật số trang cho bảng mục lục (khi nhập dữ 

liệu cho phần nội dung thì số trang sẽ tăng lên, ta dùng chức năng này để đồng bộ số trang 

cho mục lục). 

- Update entire table: Cập nhật tiêu đề cho mục lục (thường thì chỉ nên cập 

nhật khi chưa nhập nội dung, vì bảng đề cương chi tiết phải được chấp nhận là đúng đắn 

trước khi được nhập dữ liệu). 

Như vậy ta đã đi qua sáu bước để tạo được một mục lục cho tài liệu, ta cần nắm rõ cách 

tạo Style, đa cấp để có thể tạo mục lục một cách nhanh chóng và dễ dàng hơn.  

  

1.4.  Thực Hiện Chức Năng Trộn Thư 
 

Chức năng trộn thư là gì? Và tại sao ta nên biết chức năng này? Là nhân viên văn 

phòng ta thường phải thiết kế các biểu mẫu (thư mời, thư ngỏ, phiếu thông báo, quảng 

cáo…) và phải in ấn hoặc gửi email cho rất nhiều khách hàng, các mẫu này đa phần là giống 

nhau toàn bộ về hình thức trình bày cũng như nội dung, chỉ khác nhau chút ít về thông tin 

khách hàng. Danh sách khách hàng thì công ty (ta) đã có sẵn và được thu thập từ lâu. Câu 

hỏi đặt ra là có cách nào chỉ cần thiết kế một lần biểu mẫu và có thể được nhân bản ra rất 

nhiều các biểu mẫu khác tương ứng với thông tin của khách hàng một cách chính xác và 

nhanh gọn hay không? Đó là nhiệm vụ của chức năng trộn thư. Cụ thể ta sẽ tìm hiểu các 

chức năng dưới đây: 

 Thiết lập chức năng trộn thư 

 Thực hiện chức năng trộn thư 

 Tạo một thư trộn sử dụng từ danh sách ngoài 

 Tạo nhãn và bao thư 

1.4.1.  Thiết lập chức năng trộn thư 
Để tiến hành làm chức năng trộn thư thì ta phải có: Biểu mẫu và danh sách 

(dùng để đổ thông tin vào biểu mẫu khi trộn thư). Như vậy ta thiết kế biểu mẫu thật đẹp để 

đáp ứng nhu cầu sử dụng sau đó dùng chức năng trộn thư để nhân bản các biểu mẫu này ra 

theo đúng với số lượng và thông tin trong danh sách (vậy ta có 2 tập tin độc lập). 

Ví dụ ta cần làm thiệp mới theo mẫu sau (lưu với tên thumoi.docx): 
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Danh sách khách hàng để nhân bản thiệp mời (có thể lưu trong word, excel, access… 

hoặc nhập vào trong quá trình trộn thư): 

Tên khách hàng Địa chỉ Số điện thoại 

Nguyễn Văn Hùng Phong phú – Bình Chánh 0981131140 

Trần Duy Thanh Phường 5- Gò Vấp 0977777888 

Phạm Thị Xuân Diệu Kha vạn cân-Thủ Đức 0981234567 

Đỗ Công Thành Phường 1 – Quận Tân Bình 0973224244 

Nguyễn Cẩm Hương Phường 3 – Gò Vấp 0903335656 

1.4.2.  Thực hiện chức năng trộn thư 
Phần này giáo trình sẽ hướng dẫn sáu bước cụ thể để thực hiện chức năng trộn 

thư (danh sách nhập trong quá trình trộn thư). Ở đây ta quan sát lưu biểu mẫu vào ổ đĩa với 

tên bất kỳ (ví dụ thumoi.docx): 

 

 

Lễ Tri Ân Khách Hàng VIP 

Kính Gửi Anh/Chị: ......................................................  

Địa chỉ: ..........................................................................  

Số điện thoại: ................................................................  

Lễ tri ân lúc 10h00 ngày 01-09-2013 tại khách sạn Sheraton Quận 1 
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- Bước 1: Mở tập tin thumoi.docx, vào tab Mailings/ Start Mail Merge / chọn 

Letters 

 

 

- Bước 2: Vào Select Recipients/ chọn Type New List… 

 

Màn hình nhập danh sách xuất hiện sau khi ta chọn Type New List…: 

 

Ta vào Customize Columns… Để hiệu chỉnh cột thông tin (thêm, sửa, xóa cột) cho 

theo đúng với mục đích sử dụng: 

- Nút Add…: Để thêm một cột mới. 

- Nút Delete: Để xóa cột đang chọn. 

- Nút Rename…: Để chỉnh sửa cột đang chọn. 

- Nút Move Up: Để di chuyển thứ tự của cột 

đang chọn lên bên trên. 

- Nút Move Down: Để di chuyển thứ tự của cột 

đang chọn xuống bên dưới. 
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Ví dụ: Ta muốn thêm một cột mới tên là “Tên Khách Hàng”: 

Bấm chuột vào nút “Add…”/ của sổ Add Field hiển thị lên 

như bên dưới, ta nhập thông tin rồi nhấn nút OK để thêm cột 

mới. Tượng tự như vậy ta dùng các thao tác Delete để xóa các 

cột không cần thiết. 

 

Hiệu chỉnh đủ 3 cột như trên rồi nhấn nút OK để trở về màn hình  

 

 

Nhập thông tin khác hàng theo nhu cầu sử dụng. 

- New Entry: Thêm dòng mới để nhập dữ liệu (ta có thể nhấn phím Tab ở dòng cuối 

cùng để tự động tạo thêm dòng mới). 

- Delete Entry: Xóa dòng dữ liệu đang chọn. 

- Bấm nút OK để lưu danh sách (nên lưu cùng chỗ với tập tin thumoi.docx để dễ quản 

lý): 

Tập tin được lưu này sẽ có định dạng là Microsoft Access, ta xem màn hình chụp 

nơi lưu trữ danh sách (đuôi .mdb): 
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- Bước 3: Hiệu chỉnh danh sách (nếu có), bấm chọn Edit Recipient List để hiệu chỉnh: 

 

 

Màn hình cho phép hiệu chỉnh danh sách 

Tại màn hình này, muốn bỏ dòng dữ liệu nào thì ta bỏ Tick khỏi dòng đó, chức năng 

này ít được sử dụng vì mặc nhiên danh sách nhập vào chính là mong muốn nhân bản biểu 

mẫu của người sử dụng. 

- Bước 4: Chèn dữ liệu vào biểu mẫu, muốn chèn dữ liệu vào vị trí nào thì di chuyển 

con trỏ văn bản vào vị trí đó trước, rồi vào Insert Merge Field / chọn đúng tên cột hiển thị: 
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- Bước 5: Xem trước kết quả, chọn Preview Results: 

 

Để di chuyển qua lại giữa các nhân bản của biểu mẫu, ta bấm vào các biểu tượng kế 

bên nút PreView Results: 

- Bước 6: Kết thúc quá trình trộn thư, trong tab 

Mailings ta chọn nút Finish & Merge: 

- Edit Individual Documents…: Xuất các 

nhân bản biểu mẫu vào một tập tin (mỗi dòng dữ liệu 

sẽ tạo lên một biểu mẫu nằm ở 1 trang riêng biệt, tức là 

nếu ta có 5 dòng dữ liệu thì sẽ tự động tạo ra 5 biểu 

mẫu nằm ở 5 trang khác nhau), tên mặc định là 

Letters1. 

 

- All: Trộn toàn bộ danh sách. 

- Current record: Trộn dòng dữ liệu hiện tại đang xem (ở bước 5). 

- From … To : Trộn danh sách từ vị trí X tới vị trí Y (ví dụ From: 2, To: 4 thì 

trộn danh sách từ dòng thứ 2 tới dòng thứ 4). 

 

Bấm OK để xem kết quả: 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 81 

 

 

Ta nên lưu lại kết quả cùng chỗ với danh sách và biểu mẫu (ví dụ: ketquatronthu.docx) 

 

 

Vậy cuối cùng ta có tổng cộng là 3 tập tin như hình trên, từ đây ta có thể in ấn, gửi 

email trong tập tin ketquatronthu.docx. 

- Print Documents…: Dùng để in ấn kết quả trộn thư ra giấy trực tiếp trong quá trình 

trộn thư 

- All: In toàn bộ danh sách trộn thư. 

- Current record: In dòng dữ liệu hiện tại đang 

xem (ở bước 5). 

- From … To : In danh sách trộn từ vị trí X tới vị 

trí Y (ví dụ From: 2, To: 4 thì trộn danh sách từ dòng 

thứ 2 tới dòng thứ 4). 

 

- Send E-Mail Messages…: Gửi thông tin trộn thư qua email (tất nhiên phải sửa lại 

danh sách là bổ sung thêm cột email, chức năng này ta ít sử dụng, vì ta thường tách ra 

tập tin để in ấn hoặc gửi email trên website bằng tập tin kết quả, hoặc do máy ta đang 

sử dụng chưa cấu hình Mail Server để gửi). 
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1.4.3.  Tạo một thư trộn sử dụng từ danh sách ngoài 
Phần này sẽ trình bày chức năng trộn thư sử dụng danh sách ngoài (danh sách có 

sẵn), danh sách này có thể được lưu trong 1 tập tin Word, Excel, Access … Thường thì khi ta 

làm cho một công ty nào đó (công ty vừa và nhỏ), ta lưu danh sách khách hàng vào Excel 

(hiện nay Excel vẫn là giải pháp tối ưu cho các công ty vừa và nhỏ). 

 

Nhập danh sách vào tập tin Excel như sau (đặt tên danhsach.xlsx): 

 

 

Tập tin thư mời ta sẽ bổ sung hiển thị nếu cột “Khách hàng VIP” được dánh dấu là 

VIP thì trong biểu mẫu sẽ xuất hiện dòng chữ “Mời khách hàng tới phòng 01”, còn không có 

thì ghi “Mời khách hàng tới phòng 03”. 

 

- Bước 1: Vào Mailings/ Start Mail Merge/chọn Letters 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 83 

 

- Bước 2: Vào Mailings/ Select Recipients/ chọn Use Existing List… 

 

Trong màn hình Select Data Source: Ta tìm tới đúng tập tin danhsach.xlsx rồi bấm Open. 

 

 

Chọn Sheet1$ vì ta nhập dữ liệu ở Sheet1, bấm OK để chọn danh sách. 

- Bước 3: Hiệu chỉnh danh sách, bấm vào biểu tượng Edit Recipients: 
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Hiệu chỉnh những gì cần thiết rồi bấm nút OK. 

- Bước  4: Chèn dữ liệu vào biểu mẫu, tương tự như đã làm ở phần trước, ta di chuyển 

con trỏ văn bản vào nơi cần chèn rồi vào Insert Merge Field/ chọn đúng cột thông tin cần 

chèn. 

 

Ngoài ra để chèn dữ liệu theo đúng điều kiện: Nếu cột 

“Khách hàng VIP” được dánh dấu là VIP thì trong biểu mẫu sẽ xuất 

hiện dòng chữ “Mời khách hàng tới phòng 01”, còn không có thì 

ghi “Mời khách hàng tới phòng 03”. Ta di chuyển con trỏ tới nơi 

cần hiển thị, rồi vào Rules/ chọn If … Then…Else… 

 

Màn hình Insert Word Field: IF xuất hiện: 

- Field name: Chọn cột muốn so sánh (ở đây là cột khách 

hàng VIP). 
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- Comparison: Phép so sánh, tùy vào kiểu dữ liệu trong Field name mà phép so sánh sẽ 

khác nhau. Trong bài này thì 

ta chọn Equal to (so sánh 

bằng). 

Còn có các phép so sánh khác: 

Not equal to (so sánh không bằng), 

Less than (nhỏ hơn), Greater than 

(lớn hơn), Less than or equal (nhỏ 

hơn hoặc bằng), Greater than or 

equal (lớn hơn hoặc bằng),…. 

- Compare to: Giá trị so sánh, ta nhập vào từ VIP. 

- Insert this Text: Giá trị xuất hiện khi điều kiện đúng. 

- Otherwise insert this Text: Giá trị xuất hiện khi điều kiện sai. 

- Bấm OK để chèn điều kiện và quan sát kết quả. 

- Bước 5: Xem trước kết quả (như phần trước). 

 

- Bước 6: Kết thúc quá trình trộn thư (đã trình bày ở phần trước). 

 

1.4.4.  Tạo nhãn và bao thư 
 Chức năng trộn bao thư: 

Chức năng này cũng dựa vào danh sach có sẵn của phần trước đã minh họa, các 

bước làm như sau:  

- Bước 1: Mở tập tin mới/ vào tab Mailings/ Start Mail Merge / chọn Envelops… 
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Cửa sổ chọn bao thư sẽ xuất hiện như bên 

dưới: 

 

- Preview: Xem trước định dạng 

bao thư khi được in ra. 

- Envelope Size: Lựa chọn kích 

thước của bao thư. 

- Delivery Addres: Hiệu chỉnh font 

chữ in trên địa chỉ người nhận. 

- Return Address: Hiệu chỉnh font 

chữ in trên địa chỉ người gửi. 

- Bấm Ok để lưu hiệu chỉnh. 

Hình 1.85 – Cửa sổ chọn bì thư 

 

 

- Bước 2: Chọn danh sách để trộn bao thư (danh sách khách hàng ta muốn gửi thư tới), 

ở ví dụ trước ta lưu trong tập tin Excel(danhsach.xlsx): 

 

 

Vào tab Mailings/chọn Select Recipients/chọn Use Existing List… rồi trỏ tới đúng 

tập tin mà ta lưu trữ danh sách muốn gửi thư tới. 

 

Chọn đúng Sheet lưu trữ danh sách khách hàng: 
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Vì ở đây ta lưu ở Sheet 1 nên ta chọn Sheet1$ rồi nhấn nút Ok. 

Bước 3: Hiệu chỉnh danh sách (nếu có nhu cầu), chọn nút Edit Recipient List. 

Bước 4: Chèn dữ liệu vào bao thư. Bước này giống như phần trộn thư đã hướng dẫn, 

ở đây ta thiết kế và chèn dữ liệu sao cho phù hợp, ví dụ: 

 

- Bước 5: Xem trước kết quả (bấm chọn Preview Results như đã hướng dẫn ở phần 

trước). 

- Bước 6: Kết thúc quá trình trộn bao thư (bấm chọn Finish & Merge như đã hướng 

dẫn ở phần trước). 
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Hình 1.86 – Kết quả sau khi trộn bao thư 

 Chức năng trộn nhãn: 

Tương tự ta cũng có các bước dưới đây: 

- Bước 1: Trong tab Mailings vào Start Mail Merge/ chọn Labels… 

• Printer Information: 

Lựa chọn loại khay in, mặc định 

là Default tray (dĩ nhiên nó phụ 

thuộc vào máy tính ta đang sử 

dụng). 

• Label information: Lựa chọn 

nhà cung cấp giấy, ở đây ta sẽ chọn 

loại và kích cỡ giấy phù hợp với 

nhãn mà ta sẽ in (nên chọn A-ONE). 

• Product number: Gợi ý chọn 

A-ONE 28787 dùng cho loại 30 

nhãn, tùy vào nhu cầu mà ta chọn 

các product number khác nhau. Để xem chi tiết cho từng loại ta bấm vào nút Details 
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Hình 1.87 – Thông tin chi tiết cho từng loại version 

- Bước 2: Chọn danh sách để trộn (như hướng dẫn ở các phần trên). 

- Bước 3: Hiệu chỉnh danh sách (nếu có nhu cầu), chọn nút Edit Recipient List. 

- Bước 4: Chèn dữ liệu vào văn bản. 

- Bước 5: Xem trước kết quả (như hướng dẫn ở các phần trên). 

- Bước 6: Kết thúc quá trình trộn (như hướng dẫn ở các phần trên). 

 

1.5.  Quản lý Macros và Forms 
 

Chương này sẽ tập trung trình bày cách tạo và thực thi Macro, cách chạy Macro tự 

động khi mở một tài liệu và cách thiết kế biểu mẫu trong tài liệu, cụ thể chương trình sẽ đề 

cấp tới bốn mục kỹ năng dưới đây: 

 Thiết lập và thao tác với macros 

 Thiết lập và thao tác với các lựa chọn trong macros 

 Tạo forms 

 Thao tác với forms 

 

1.5.1.  Thiết lập và thao tác với macros 
Thực chất macros cũng tương tự như Autotext, khi có những thao tác ta phải lập 

đi lập lại nhiều lần, để giảm thiểu thời gian ta có thể dùng Autotext hoặc macros. Để tạo 

macros thì ta có thể dùng công cụ Record Macro hoặc tự viết mã lệnh trong VBA (viết 

macros bằng ngôn ngữ Visual Basic). Trong khuôn khổ giáo trình B, ta chỉ quan tâm tới 

Record Macro. Chú ý rằng Macro nằm trong tab Developer, mặc định tab này không được 

hiển thị trong thanh Ribbon do đó ta phải thiết lập cho tab Developer hiển thị. 

Vào Customize the Ribbon…, tick chọn tab Developer: 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 90 

 

Hình 1.88 – Hiển thị tab Developer 

 Cách sử dụng Macro Recorder 

Vào tab Developer/ chọn Record Macro trong nhóm lệnh Code 

 

Cửa sổ Record Macro sẽ xuất hiện như dưới đây: 

Đặt tên cho Macro name (mang tính gợi nhớ) 

 

Để thiết lập phím tắt cho macro, tại màn hình này ta chọn Keyboard: 
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- Press new shortcut key: Nhập phím tắt cho  macro này. 

- Assign: Bấm vào đây để chấp nhận phím 

tắt, lúc này nó sẽ được đưa vào danh mục 

Current keys, để đóng cửa sổ này thì nhấn 

nút Close. 

- Màn hình lưu Macro: 

- Stop Recording: Ngừng macro đang lưu. 

- Pause Recording: Tạm ngừng macro 

đang lưu. 

 Chạy Macro: 

Sau khi đã ngừng macro đang lưu, để 

chạy Macro này ta có thể gõ phím tắt như bên 

trên ta đã thiết lập hoặc bấm vào biểu tượng 

Macros trong nhóm lệnh code của tab 

Developer. 

Chọn tên Macro rồi nhấn nút Run (Ta 

có thể dùng phím tắt đã gán ở trên) để chạy 

macro, những thông tin được lưu trước đó sẽ 

tự động xuất hiện trong tài liệu (trong trường 

hợp này là cụm từ Trường Đại Học Công 

Nghệ Đồng Nai sẽ được đưa vào tài liệu. 

 Thiết lập Macro Security 

Ta phải cho phép Macro hoạt động bằng cách bấm nút lệnh Macro Security rồi cấu 

hình như bên dưới  
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1.5.2.  Thiết lập và thao tác với các lựa chọn trong macros 
Word cung cấp một số Macro mà nội tại của nó tự làm các công việc sau (khi 

Record Macro ta đặt tên trùng với tên của các Macro có sẵn): 

- AutoOpen: Tự động thực thi Macro khi mở tài liệu. 

- AutoExec: Tự động thực thi Macro khi ta mở chương trình word (trước khi mở bất kỳ 

một tập tin word nào). 

- AutoNew: Tự động thực thi Macro khi ta tạo mới một tài liệu. 

- AutoClose: Tự động thực thi Macro khi ta đóng tài liệu. 

- AutoExit: Tự động thực thi Macro khi ta thoát Word. 

- Ví dụ: 

 

Khi chọn Record Macro, ta đặt tên AutoOpen ở trong mục Macro name, lúc này 

Macro sẽ tự động thực thi khi ta mở tài liệu word. 

 

1.5.3.  Tạo forms 
Trong một số trường hợp ta cần làm những biểu mẫu để người sử dụng nhập 

thông tin, chẳng hạn như biểu mẫu dưới đây: 
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Word cho phép chúng ta thiết kế các control  (Plain Text Control, Rich Text 

Control, Button, Drop List, DateTime picker, RadioButton, Checkbox…), tùy vào mục đích 

sử dụng mà ta có thể lựa còn các control phù hợp. Ta nên dùng bảng để định vị trí cho các 

control trên form. 

Để thiết kế được Form, ta vào tab Developer như dưới đây (nếu không thấy thì ta 

vào Customize the Ribbon để mở lên): 

 

 

Để dễ dàng hiểu cách sử dụng Form, ta làm mẫu sau: 

 

 

Trước tiên ta cần định hình giao diện, dùng bảng để định vị cho các control. Để bắt 

đầu thiết kế thì ta phải chọn nút Design Mode rồi chọn các control phù hợp đưa vào biểu 

mẫu: 
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Để đưa ô nhập họ tên, ta di chuyển con trỏ văn bản vào đúng vị trí rồi bấm  vào 

biểu tượng Aa như hình dưới: 

 

Đối với Năm Sinh, ta cũng di chuyển con trỏ văn bản vào đúng vị trí rồi chọn Date 

Picker Control: 

 

Mục giới tính: Tại một thời điểm chỉ cho phép chọn một lựa chọn (Nam hoặc Nữ), 

ta dùng OptionButton Control. Chú ý rằng hai OptionButton phải cùng một nhóm. 

 

Kế đến ô tình trạng hôn nhân, ở đây ta có các tình trạng : Độc thân, có gia đình, ly 

thân, ly hôn. Vậy ta sử dụng Drop list control: 
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Ô email và điện thoại tương tự như ô nhập tên. 

Cuối cùng ta có ô sở thích, ở đây biểu mẫu đưa ra các sở thích: Xem phim, bóng 

đá, đọc sách. Người sử dụng có quyền chọn nhiều lựa chọn, vậy ta dùng Checkbox. 

 

Vậy ta đã thiết kế xong biểu mẫu, với các control phù hợp với mục đích sử dụng, 

phần tiếp theo sẽ trình bày các thao tác với control trong biểu mẫu. 

 

1.5.4.  Thao tác với forms 
Ta sẽ thông qua cách thao tác với một số control thường sử dụng nhất trong 

biểu mẫu, cụ thể ta sẽ thao các với các control đã trình bày ở phần trên. Ta bấm chuột vào 

từng Control rồi chọn Properties trong nhóm lệnh Controls của tab Developer: 

Đối với PlainText, RichText: 
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- Ta nhập tiêu đề (title) cho control để dễ thao tác trong quá trình sử dụng. 

- Đối với Datetime Picker (ô năm sinh): 

- Nhập tiêu đề (title), hiệu chỉnh Display the date like this (dd/MM/yyyy chính là hiển 

thị Ngày/tháng/năm, ví dụ 20/12/1983). 
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Đối với Radio Button: Ta phải thiết lập nhóm cho các control này, ở đây ta có giới 

tính Nam và Nữ, thì 2 Button này phải có cùng một nhóm để tại 

một thời điểm ta chỉ được chọn một lựa chọn mà thôi. 

 

 

 

 

 

 

 

 

 

 

 

Đối với Drop list tình trạng hôn nhân: 

 

 

Đối với Checkbox: Tại một thời điểm có thể chọn nhiều lựa chọn, ta có thể thay 

đổi cách hiển thị của Checkbox: 

Ta quan tâm tới một số thuộc tính thường sử dụng sau: 

Name: Đặt tên cho control 

Caption: Nhập dữ liệu hiển thị 

GroupName: Đặt tên nhóm, bất kỳ một Radio nào mà có 

cùng tên nhóm này thì tại một thời điểm nó chỉ được chọn 

một lựa chọn trong cùng một nhóm. 

Value: True để checked, False để bỏ checked, thường dùng 

để thiết lập giá trị mặc định. 

Add: Để nhập thêm dòng dữ liệu cho Drop list 

Modify: Để chỉnh sửa dòng đang chọn. 

Remove: Xóa dòng đang chọn 

Move up: Di chuyển dòng đang chọn lên trên 

Move Down: Di chuyển dòng đang chọn 

xuống dưới. 

 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 98 

 

Còn nhiều control khác, cách cấu hình cũng tương tự như các control phổ biến ở 

trên. Ngoài ra ta có thiết viết mã lệnh bằng VBA, trong khuổn khổ giáo trình chỉ đề cấp tới 

thiết kế và cách thức sử dụng. 

2. MICROSOFT EXCEL (NC) 
Trong phần này, chúng ta sẽ xây dựng những kỹ năng cần thiết để tạo, chỉnh sửa, định 

dạng bảng tính trong Microsoft Excel 2013. Chúng ta sẽ tìm hiểu sâu thêm về các kỹ năng để 

có thể được chứng nhận là một “ chuyên gia Microsoft Excel 2013”. 

➢ Chia sẻ và bảo quản tài liệu 

➢ Áp dụng công thức và hàm 

➢ Trình bày dữ liệu trực quan 

➢ Làm việc với macro và các hình thức 

2.1.  Chia Sẻ Và Bảo Quản Tài Liệu 
Chúng ta cần thiết lập một bảng tính được sử dụng bởi nhiều người riêng rẽ hay nhóm 

người dùng, bằng cách tạo ra một bảng tính mẫu, hay chúng ta cần bảo vệ cấu trúc của một 

bảng tính, cấm sự ngăn chặn của người dùng chèn hoặc xóa . 

Đối với một số bài tập nhóm thì chỉ có những thành viên trong nhóm mới có thể truy 

cập hay thiết lập riêng chỉ cho một số người có thể truy cập và cập nhật còn những người 

khác chỉ có thể đọc. 

 Thiết lập và lựa chọn hiệu chỉnh dữ liệu 

 Thiết lập bảo mật và chia sẻ tài liệu 

 Bảo quản tài liệu được chia sẻ 

 

2.1.1. Thiết lập và lựa chọn hiệu chỉnh dữ liệu 

Title: Nhập tiêu đề cho checkbox 

Checked symbol và Unchecked symbol: Ta có thể 

đổi biểu tượng bằng cách bấm vào nút Change: 
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Trong phần này chúng ta sẽ thiết lập một bảng tính như một bảng mẫu, thiết 

lập các thuộc tính, và cách để nhập và xuất dữ liệu sử dụng XML và bản đồ XML. 

❖ Lưu một bảng tính mẫu 

Một bảng tính mẫu  là một mẫu bảng tính mới trên một tập tin với tập hợp tiêu đề các 

cột và hàng , các công thức, định dạng và các thành phần khác đã được đặt ra.  

Bước đầu tiên trong việc thiết kế một bảng tính mẫu là ta thiết lập một bảng tính với 

những công thức, định dạng, và các yếu tố khác mà ta cần. 

Để ngăn chặn sự thay đổi mẫu bảng tính mà ta tạo ra, ta có thể tạo mật khẩu cho mẫu. 

Ta cũng có thể tạo mật khẩu cho đọc và truy cập vào các tập tin và mật khẩu để người dùng 

phải nhập vào để có thể thay đổi mẫu. 

Mặc định khi lưu các bảng tính mẫu (template ) thì Excel lưu trong thư mục: Users / 

UserName / AppData / Roaming / Microsoft /Template. Khi ta lưu mẫu ở vị trí này thì Excel 

sẽ hiển thị nó trong các mẫu hộp thoại khi người dùng chọn mẫu hoặc ta có thể lưu mẫu bảng 

tính trên mạng chia sẻ, nơi mà nhóm người dùng có quyền truy cập. 

 Các bước lưu bảng tính mẫu 

Bước 1. Chọn File → Save As 

 

Bước 2. Trong hộp thoại Save As, chọn loại ( Save as type ) → Excel 

Template (*.xltx). Nếu tập tin ta đang lưu như là một mẫu bao gồm các Macro, ta cần 

phải chọn Excel Macro – Enable Template (*.xltm). Nếu template ta cần để sử dụng 

với các phiên bản của Excel thì chọn: Excel 97-2003 Template (* .xlt). 
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Hình 2.1.1 

 

Bước 3. Chọn Tools → General Options 

  

Hình 2.1.2 
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Bước 4. Trong hộp thoại Options nhập mật khẩu để mở và một mật khẩu 

riêng để kiểm soát việc sửa đổi. 

 

 

Hình 2.1.3 

Bước 5. Sau đó chọn Ok→ Chọn Save As trong hộp thoại Save As. 

 

❖ Thiết lập thuộc tính bảng tính 

Khi ta tạo ra, nhập liệu, và chỉnh sửa bảng tính, Excel đều lưu lại các thuộc 

tính đó: kích thước tập tin, thời gian mà bảng tính được tạo ra và sửa đổi lần cuối cùng, 

cũng như tên tác giả của bảng tính. Thuộc tính thông thường là thuộc tính chỉ đọc ( Read 

Only). Các thuộc tính khác, bao gồm các thuộc tính nâng cao và các tùy chọn mà ta định 

nghĩa, nó có thể được thiết lập và chỉnh sửa bởi người dùng. 

Chúng ta có thể làm quen với các thuộc tính cơ bản mà Excel cung cấp. 

Vào tab File / Info: 

 

 

Hình 2.1.4 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 102 

Để thiết lập thuộc tính nâng cao cho bảng tính ta chọn Properties → Advanced 

Properties :  

 

 

Hình 2.1.5 

Sau đó ta thiết lập các thuộc tính trong  hộp thoại Advanced Properties: 

 

 

Hình 2.1.6 

 

Các Tab General, Statistics, và Contents hiển thị thông tin của bảng tính, một 

số thông tin đã hiển thị trong Info. Tab Summary, chúng ta có thể thiết lập Tiêu đề (Title) 

và Môn học ( Subject ). Tab Custom hiển thị danh sách các thuộc tính nâng cao : Check 

By, Client, Project, và Typist. Ta có thể để dạng mặc định hoạc có thể tự thiết lập theo 

danh sách có sẵn. Sau khi đã chọn ta Click Add. Để đổi tên, loại, hay giá trị của thuộc tính 

Click chọn Modify. 
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2.1.2. Thiết lập bảo mật và chia sẻ tài liệu 
Trong một số trường hợp chúng ta có thể chia sẻ bảng tính và cho phép bất kỳ người 

sử dụng nào làm việc với nó, chỉnh sửa nó theo ý thích : thay đổi định dạng, thêm hoặc xóa 

dữ liệu, chèn bảng,…Nhưng đa số chúng ta muốn bảo vệ bảng tính của mình, nhất là các 

bảng tính có tính chất quan trọng. Vì vậy để bảo vệ bảng tính ta thực hiện:  

- Cách 1:  Tab File → Info → Protect Workbook  

 

Hình 2.1.8 

 

- Cách 2: Vào Tab Review → group Changes  

 

 

Hình 2.1.9 

 

❖ Protecting Workbooks and Worksheets 
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Chúng ta có thể thiết lập bảo vệ bảng tính và một số Sheet quan trong bằng 

cách: 

➢ Bảo vệ cấu trúc bảng tính, bao gồm các worksheets,  kích thước, vị trí. 

Khi một cấu trúc bảng tính được bảo vệ ( Protect Structure ) thì người sử dụng không thể 

chèn, xóa, hoặc đổi tên, hoặc hiển thị các worksheet đẫ bị ẩn. Khi một cửa sổ bảng tính 

được bảo vệ ( Protect Windows ) thì người sử dụng không thể thay đổi kích thước hoặc vị 

trí của cửa sổ. 

  

Hình 2.1.10 

➢ Bảo vệ Worksheet : trong một bảng tính có nhiều worksheet, nhưng ta 

chỉ cần bảo mật một vài sheet cần thiết thì ta chọn Protect Worksheet . Trong hộp thoại 

Protect Sheet nhập mật khẩu, và lựa chọn một số thuộc tính cho phép người người sử dụng 

trong vùng “ Allow all users of this worksheet to:” 

 

Hình 2.1.11 

➢ Ta cũng có thể thiết lập một khu vực trong worksheet được bảo vệ cho 

phép người sử dụng có thể chỉnh sửa bằng chức năng “ Allow User to Edit Ranges” trong 

Maintab Review → group Changes 
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Hình 2.1.12 

 

- Trong hộp thoại Allow User to Edit Ranges chọn New : 

 

  

Hình 2.1.13 

 

 Thiết lập mật khẩu cho tập tin 

Bước 1. Mở tập tin muốn tạo mật khẩu →Tab File →Info → Protect 

Workbook → Encrypt with Password 
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Hình 2.1.14 

 

Bước 2. Nhập mật khẩu   

 

Hình 2.1.15 

Bước 3. Nhập lại mật khẩu vừa đặt 

 

Hình 2.1.16 

Bước 4. Click Ok hoàn thành  

2.1.3. Chia sẻ và Bảo quản tài liệu  
 Chia sẻ tài liệu 

Bước 1. Chọn Tab Review → Group Changes → Share Wokbook 
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Hình 2.1.17 

 

Bước 2. Trong cửa sổ Share Workbook →Tab Editing → Allow changes 

by more than one user at the same time. This also allows workbook merging 

 

Hình 2.1.25 

 

Bước 3. Tab Advanced cho phép bạn thiết lập một số tính năng cho tập 

tin được chia sẻ. 
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Hình 2.1.18 

Bước 4. Click Ok để hoàn thành. 

 Theo dõi sự thay đổi của tập tin 

Sau khi đã chia sẻ tập tin cho người khác hay nhóm cùng làm việc, để theo dõi 

sự thay đổi của tập tin để xem tập tin được chỉnh sửa, thêm hay thay đổi dữ liệu nào , ta thiết 

kế theo các bước: 

Bước 1. Chọn Tab Review → group Changes → Track Changes → 

Highlight Changes… 

 

Hình 2.1.19 

 

Bước 2. Trong hộp thoại Highlight Changes lựa chọn những điều kiện 

When , Who, Where thiết hợp theo yêu cầu của bạn. 
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Hình 2.1.20 

Bước 3. Click Ok để hoàn thành. 

➢ Với thiết lập này thì những vị trí mà dữ liệu thay đổi sẽ được làm dấu với 

Highlight. 

 

Hình 2.1.21 

 

 Xem chi tiết những thay đổi của tập tin 

Bước 1. Trong Tab Review → group Changes → Track Changes → 

Accept/Reject Changes 

Bước 2. Trong hộp thoại Select Changes to Accept or Reject bạn sẽ lựa 

chọn xem chi tiết thay đổi của dữ liệu khi nào , của ai, hay vùng nào,.. 

 

Hình 2.1.22 
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Bước 3. Trong hộp thoại Accept or Reject Changes sẽ hiển thị chi tiết các 

dữ liệu đã bị thay đổi và bạn có quyền chấp nhập hoặc không sự thay đổi đó. 

 

 

Hình 2.1.23 

 

2.2.  Thao Tác Với Công Thức Và Hàm 

2.2.1.  Kiểm tra công thức 
Chức năng Kiểm tra công thức (formula-auditing) của Excel hoạt động bằng 

cách tạo ra các tracer — là những cái mũi tên hai đầu chỉ ra các ô có liên quan trong một 

công thức.  

 

Hình 2.2.1 

 

Bạn có thể sử dụng các tracer để tìm ra ba loại ô như sau: 

• Precedents: Đây là các ô được tham chiếu trực tiếp hoặc gián tiếp trong một 

công thức. Ví dụ, ô B4 chứa công thức =B2; rồi B2 sau đó lại là một precedent trực tiếp 

của B4. Bây giờ giả sử rằng ô B2 chứa công thức =A2/2; điều này làm cho A2 trở thành 

một precedent trực tiếp của B2 đồng thời cũng là một precedent gián tiếp của B4. 

• Dependents: Đây là các ô được tham chiếu trực tiếp hoặc gián tiếp bởi một 

công thức đang nằm trong một ô khác. Trong ví dụ trên đây, ô B2 là 

một dependent trực tiếp của A2, và B4 là một dependent gián tiếp của A2. 

• Errors : Đây là những ô chứa một giá trị lỗi và đang được tham chiếu trực tiếp 

hoặc gián tiếp trong một công thức (và do đó nó gây ra một lỗi tương tự trong công 

thức này). 
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Hình 2.2.2: Minh họa một bảng tính với ba ví dụ của các mũi tên tracer 

 

- Ô B4 chứa công thức =B2, và B2 chứa công thức =A2/2. Những cái mũi tên (màu 

xanh) chỉ ra các precedent(trực tiếp và gián tiếp) của B4. 

- Ô D4 chứa công thức =D2, và D2 chứa công thức =D1/0, gây ra lỗi #DIV/0!, do đó, 

lỗi này cũng xuất hiện ở ô D4. Mũi tên (màu đỏ) chỉ ra nguồn gốc của lỗi. 

- Ô G4 chứa công thức =Sheet2!A1. Excel hiển thị một mũi tên đứt khúc với một cái 

biểu tượng bảng tính ở đuôi mũi tên khi precedent hoặc dependent nằm trên một trang 

tính (worksheet) khác. 

 Truy tìm các Precedent của ô 

Bước 1. Chọn ô chứa công thức mà bạn muốn truy tìm precedent của nó. 

Bước 2. Chọn Tab Formulas →Group Fomula Auditing → Trace 

Precedents. Excel sẽ thêm một mũi tên vào mỗi cái precedent trực tiếp 

 

 

 

Hình 2.2.3 

Bước 3. Tiếp tục lập lại bước 2 để thêm các cấp precedent (nếu có). 
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Hình 2.2.4 

 

 Truy tìm các Dependent của ô 

Bước 1. Chọn ô chứa công thức mà bạn muốn truy tìm Dependent của nó. 

Bước 2. Chọn Tab Formulas →Group Fomula Auditing → Trace Dependents 

 

 

Hình 2.2.5 

 

Bước 3. Tiếp tục lập lại bước 2 để thêm các cấp Dependent (nếu có). 

 Gỡ bỏ những mũi tên Tracer 

➢ Chọn Tab Formulas →Group Fomula Auditing → Remove Arrows 
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Hình 2.2.6 

➢ Để gỡ bỏ các mũi tên precedent mỗi lần một cấp, chọn  Remove 

Precedent Arrows. 

➢ Để gỡ bỏ các mũi tên dependent mỗi lần một cấp, và chọn Remove 

Dependent Arrows. 

 

 Các thông báo lỗi thường gặp 

Khi Excel không tính được một công thức thì chương trình sẽ báo lỗi sai, bắt 

đầu bằng dấu #, dưới đây là danh sách các thông báo lỗi thường gặp. 

 

Thông báo 

lỗi 
Nguyên nhân 

#DIV/0! Trong công thức có phép tính chia cho 0. 

#N/A 
Công thức tham chiếu đến ô có giá trị không 

tìm thấy hoặc nhập hàm thiếu đối số. 

#NAME? Trong công thức có tên hàm hoặc tên ô sai. 

#NULL 
Xảy ra khi xác định giao giữa 2 vùng 

nhưng vùng giao nhau là rỗng. 

#NUM! Dữ liệu số bị sai. 

#REF! 
Xảy ra khi trong công thức có tham chiếu 

đến một địa chỉ không hợp lệ. 

#VALUE! 
Trong công thức có các toán hạng và 

toán tử sai kiểu. 

 

 Sửa chữa lỗi công thức 

Nếu bạn thiếu một dấu ngoặc đơn khi nhập một công thức, hoặc nếu bạn đặt 

một dấu ngoặc đơn sai vị trí, Excel thường hiển thị một hộp thoại như minh họa ở hình bên 

dưới khi bạn cố xác nhận công thức. Nếu thấy công thức (do Excel gợi ý trong hộp thoại) là 
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đúng những gì bạn muốn, bạn nhấn Yes để Excel tự động sửa lại công thức cho bạn; còn nếu 

thấy công thức đó sai, bạn nhấn No và tự sửa lại công thức. 

 

Hình 2.2.7 

 

 Sử dụng chức năng kiểm tra lỗi công thức 

Nếu bạn sử dụng Microsoft Word, có lẽ bạn đã quen với những đường gợn 

sóng màu xanh xanh xuất hiện ở bên dưới các từ hoặc cụm từ mà chương trình kiểm tra 

văn phạm (grammar checker) cho là không đúng. Grammar checker hoạt động bằng 

cách sử dụng một bộ quy tắc để kiểm tra văn phạm và cú pháp. Khi bạn nhập văn 

bản, grammar checker âm thầm theo dõi từng câu từng chữ của bạn, nếu có thứ gì đó 

bạn nhập không đúng với những quy tắc của grammar checker, đường gợn sóng sẽ xuất 

hiện để báo cho bạn biết là có vấn đề. 

Excel cũng có tính năng tương tự như vậy: chức năng kiểm tra lỗi công thức 

(formula error checker). Nó tương tự như grammar checker, dùng một một bộ quy tắc để 

kiểm tra các phép tính và cũng hoạt động cách âm thầm khi giám sát những công thức 

của bạn. Nếu nó phát hiện ra điều gì đó không ổn, nó sẽ hiển thị một dấu hiệu báo lỗi — 

một cái tam giác màu xanh — ở góc trái phía trên của ô chứa công thức. 

 

Hình 2.2.8 

 

❖ Cách sửa chữa lỗi 

Khi bạn chọn cái ô có dấu hiệu báo lỗi, Excel hiển thị một smart tag ngay 

cạnh đó, và nếu bạn đặt con trỏ chuột lên trên cái biểu tượng mới xuất hiện này, một câu 

thông báo miêu tả lỗi mắc phải sẽ hiện lên, như minh họa trong hình trên. Bên góc phải 

của biểu tượng này còn có một nút nhấn để mở ra một danh sách những cách xử lý lỗi 

cho bạn chọn: 
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- Help on This Error : Tìm hiểu thông tin về lỗi qua hệ thống Help của 

Excel. 

- Show Calculation Steps : Chạy chức năng Evaluate Formula (đánh 

giá công thức).  

- Ignore Error : Bỏ qua, giữ nguyên công thức sai như vậy. 

- Edit in Formula : Hiển thị công thức trong chế độ chỉnh sửa (Edit) 

trên thanh công thức (formula bar). Chẳng qua là để cho bạn tự sửa lại 

công thức.  

- Error-Checking : Hiện các tùy chọn của chức năng Error Checking từ 

hộp thoại Option để bạn chọn. 

 

Hình 2.2.9 

 

❖ Thiết lập các tùy chọn cho việc kiểm tra lỗi 

• Cũng giống như việc kiểm tra ngữ pháp trong Word, chức năng 

kiểm tra lỗi công thức (Formula Error Checker) cũng có một số những tùy chọn để 

quy định cách nó làm việc và sẽ đánh dấu những lỗi nào. Để xem những tùy chọn 

này, bạn có hai cách: 

- Chọn Office, Excel Options để hiển thị hộp thoại Excel Options, 

và chọn Formulas 

- Chọn Error-Checking Options trong danh sách xổ xuống của cái 

biểu tượng báo lỗi (như đã nói trong bài trước). 

• Cả hai cách đều mở ra những tùy chọn cho Error 

Checking và Error Checking Rules như minh họa: 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 116 

 

Hình 2.2.10 

 

 

Hình 2.2.11 

 

• Enable Background Error Checking : Check box này bật và tắt chế 

độ tự động của chức năng Formula Error Checker. Nếu bạn tắt chế độ này, mỗi khi bạn 

muốn kiểm tra lỗi công thức, bạn chọn Formulas, Error Checking. 

• Indicate Errors Using This Color : Chọn màu cho dấu chỉ báo lỗi (cái 

tam giác nhỏ xíu ở góc bên trái ô có lỗi). 

• Reset Ignored Errors : Nếu bạn đã bỏ qua một hoặc nhiều lỗi, bạn có 

thể cho hiển thị lại các lỗi đó bằng cách nhấn nút này. 

• Cells Containing Formulas That Result in an Error : Khi tùy chọn 

này được kích hoạt, chức năng Formula Error Checker sẽ đánh dấu vào ô công thức có 
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kết quả là các giá trị lỗi như #DIV/0!, #NAME?, hay bất kỳ giá trị lỗi nào đã sử dụng 

trước đó. 

• Inconsistent Calculated Column Formula in Tables : (Tùy chọn mới 

ở phiên bản Excel 2007) Khi tùy chọn này được kích hoạt, Excel kiểm tra các công 

thức trong cột dùng để tính toán của một Table (một dạng bảng đặc biệt của Excel), và 

đánh dấu vào những ô có công thức mà cấu trúc của công thức này không giống với 

những công thức khác trong cột. Trong smart tag ở ô có lỗi, có kèm thêm lệnh Restore 

to Calculated Column Formula, cho phép bạn cập nhật lại công thức để nó nhất quán 

với những công thức ở phần còn lại trong cột. 

• Cells Containing Years Represented as 2 Digits : Khi tùy chọn này 

được kích hoạt, chức năng Formula Error Checker sẽ đánh dấu vào những công thức 

có bao gồm những giá trị ngày tháng mà trong đó con số chỉ năm chỉ có 2 chữ số (một 

tình huống mơ hồ, không rõ ràng, bởi vì chuỗi đó có thể tham chiếu đến một ngày nào 

ở những năm 1900 lẫn những năm 2000). Với trường hợp này, danh sách tùy chọn 

trong smart tag có chứa hai lệnh — Convert XX to 19XX và Convert XX to 20XX — 

cho phép bạn chuyển đổi con số chỉ năm có 2 chữ số thành con số có 4 chữ số. 

• Numbers Formatted as Text or Preceded by an Apostrophe : Khi 

tùy chọn này được kích hoạt, chức năng Formula Error Checker sẽ đánh dấu vào 

những ô có chứa một con số được định dạng dưới dạng text hoặc có một dấu nháy đơn 

(') ở trước. Với trường hợp này, danh sách tùy chọn trong smart tag có thêm 

lệnh Convert to Number để chuyển con số đó thành một con số thật sự (định dạng theo 

kiểu số). 

• Formulas Inconsistent with Other Formulas in the Region : Khi tùy 

chọn này được kích hoạt, chức năng Formula Error Checker sẽ đánh dấu vào những 

công thức có cấu trúc khác với những công thức tương tự ở xung quanh nó. Với 

trường hợp này, danh sách tùy chọn trong smart tag có thêm một lệnh đại loại 

như Copy Formula from Left (copy công thức ở ô bên trái sang đây) để làm cho công 

thức này nhất quán với những công thức xung quanh.  

• Formulas Which Omit Cells in a Region : Khi tùy chọn này được 

kích hoạt, chức năng Formula Error Checker sẽ đánh dấu vào những công thức (mà 

những công thức này) bỏ qua các hàng gần kề với dãy được tham chiếu trong công 

thức. 

• Unlocked Cells Containing Formulas : Khi tùy chọn này được kích 

hoạt, chức năng Formula Error Checker sẽ đánh dấu vào những công thức nằm trong 

các ô không được khóa (unlocked). Đây không phải là một lỗi mà là một cảnh báo 

rằng những người khác có thể sửa đổi công thức, ngay cả sau khi bạn đã bảo vệ 

(protect) bảng tính. Với trường hợp này, danh sách tùy chọn trong smart tag có thêm 
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lệnh Lock Cell dùng để khóa ô lại và ngăn không cho người dùng khác thay đổi công 

thức sau khi bạn đã bảo vệ bảng tính. 

• Formulas Referring to Empty Cells : Khi tùy chọn này được kích 

hoạt, chức năng Formula Error Checker sẽ đánh dấu vào những công thức tham chiếu 

đến các ô rỗng. Với trường hợp này, danh sách tùy chọn trong smart tag có thêm 

lệnh Trace Empty Cell để cho phép bạn tìm ô rỗng mà công thức này đang tham chiếu 

đến (và bạn có thể nhập dữ liệu vào ô rỗng đó, hoặc điều chỉnh công thức sao cho nó 

không tham chiếu đến ô này nữa). 

• Data Entered in a Table Is Invalid : Khi tùy chọn này được kích hoạt, 

chức năng Formula Error Checker sẽ đánh dấu vào những ô vi phạm các quy tắc hiệu 

lực hóa dữ liệu (data-validation rules) của một Table. Điều này có thể xảy ra nếu bạn 

thiết lập một quy tắc Data-validation với chỉ một kiểu Warning hoặc Information, 

người dùng vẫn có thể chọn nhập những dữ liệu không hợp lệ trong trường hợp này, 

và Formula Error Checker sẽ đánh dấu vào những ô chứa dữ liệu không hợp lệ. Danh 

sách tùy chọn trong smart tag có thêm lệnh Display Type Information, hiển thị quy 

tắc Data-validation mà những ô đó vi phạm. 

 Sử dụng Watch Window 

Tính năng này giúp ta theo dõi các ô trong quá trình tính toán. Bạn muốn giám 

sát ô nào thì đưa nó vào danh sách giám sát ở cửa sổ của Watch Window. Gọi cửa sổ Watch 

Window : 

- Chọn  Tab Formulas →  group Formula Auditing → Watch Window 

 

Hình 2.2.12 

 

- Sau đó chọn ô cần theo dõi và nhấn vào nút Add Watch trên cửa sồ Watch 

Window. 

 

Hình 2.2.13 
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 Sử dụng chức năng Data Validation trong quản lý nhập liệu 

Khi xây dựng bất cứ bảng tính nào đó phục vụ công việc mình, chắc chắn bạn 

sẽ cần những  vùng nhập dữ liệu theo yêu cầu nhất định nào đó. Dữ liệu đó có thể được giới 

hạn trong một  phạm vi nào đó, có thể là số nguyên, số thập phân, ngày, giờ, trong danh sách 

sẵn có hoặc chuỗi có độ dài nhất định. Khi đó chức năng Data validation sẽ giúp chúng ta 

nhập liệu một cách chính xác theo yêu cầu, hạn chế sai sót tối thiểu.  

Ví dụ: Điểm nhập vào phải >=0 và <=10: 

 

Hình 2.2.14 

 

Để thiết lập việc nhập liệu theo điều kiện, ta thực hiện: 

Bước 1.  Chọn vùng muốn thiết lập điều kiện . 

Bước 2. Vào Tab Data →  group Data Tools → Data Validation 

 

Hình 2.2.15 

 

Bước 3. Trong hộp thoại Data Validation như hình bên dưới, có ba Tab Setings, 

Input Message, Error Alert. 
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Hình 2.2.16 

 

1. Thẻ Settings  

Cửa sổ Settings cho phép thiết lập cài đặt về điều kiện nhập liệu trong 

Validation criteria. Tuỳ vào đối tượng kiểm soát mà ta chọn trong danh sách bên dưới 

Allow. Mặc định ban đầu cho phép nhập bất cứ kiểu dữ liệu nào trong ô (Any value). Để 

thay đổi theo ý muốn, đầu tiên ta chọn vùng dữ liệu cần thiết lập chức năng Validation. 

Trong danh sách thả xuống của Validation criteria, có các lựa chọn 

Whole number, Decimal, List, Date, Time, Text lenght, Custom. 

 

Hình 2.2.17 
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➢ Whole number: Chức năng này chỉ cho phép nhập liệu là số 

nguyên. Nếu nhập số thập phân, chuỗi,... sẽ bị báo lỗi. Chức năng này hữu ích khi dữ 

liệu nhập là tuổi, số lượng mặt hàng, số sản phẩm, điểm thi,... Khi chọn Whole 

number, chức năng Data xuất hiện cho phép khống chế phạm vi giá trị nhập: 

 

Hình 2.2.18 

 

Các toán tử: 

- Between: giá trị trong ô nằm trong đoạn từ a đến b (bao gồm 2 cận 

trên và dưới a, b) 

- Not between: giá trị trong ô không nằm trong đoạn [a, b] 

- Equal to: giá trị trong ô bằng (=) với giá trị so sánh 

- Not equal to: giá trị trong ô không bằng (≠) giá trị so sánh 

- Greater than: giá trị trong ô lớn hơn (>) giá trị so sánh 

- Less than: giá trị trong ô nhỏ hơn (<) giá trị so sánh 

- Greater than or equal to: giá trị trong ô lớn hơn hoặc bằng (≥) giá 

trị so sánh 

- Less than or equal to: giá trị trong ô nhỏ hơn hoặc bằng (≤) giá trị 

so sánh 

➢ Decimal: Chức năng này chỉ cho phép nhập liệu là số nguyên 

hoặc số thập phân. Cách thực hiện tương tự đối với Whole number. Sử dụng kiểu giá 

trị Decimal cho phép tránh được những sai sót do quy định về số thập phân Quốc tế 

và Việt Nam (dấu chấm và phẩy). 

➢ List: Chức năng này chỉ cho phép nhập liệu từ một danh sách sẵn 

có. Danh sách này có thể được nhập trực tiếp, từ một vùng trong sheet, từ tên (Name) 

vùng sẵn có hoặc từ file khác. Nên sử dụng chức năng này khi bạn cần nhập liệu được 
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lấy từ một cơ sở dữ liệu (CSDL) sẵn có nằm hạn chế sai sót, rút ngắn thời gian. Ví dụ 

như nhập danh sách môn học, mã môn học, lớp...... Điều này cho phép hạn chế tối đa 

do nhập liệu không đúng dẫn đến kết quả tính toán sai, đặc biệt là đối tượng nhập là 

chuỗi. 

➢ Date: Chức năng này chỉ cho phép nhập liệu là ngày. Việc điều 

khiển về khoảng ngày nhập giống như đối với Whole number. Điều đó có nghĩa là 

chọn ngày trong 1 khoảng xác định, ngày bắt đầu, ngày kết thúc,... 

➢ Text length: Chức năng này chỉ cho phép nhập liệu là chuỗi có 

độ dài xác định (tính bằng số ký tự, kể cả koảng trắng, dấu,...). Việc điều khiển về 

chiều dài chuỗi nhập giống như đối với Whole Number. Điều đó có nghĩa là có thể 

kiểm soát được chiều dài chuỗi nhập giới hạn trong 1 bảng xác định, chiều dài chuỗi 

nhập nhỏ nhất, chiều dài chuỗi nhập lớn nhất,... Ví dụ như trong hình 16, chỉ cho phép 

nhập mã hàng có chiều dài 6 ký tự. 

 

2. Input Message 

Chức năng Input Message cho phép hiển thị thông tin nhập liệu khi di 

chuyển chuột vào ô  đó, từ đó định hướng cho công việc nhập liệu. Gồm có các thông số: 

➢ Show input message when cell is selected: Bật (tắt) chế độ hiển 

thị thông báo khi ô được chọn. Trường hợp này chọn Bật. 

➢ Title: Nội dung tiêu đề hiển thị, dùng kiểu gõ Unicode. 

➢ Input message: Nội dung thông báo, dùng kiểu gõ Unicode. 

Ví dụ: 

 

Hình 2.2.19 

 

➔ Thì lúc đó trong vùng bạn chọn điều kiện sẽ hiển thị thông báo như sau: 
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Hình 2.2.20 

 

3. Error Alert 

Khi ô đã được đặt chế độ Data validation, nếu nhập liệu không đúng quy 

định sẽ bị thông báo Ta có thể thay đổi nội dung thông báo mặc định đó theo các hoàn cảnh 

khác nhau và hiển thị nội dung thông báo đó bằng tiếng Việt cho dễ hiểu và sửa đổi. 

 

 

Hình 2.2.21 

 

➢ Show error alert after invalid data is selected: Bật (tắt) chế độ 

hiển thị cảnh báo sau khi  dữ liệu được nhập vào ô. Trường hợp này chọn Bật. 

➢ Style: Kiểu cảnh báo, gồm Stop (dừng lại), Warrning (cảnh báo), 

Information (thông tin). 
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Tuỳ mức độ cảnh báo mà có cách xử lý phù hợp. 

- Stop: Thông báo lỗi nhập liệu nghiêm trọng, Excel không chấp 

nhận giá trị nhập liệu này và yêu cầu phải nhập đúng mới được chấp nhận. 

- Warning: Thông báo lỗi nhập liệu mang tính cảnh báo, tùy 

trường hợp có thể chấp nhập hoặc không chấp nhận giá trị nhập liệu. 

- Information: Thông báo lỗi nhập liệu mang tính thông tin, bạn 

có thể bỏ qua trường hợp nhập liệu không đúng quy định. 

➢ Title: Nội dung tiêu đề thông báo, dùng kiểu gõ Unicode. 

➢ Input message: Nội dung thông báo (chú ý nội dung theo những 

hoàn cảnh cụ thể), dùng kiểu gõ Unicode. 

 

 

Hình 2.2.22 

 

2.2.2. Định dạng có điều kiện ( Conditionnal Formatting ) 
Sử dụng bảng dữ liệu Excel, khi cần tách lọc các dữ liệu cần thiết theo một 

quy tắc cụ thể, đại đa số người dùng đều thực hiện chức năng lọc (Filter) của phần mềm 

Excel. Tuy nhiên, nếu muốn đặt phần dữ liệu đó với định dạng nổi bật riêng biệt thì chức 

năng lọc không thể đáp ứng được. Để đạt được điều đó, bạn phải sử dụng chức năng định 

dạng có điều kiện (Conditional Formatting) của phần mềm Excel. 

Chức năng Conditional Formatting là kỹ thuật định dạng, cho phép bạn thiết 

lập định dạng riêng những ô được lựa chọn, khi dữ liệu trong các ô đó thỏa mãn điều kiện 

đã định sẵn. 

Việc định dạng khác biệt cho các ô dữ liệu thỏa mãn điều kiện, giúp người 

xem nhanh chóng nhận ra được các thông tin đủ điều kiện, trong khi vẫn xem được tổng 

thể bao gồm các dữ liệu khác. 
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Ví dụ: Trong hình dưới đây, không đơn giản để nhân viên có thể nhận ra đâu 

là đơn hàng quá hạn nhưng chưa cung cấp đủ số lượng, đâu là đơn hàng gần tới hạn 

nhưng chưa có đủ số lượng yêu cầu. 

 

 

Hình 2.2.23 

 

Nếu có sử dụng chức năng định dạng, người sử dụng có thể nhanh chóng 

thấy được các đơn hàng quá hạn nhưng chưa đủ số lượng được đánh dấu màu đỏ nhạt ; 

các đơn hàng sắp tới hạn nhưng chưa được cung cấp đầy đủ được đánh dấu màu vàng. 

 

Hình 2.2.24 
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Trong trường hợp sử dụng chức năng Conditional Formatting, toàn bộ dữ 

liệu đáp ứng điều kiện sẽ được tự động định dạng riêng biệt, giúp người sử dụng nhanh 

chóng nhận ra những vấn đề cần xử lý. 

Ngoài ra, từ phiên bản Office 2007, tính năng Conditional Formatting của 

phần mềm Excel được nâng cấp với nhiều mức điều kiện, sử dụng nhiều cách thức định 

dạng đẹp và ấn tượng như Data Bars, Color Scales, Icon Sets v…v… 

 Các định dạng theo mẫu sẵn 

Bước 1. Chọn vùng muốn định dạng. 

Bước 2. Vào Tab Home → group Style → Conditional Formatting 

 

Hình 2.2.25 

 

Bước 3. Chọn định dạng điều kiện muốn thiết lập. 

 

Hình 2.2.26 

 

Bảng dưới đây liệt kê các đối tượng có trong hộp thoại Conditional 

Formatting Rules Manager. 
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Hình 2.2.27 

 

Đối tượng Tác dụng 

Show 

formatting 

rules for 

Đối tượng được sử dụng để lọc ra các điều kiện đang được sử dụng. 

Thông thường bạn có thể để lựa chọn Current Selection để xem định 

dạng có điều kiện cho vùng/ô được chọn, hoặc thay đổi sang mục This 

Worksheet để xem toàn bộ các định dạng có điều kiện đang được sử 

dụng trong tập tin bảng tính. 

New Rule Nút sử dụng để tạo một luật mới. 

Edit Rule Nút sử dụng để sửa luật đang chọn. 

Delete Rule Nút sử dụng để xóa luật đang chọn. 

Move 

Up/Move 

Down 

Hai nút sử dụng để thay đổi trình tự ưu tiên của luật đang được chọn: lên 

trên luật liền kề phía trên hoặc xuống dưới luật liền kề phía dưới. 

Stop If 

True 

Cột lựa chọn ngừng thực thi các luật tiếp theo, nếu luật tương ứng mục 

chọn đã đúng. 

 

 Hộp thoại New Formatting Rule 

Trong các phiên bản Excel từ 2007, để tạo một luật mới, bạn sẽ phải sử dụng 

hộp thoại New Formatting Rule. Hộp thoại trong các phiên bản “đời sau” được chia 

thành 2 phần chính là: Select a Rule Tyle và Edit the Rule Description. 
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Hình 2.2.28 

 

Kiểu luật Tác dụng 

Format all cells based 

on their values 
Định dạng có điều kiện dựa trên giá trị có trong ô. 

Format only cells that 

contain 

Định dạng có điều kiện dựa trên việc xác định thành phần 

dữ liệu có chứa. Ví dụ: có chứa chữ officelab.vn, dữ liệu 

trống, dữ liệu ngày hôm qua v…v… 

Format only top or 

bottom ranked values 

Định dạng có điều kiện cho các dữ liệu cao nhất hoặc thấp 

nhất. Các tùy chọn trong phần này cho phép định dạng theo 

số lượng cụ thể hoặc phần trăm. 

Format only values 

that are above or 

below average 

Định dạng có điều kiện cho các dữ liệu trên hoặc dưới trung 

bình theo nhiều tiêu chí khác nhau. 

Format only unique or 

duplicate values 

Định dạng có điều kiện để nhận diện các dữ liệu duy nhất 

hoặc trùng lặp. 

Use a formula to 

determine which cells 

to format 

Định dạng có điều kiện dựa theo công thức do người sử 

dụng xây dựng. 

 

 Để định dạng với Conditional Formatting 

❖ Để đánh dấu nhanh các ô thỏa mãn các điều kiện cơ bản 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 
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Bước 4. Trong trình đơn Conditional Formatting, chọn Highlight Cells 

Rules. 

Bước 5. Trong trình đơn con Highlight Cells Rules, chọn loại điều kiện 

bạn muốn sử dụng. 

Bước 6. Nhập các chỉ số cần thiết và kiểu định dạng trong hộp thoại điều 

kiện, nhấn Ok để xác nhận việc định dạng. 

❖ Để đánh dấu nhanh các ô theo luật cao/thấp 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Top/Bottom 

Rules. 

Bước 5. Trong trình đơn con Top/Bottom Rules, chọn loại luật cao/thấp 

bạn muốn sử dụng. 

Bước 6. Trong hộp thoại điều kiện, nhập các chỉ số và kiểu định dạng bạn 

muốn sử dụng. 

Bước 7. Nhấn Ok để xác nhận điều kiện và thực hiện định dạng. 

❖ Để định dạng theo độ lệch Data Bars 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Data Bars. 

Bước 5. Trong trình đơn con Data Bars, chọn loại màu bạn muốn sử 

dụng. 

❖ Để định dạng theo độ biến thiên Color Scales 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Color Scales. 

Bước 5. Trong trình đơn con Color Scales, chọn loại màu bạn muốn sử 

dụng. 

❖ Để định dạng theo biểu tượng phân nhóm Icon Sets 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Icon Sets. 
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Bước 5. Trong trình đơn con Icon Sets, chọn tập hợp biểu tượng bạn 

muốn sử dụng. 

❖ Để tạo một định dạng tùy biến bằng hộp thoại New Formatting Rule 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn New Rule. 

Bước 5. Trong hộp thoại New Formatting Rule, đặt các điều kiện mong 

muốn. 

Bước 6. Nhấn Ok để xác nhận điều kiện và thực hiện việc định dạng. 

❖ Để xem các định dạng có điều kiện đang được sử dụng 

Bước 1. Trên thanh Ribbon, chọn thẻ Home. 

Bước 2. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 3. Trong trình đơn Conditional Formatting, chọn Manage Rules. 

Bước 4. Trong mục Show formatting rules for, chọn This Worksheet. 

❖ Để sửa một định dạng có điều kiện 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Manage Rules. 

Bước 5. Trong hộp thoại Conditional Formatting Rules Manager, chọn 

định dạng bạn muốn sửa. 

Bước 6. Nhấn nút Edit Rule để mở hộp thoại Edit Formatting Rule. 

Bước 7. Điều chỉnh các tùy chọn điều kiện, sau đó nhấn nút Ok để xác 

nhận thay đổi và đóng hộp thoại Edit Formatting Rule. 

Bước 8. Đặt lại vùng được áp dụng định dạng có điều kiện trong 

cột Applies to (nếu cần). 

Bước 9. Nhấn Ok để xác nhận và thực hiện việc định dạng. 

❖ Để xóa một định dạng có điều kiện 

Bước 1. Chọn vùng dữ liệu bạn cần định dạng. 

Bước 2. Trên thanh Ribbon, chọn thẻ Home. 

Bước 3. Trong nhóm Styles, nhấp chuột lên nút Conditional Formatting. 

Bước 4. Trong trình đơn Conditional Formatting, chọn Manage Rules. 

Bước 5. Trong hộp thoại Conditional Formatting Rules Manager, chọn 

định dạng bạn muốn xóa. 

Bước 6. Nhấn nút Delete Rule để xóa định dạng. 
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Bước 7. Nhấn Ok để xác nhận việc xóa định dạng và đóng hộp 

thoại Conditional Formatting Rules Manager. 

 

2.2.3.  Thao tác lựa chọn cho công thức 
Theo mặc định, Excel sẽ tự động tính toán các công thức trong bảng tính khi 

bạn mở bảng tính hoặc thay đổi bất kỳ thành phần nào phụ thuộc công thức. Nếu bảng tính 

của bạn lớn, với nhiều công thức liên quan với nhau, việc tính toán này có thể làm mất thời 

gian đôi khi lên đến vài phút. 

Trong khi các công thức đang được tính lại, con trỏ chuột sẽ ở chế độ chờ, 

bạn không thể thực hiện bất cứ điều gì làm thay đổi bảng tính. 

Có thể bạn muốn tạm thời tắt việc tự động tính toán để tiết kiệm thời gian cho 

đến khi bạn hoàn thành việc nhập và thay đổi cac công thức trong bảng tính? Việc này rất dễ 

dàng, và đây là cách thực hiện. 

Trong cửa sổ Excel → Tab File → Options → Formulas → Calculation 

Options 

 

Hình 2.2.29 

 

Trong hộp thoại di chuyển xuống tùy chọn tính toán (Calculation Options), 

chọn Manual để ngăn chặn việc tự động tính các công thức mỗi khi bạn thay đổi giá trị có 

liên quan. 

Sau đây là danh sách xác định các tùy chọn có sẵn: 

• Automatic: Tính tất cả các công thức phụ thuộc và cập nhật mở rộng hoặc 

nhúng vào biểu đồ mỗi khi bạn thay đổi một giá trị, một công thức hoặc một tên. Đây là 

thiết lập mặc định cho mỗi bảng tính mới. 

• Automatic Except for Data Tables: Tính tất cả các công thức phụ thuộc và 

cập nhật mở rộng hoặc nhúng vào biểu đồ, ngoại trừ việc tính toán các bảng dữ liệu. Khi 

kích hoạt tùy chọn này, các bảng dữ liệu sẽ được tính toán lại khi bạn nhấp vào nút lệnh 

CalculateNow ở thanh công thức trên Ribbon, hoặc nhấn F9 trong bảng tính. 
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• Manual: Tính các bảng tính và cập nhật mở rộng hoặc nhúng vào biểu đồ chỉ 

khi nào bạn nhấp vào nút lệnh Calculate Now ở thanh công thức trên Ribbon, hoặc nhấn 

F9 hoặc tổ hợp phím "Ctrl + =" trong bảng tính. 

• Recalculate Workbook before Saving: Tính bảng tính mở rộng và cập nhật 

bổ sung hoặc các biểu đồ được nhúng vào trước khi bạn lưu chúng. Nếu không muốn 

cập nhật các công thức và biểu đồ phụ thuộc mỗi khi lưu, bạn tắt tùy chọn này. 

• Enable Iterative Calculation: Kích hoạt tùy chọn này để bạn thiết lập hai tính 

năng sau: 

- Lặp lại tối đa (Maximum Iterations): Thiết lập số lần tối đa một bảng tính 

được tính toán lại mỗi khi bạn thực hiện việc tìm kiếm hoặc giải quyết các tài 

liệu tham khảo (mặc định là 100). 

- Thay đổi tối đa (Maximum Change): Thiết lập số lượng thay đổi tối đa các giá 

trị trong mỗi lần lặp (mặc định 0,001). 

 

 

 

 

2.2.4.  Công thức thống kê 
1.1.1.1. Hàm SUMIF và SUMIFS 

Hàm SUMIF cho phép bạn tính tổng theo một điều kiện nào đó trong một 

vùng dữ liệu. 

Cú pháp:  

 

 

Ví dụ: Tính tổng tiền theo từng loại phòng? 

 

=SUMIF( vùng chứa điều kiện, điều kiện, vùng tính tổng) 
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Hình 2.2.30 

 

  Dựa theo điều kiện đề bài ta sử dụng công thức SUMIF để tính: 

 

 

Hình 2.2.31 

 Vùng chứa điều kiện ( $A$4:$A$13) : vì đề bài yêu cầu tính tổng tiền theo 

phòng →Loại phòng chính là điều kiện → Quét vùng dữ liệu cột Loại phòng. 

 Điều kiện trong vùng (1), ta đang tính tổng tiền của Loại phòng là A nên 

điều kiện là “A” . Trong đối số thứ hai này, bạn có thể sử dụng nhiều cách khác nhau. 

- Bạn có thể gõ lại điều kiện cần và điều kiện được đặt trong cập dấu 

nháy kép. 

- Hoặc bạn có thể click trỏ chuột vào ô dữ liệu chứa điều kiện và nhớ 

cố định ô dữ liệu đó.  

 

Hình 2.2.32 

 

Với hàm SUMIF bạn có thể tính tổng theo điều kiện đề bài yêu cầu, nhưng 

nếu đề bài đặt ra nhiều điều kiện thì hàm SUMIF chưa thể giải quyết được. Vì vậy Excel đã 

hỗ trợ cho chúng ta một hàm SUMIFS. 

Cú pháp: 

 

 

 

=SUMIFS(vùng tính tổng, vùng điều kiện 1, điều kiện1, vùng điều kiện 2, điều kiện2,…) 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 134 

Ví dụ:  Tính tổng tiền theo loại phòng và có số người lớn hơn 2. 

 

Hình 2.2.33 

 

Tương tự hàm tính tổng theo điều kiện ta có các hàm thống kê theo điều kiện : 

- Đếm theo điều kiện: Countif, Counifs 

Cú pháp: 

 

 

 

- Tính trung bình theo điều kiện: Averageif, Averageifs 

Cú pháp: 

 

 

 

 

 

 

 Các nhóm hàm thống kê 

 

Cú pháp Ý nghĩa 

AVEDEV (number1, number2, ...) 

Tính trung bình độ lệch tuyệt đối các điểm dữ liệu 

theo trung bình của chúng. Thường dùng làm 

thước đo về sự biến đổi của tập số liệu. 

VD: AVEDEV(2,4,6) → 1.333333 

AVERAGE (number1, number2, ...)  
Tính trung bình cộng 

VD: AVERAGE(2,4,6) → 4 

=COUNTIF(Vùng điều kiện, điều kiện) 

=COUNTIFS(Vùng điều kiện 1, điều kiện 1, Vùng điều kiện 2, điều kiện 2, ….) 

= AVERAGEIF (Vùng điều kiện, điều kiện, vùng cần tính) 

= AVERAGEIFS( Vùng cần tính,vùng điều kiện 1, điều kiện 1, 

vùng điều kiện 2, điều kiện 2, ….) 
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Cú pháp Ý nghĩa 

AVERAGEA (number1, number2, 

...)  

Tính trung bình cộng của các giá trị, bao gồm cả 

những giá trị logic. 

VD: AVERAGEA(2,3,“true”,4) → 2.5 

       AVERAGEA(2,3,“not true”,4) → 2.25 

AVERAGEIF (range, criteria1) 

Tính trung bình cộng của các giá trị trong một 

mảng theo một điều kiện. 

VD:  Xem chi tiết ở phía trên. 

AVERAGEIFS (range, criteria1, 

criteria2, ...) 

Tính trung bình cộng của các giá trị trong một 

mảng theo nhiều điều kiện 

VD:  Xem chi tiết ở phía trên. 

COUNT (value1, value2, ...) 
Đếm ô chứa giá trị số trong danh sách. 

VD: COUNT(2,3,“true”,4) → 3 

COUNTA (value1, value2, ...)  

Đếm số ô có chứa giá trị (không rỗng) trong danh 

sách 

VD: COUNTA(2,3,“true”,4) → 4 

COUNTBLANK (range) 
Đếm các ô rỗng trong một vùng. 

VD: COUNTBLANK (A2:A20) 

COUNTIF (range, criteria)  

Đếm số ô thỏa một điều kiện cho trước bên trong 

một dãy 

VD:  Xem chi tiết ở phía trên. 

COUNTIFS (range1, criteria1, 

range2, criteria2, …) 

Đếm số ô thỏa nhiều điều kiện cho trước. 

VD:  Xem chi tiết ở phía trên. 

DEVSQ (number1, number2, ...)  

Tính bình phương độ lệch các điểm dữ liệu từ 

trung bình mẫu của chúng, rồi cộng các bình 

phương đó lại. 

VD: DEVSQ (2,3,4,5) → 5 

FREQUENCY (data_array, 

bins_array) 

Tính xem có bao nhiêu giá trị thường xuyên xuất 

hiện bên trong một dãy giá trị, rồi trả về một mảng 

đứng các số. Luôn sử dụng hàm này ở dạng công 

thức mảng. 

GEOMEAN (number1, number2, ...) 

Trả về trung bình nhân của một dãy các số dương. 

Thường dùng để tính mức tăng trưởng trung bình, 

trong đó lãi kép có các lãi biến đổi được cho 

trước… 

HARMEAN (number1, number2, 

...) 

Trả về trung bình điều hòa (nghịch đảo của trung 

bình cộng) của các số 

KURT (number1, number2, ...) 
Tính độ nhọn của tập số liệu, biểu thị mức nhọn 

hay mức phẳng tương đối của một phân bố so với 
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Cú pháp Ý nghĩa 

phân bố chuẩn 

LARGE (array, k) Trả về giá trị lớn nhất thứ k trong một tập số liệu 

MAX (number1, number2, ...)  Trả về giá trị lớn nhất của một tập giá trị 

MAXA (number1, number2, ...) 
Trả về giá trị lớn nhất của một tập giá trị, bao gồm 

cả các giá trị logic và text 

MEDIAN (number1, number2, ...) Tính trung bình vị của các số. 

MIN (number1, number2, ...) Trả về giá trị nhỏ nhất của một tập giá trị 

MINA (number1, number2, ...)  
Trả về giá trị nhỏ nhất của một tập giá trị, bao 

gồm cả các giá trị logic và text 

MODE (number1, number2, ...)  
Trả về giá trị xuất hiện nhiều nhất trong một mảng 

giá trị 

PERCENTILE (array, k) 
Tìm phân vị thứ k của các giá trị trong một mảng 

dữ liệu 

PERCENTRANK (array, x, 

significance) 

Trả về thứ hạng (vị trí tương đối) của một trị trong 

một mảng dữ liệu, là số phần trăm của mảng dữ 

liệu đó 

PERMUT (number, 

number_chosen) 

Trả về hoán vị của các đối tượng 

QUARTILE (array, quart)  

Tính điểm tứ phân vị của tập dữ liệu. Thường 

được dùng trong khảo sát dữ liệu để chia các tập 

hợp thành nhiều nhóm… 

RANK (number, ref, order)  Tính thứ hạng của một số trong danh sách các số 

SKEW (number1, number2, ...) 
Trả về độ lệch của phân phối, mô tả độ không đối 

xứng của phân phối quanh trị trung bình của nó 

SMALL (array, k)  Trả về giá trị nhỏ nhất thứ k trong một tập số  

STDEV (number1, number2, ...)  Ước lượng độ lệch chuẩn trên cơ sở mẫu 

STDEVA (value1, value2, ...)  
Ước lượng độ lệch chuẩn trên cơ sở mẫu, bao gồm 

cả những giá trị logic 

STDEVP (number1, number2, ...)  Tính độ lệch chuẩn theo toàn thể tập hợp 

STDEVPA (value1, value2, ...) 
Tính độ lệch chuẩn theo toàn thể tập hợp, kể cả 

chữ và các giá trị logic 

VAR (number1, number2, ...)  Trả về phương sai dựa trên mẫu 

VARA (value1, value2, …) 
Trả về phương sai dựa trên mẫu, bao gồm cả các 

trị logic và text 

VARP (number1, number2, ...)  Trả về phương sai dựa trên toàn thể tập hợp 

VARPA (value1, value2, …)  
Trả về phương sai dựa trên toàn thể tập hợp, bao 

gồm cả các trị logic và text. 

TRIMMEAN (array, percent)  
Tính trung bình phần trong của một tập dữ liệu, 

bằng cách loại tỷ lệ phần trăm của các điểm dữ 
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Cú pháp Ý nghĩa 

liệu ở đầu và ở cuối tập dữ liệu. 

 

2.2.5. Công thức mảng 
Một trong  những tính  năng  độc  đáo và mạnh mẽ nhất của Excel chính  là 

khả năng tính toán  với các mảng  dữ liệu trong công thức.  Khi hiểu rõ được khái niệm này 

sẽ giúp chúng ta  tạo ra được các công thức thực hiện các phép tính  khó một cách kỳ diệu.  

Bài viết này sẽ giới thiệu các khái niệm về các mảng số liệu mà bất kỳ ai nếu muốn trở 

thành chuyên gia sử dụng công thức trong Excel  đều phải biết về nó, ngoài ra trong bài 

cũng trình bày các ví dụ về công thức mảng rất hữu ích. 

Công thức mảng không cần lưu trữ các số liệu trong quá trình tính toán trong 

các ô (cell), mà Excel sẽ xử lý các  mảng  số liệu này trong bộ nhớ máy tính.  Sau đó các 

công thức mảng  sẽ lấy kết quả tính toán trả về trên bảng tính. Một công thức mảng có thể 

trả về kết quả là nhiều ô (range) hay chỉ một ô. 

Khi thực hiện tính toán bằng công thức mảng thì công thức được bao bọc bởi 

hai dấu ngoặc {}. Hai dấu ngoặc này người dùng không gõ mà được tự phát sinh khi người 

dùng thực hiện tính toán bằng cách nhấn tổ hợp phím Ctrl+Shift+Enter. Nếu bạn thực hiện 

tính toán hoặc sửa chữa mà quên nhấn tổ hợp phím trên thì công thức của bạn sẽ trả về giá 

trị không đúng hay thông báo lỗi #VALUE! Error. 

 Công thức mảng trả kết quả về một vùng nhiều ô 

Ví dụ ta tính cột Thành Tiền, tại ô F2 ta nhập vào công thức: =D2*E2 và sau 

đó chép xuống F3:F7. 

 

Hình 2.2.34 

 

Để tính cho cột Thành Tiền  ở đây chúng ta dùng tới sáu công thức. Ngoài 

cách này chúng ta có thể dùng một công thức mảng để tính ra kết quả cho cả cột Thành 

Tiền và lưu kết quả trả về tại F2:F7. 

Để tạo một công thức mảng tính toán cho trường hợp này hãy làm theo các 

bước sau: 
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➢ Chọn vùng các ô sẽ lưu kết quả trả về của công thức mảng, trong ví dụ này 

chọn vùng F2:F7. 

➢ Nhập vào công thức sau =D2:D7*E2:E7 (sau khi chọn vùng thì gõ công 

thức này vào)   

➢ Vì đây là công thức  mảng  bạn hãy nhấn tổ hợp phím  Ctrl+Shift+Enter  

để nhận kết quả công thức trả về. (Công thức thông thường thì chỉ cần 

Enter) 

         

Hình 2.2.35 

 

❖ Sử dụng công thức mảng thay cho công thức đơn có một số ưu điểm như: 

▪ Là cách tính toán đảm bảo sự chính xác về kết quả  (tránh  trường hợp vô tình sao 

chép sai  công thức do chạy địa chỉ tham chiếu) 

▪ Dùng công thức mảng  tránh được việc vộ tình xoá hay làm thay đổi công thức 

trong một ô nào đó của vùng công thức  mảng. Vì công thức  mảng  không cho 

phép xoá, sửa chữa một ô trong vùng công thức mảng. 

▪ Dùng công thức mảng sẽ giúp tránh trường hợp người chưa thành thạo Excel làm 

xáo trộn các công thức của bạn. 

 Công thức mảng trả kết quả về một ô 

Ví dụ 1: Bạn cần tính tổng số ký tự của một dãy các chuỗi Loại Hàng, thông 

thường thì bạn sẽ tính số ký tự của từng chuỗi, rồi sau đó sẽ dùng Sum tính tổng đó.  

Để thay thế cho hai công việc trên ta sẽ dùng công thức mảng để tính. Tại ô 

cần tính ta nhập công thức:  

 =Sum(Len(B2:B1))  

Và để kết thúc công thức mảng bạn nhấn tổ hợp phím Ctrl + Shift + Enter 
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Hình 2.2.36 

 

Ví dụ 1: Tính tổng có điều kiện  

Bạn cần tính Tổng Tiền theo Loại Hàng với Số Lượng >=200. Ta tính Tổng 

tiền mặt hàng Tủ Lạnh theo điều kiện:  

 

Hình 2.2.37 

 

Công thức mảng ở đây dùng hàm IF để kiểm tra từng ô một trong dãy. Sau đó 

nó tạo ra một mảng mới gồm các giá trị thỏa mãn điều kiện, và mảng mới này được chuyển 

sang hàm SUM để tính tổng cần tìm. 

- Trong công thức mảng nếu có nhiều điều kiện thì nếu các điều kiện 

đồng thời ( toán tử AND ) thì bạn dùng dấu “*” để kết các điều kiện. 

- Và nếu các điều kiện không đồng thời ( hoặc điều kiện này, hoặc điều 

kiện khác ) thì bạn dùng dấu “+” để kết các điều kiện. 
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Ví dụ 2: Tìm giá trị lớn nhất, nhỏ nhất   

Bạn cần tìm Thành Tiền nhỏ nhất của Loại Hàng  là Ampli, thì bạn có thể sử 

dụng công thức mảng như sau: 

 

Hình 2.2.38 

 

Tìm giá trị lớn nhất tương tự, ví dụ bạn cần tìm số lượng lớn nhất của Loại 

Hàng là Cassette : 

 

 

 Một số khái niệm thêm về Mảng trong Excel 

Nếu bạn đã từng lập trình trên bất kỳ ngôn ngữ lập trình nào thì chắc bạn cũng 

đã nghe đến khái niệm mảng  (array).  Một  array  đơn thuần  chỉ là một tập hợp các phần tử 

có quan hệ hay độc lập với nhau.Trong Excel, một array có thể là array một chiều hoặc 

array hai chiều. Chiều của array ở đây chính là chỉ các dòng và cột trong array. Ví dụ như 

array một chiều thì có thể hiểu đó là một vùng  (range) số liệu trên bảng tính mà vùng này 

sẽ có một dòng (khi array  nằm ngang) hoặc một cột (array nằm dọc).  Một array hai chiều 

có thể hiểu đó là một vùng số liệu trên bảng tính  (có dạng hình chữ nhật) bao gồm nhiều 

dòng và nhiều cột. Excel không hỗ trợ array 3-chiều (VBA thì hỗ trợ). 

❖ Mảng một chiều 

Ta có thể xem mảng một chiều là một hàng ( mảng ngang ) hay một cột ( 

mảng dọc ). Các phần tử trong mảng một chiều ( mảng ngang được cách nhau bằng một dấu 

phẩy, và trong mảng dọc  được cách bởi dấu chấm phẩy. 

Ví dụ:  

- Mảng ngang: ={2,4,6,8,10} 

- Mảng dọc: ={1;3;5;7;9} 

- Mảng chuỗi: ={"Mon";"Tue";"Wed";"Thu";"Fri";"Sat";"Sun"} 

={MAX(IF($B$2:$B$13="Cassette",$C$2:$C$13,""))} 
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Để nhập các giá trị trong mảng ta chọn vùng, và gõ công thức mảng, kết thúc 

công thức phải nhấn tổ hợp phím Ctrl + Shift + Enter. 

 

Hình 2.2.39 

 

Lưu ý: Nếu các phần tử trong mảng là 5 mà ta quét chọn 7 ô để nhập thì ô thứ 

6 và thứ 7 sẽ hiển thị lỗi #NA. 

 

Hình 2.2.40 

Để chuyển mảng ngang thành mảng dọc và ngược lại bạn sử dụng hàm: 

TRANSPOSE.  

Ví dụ: Bạn chuyển mảng chuỗi dọc phía trên thành mảng ngang: 

 

Hình 2.2.41 
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2.2.6.  Sử dụng các hàm xây dựng sẵn 
Hàm dùng để tính toán và trả về một giá trị, trong ô chứa hàm sẽ trả về một giá 

trị, một chuỗi ký tự hoặc một thông báo lỗi, … Excel có một tập hợp các hàm rất phong phú 

và được phân loại theo từng Group phục vụ cho việc tính toán trên nhiều kiểu dữ liệu và 

nhiều mục đích khác nhau.  

 

Hình 2.2.42 

 

2.2.7. Các hàm về chuỗi 

Cú pháp Ý nghĩa 

CHAR (number) 

Chuyển đổi một mã số trong bộ mã ANSI (có miền giá trị 

từ 1 - 255) sang ký tự tương ứng. 

VD: Char(169) → © 

CLEAN (text) Loại bỏ tất cả những ký tự không in ra được trong chuỗi 

CODE (text) 
Trả về mã số của ký tự đầu tiên chuỗi text 

VD: CODE("A") → 65 

CONCATENATE (text1, 

text2, ...) 

Nối nhiều chuỗi thành một chuỗi. 

VD: =CONCATENATE("Đại học Công nghệ"," Đồng 

Nai") → Đại học Công nghệ Đồng Nai 

DOLLAR (number, 

decimals) 

Chuyển đổi một số thành dạng tiền tệ (dollar Mỹ), có kèm 

theo dấu phân cách hàng ngàn, và có thể làm tròn theo ý 

muốn. 

VD: =DOLLAR(20000,0) → $20,000 

EXACT (text1, text2) 

So sánh hai chuỗi. Nếu giống nhau thì trả về TRUE, nếu 

khác nhau thì trả về FALSE. Có phân biệt chữ hoa và chữ 

thường. 

VD: =EXACT("Đồng Nai","ĐỒNG NAI") → FALSE 

FIND (find_text, 

within_text, start_num) 

Tìm vị trí bắt đầu của một chuỗi con (find_text) trong một 

chuỗi (within_text), tính theo ký tự đầu tiên. 

VD: =FIND("n","Đại học Công nghệ Đồng Nai",1) → 11 

FIXED (number, 

decimals, no_commas) 

Chuyển đổi một số thành dạng văn bản (text), có hoặc 

không kèm theo dấu phân cách hàng ngàn, và có thể làm 

tròn theo ý muốn. 

VD: =FIXED(12345.78,1,0) → 12,345.8 

LEFT (text, num_chars) 
Trả về một hay nhiều ký tự đầu tiên bên trái của một 

chuỗi, theo số lượng được chỉ định. 
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Cú pháp Ý nghĩa 

VD: =LEFT("Đại học Công nghệ Đồng Nai",7)  

         → Đại học 

LEN (text) 
Đếm số ký tự trong một chuỗi. 

VD: =LEN("Đại học Công nghệ Đồng Nai") → 26 

LOWER (text) 

Đổi tất cả các ký tự trong một chuỗi văn bản thành chữ 

thường. 

VD: =LOWER("ĐẠI HỌC CÔNG NGHỆ ĐỒNG NAI") 

→ đại học công nghệ đồng nai 

MID (text, start_num, 

num_chars) 

Trả về một hoặc nhiều ký tự liên tiếp bên trong một chuỗi, 

bắt đầu tại một vị trí cho trước. 

VD: =MID("ĐẠI HỌC CÔNG NGHỆ ĐỒNG NAI",5,3) 

        → HỌC 

PROPER (text) 

 Đổi ký tự đầu tiên trong chuỗi thành chữ in hoa, và đổi 

các ký tự còn lại thành chữ in thường. 

VD: = PROPER("ĐẠI HỌC CÔNG NGHỆ ĐỒNG NAI") 

        → Đại Học Công Nghệ Đồng Nai 

REPLACE (old_text, 

start_num, num_chars, 

new_text) 

Thay thế một phần của chuỗi bằng một chuỗi khác, với số 

lượng các ký tự được chỉ định. 

VD: =REPLACE("KHOA CÔNG NGHỆ THÔNG 

TIN",6,9,"CN") → KHOA CN THÔNG TIN 

REPT (text, times) 
Lặp lại một chuỗi với số lần được cho trước. 

VD: =REPT("*CNTT*",3) → *CNTT**CNTT**CNTT* 

RIGHT (text, num_chars) 

Trả về một hay nhiều ký tự tính từ bên phải của một 

chuỗi, theo số lượng được chỉ định. 

VD: =RIGHT("KHOA CÔNG NGHỆ THÔNG TIN",9) 

      → THÔNG TIN 

SEARCH (find_text, 

within_text, start_num) 

Tìm vị trí bắt đầu của một chuỗi con (find_text) trong một 

chuỗi(within_text), tính theo ký tự đầu tiên. 

VD: =SEARCH("nghệ","Công nghệ thông tin",1) → 6 

TEXT (value, 

format_text) 

Chuyển đổi một số thành dạng văn bản (text) theo định 

dạng được chỉ định. 

VD: =TEXT(37,"#oC") → 37oC ( 37 độ C) 

TRIM (text) 

Xóa tất cả những khoảng trắng vô ích trong chuỗi văn 

bản, chỉ chừa lại những khoảng trắng nào dùng làm dấu 

cách giữa hai chữ. 

VD: =TRIM("Khoa   Công    nghệ Thông    Tin")  

         → Khoa Công nghệ Thông Tin 

UPPER (text) 

Đổi tất cả các ký tự trong chuỗi thành chữ in hoa. 

VD: =UPPER("Đại học Công nghệ Đồng Nai") 

      → ĐẠI HỌC CÔNG NGHỆ ĐỒNG NAI 
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Cú pháp Ý nghĩa 

VALUE (text) 
Chuyển một chuỗi thành một số. 

VD: =VALUE(RIGHT("A3500",4)) → 3,500 

 

2.2.8. Các hàm ngày và giờ (Date & Time) 
 

Cú pháp Ý nghĩa 

DATE (year, month, day) 

Trả về các số thể hiện một ngày cụ thể nào đó. Nếu định 

dạng của ô là General trước khi hàm được nhập vào, kết 

quả sẽ được thể hiện ở dạng ngày tháng năm. 

VD: =DATE(2013,12,24) → 24/12/2013 

DATEVALUE 

(date_text) 

Trả về số tuần tự của ngày được thể hiện bởi date_text 

(chuyển đổi một chuỗi văn bản có dạng ngày tháng năm 

thành một giá trị ngày tháng năm có thể tính toán được). 

VD: =DATEVALUE("02/09/13") → 41519 

DAY (serial_number) 

Trả về phần ngày của một giá trị ngày tháng, được đại 

diện bởi số tuần tự. Kết quả trả về là một số nguyên từ 1 

đến 31. 

VD: =DAY("30/04/13") → 30 

DAYS360 (start_date, 

end_date, method) 

Trả về số ngày giữa hai ngày dựa trên cơ sở một năm có 

360 ngày (12 tháng, mỗi tháng có 30 ngày) để dùng cho 

các tính toán tài chính. 

VD: =DAYS360("01/04/2013", "31/5/2013")→ 60 

    =DAYS360("01/04/2013", "31/5/2013",TRUE) → 59 

EDATE (start_date, 

months) 

Trả về số tuần tự thể hiện một ngày nào đó tính từ mốc 

thời gian cho trước và cách mốc thời gian này một số 

tháng được chỉ định. 

VD: =EDATE("16/08/13",7) → 16/03/2014 

EOMONTH (start_date, 

months)  

Trả về số tuần tự thể hiện ngày cuối cùng của một tháng 

nào đó tính từ mốc thời gian cho trước và cách mốc thời 

gian này một số tháng được chỉ định. 

VD: =EOMONTH("30/04/13",1) → 31/05/2013 

HOUR (serial_number) 

Trả về phần giờ của một giá trị thời gian. Kết quả trả về là 

một số nguyên từ 0 đến 23. 

VD: =HOUR("3:30:20 PM") → 15 

MINUTE (serial_number) 

Trả về phần phút của một giá trị thời gian. Kết quả trả về 

là một số nguyên từ 0 đến 59. 

VD: =MINUTE("1:30:20 PM") → 30 

MONTH (serial_number) 

Trả về phần tháng của một giá trị ngày tháng, được đại 

diện bởi số tuần tự. Kết quả trả về là một số nguyên từ 1 

đến 12. 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 145 

Cú pháp Ý nghĩa 

VD: =MONTH("30/04/13") → 4 

NETWORKDAYS 

(start_date, end_date, 

holidays) 

Trả về tất cả số ngày làm việc trong một khoảng thời gian 

giữa start_date và end_date, không kể các ngày cuối tuần 

và các ngày nghỉ (holidays). 

VD: = NETWORKDAYS("01/02/13", "15/05/13", 

{"30/04/13","01/5/13"}) → 72 

NOW () 

Trả về số tuần tự thể hiện ngày giờ hiện tại. Nếu định 

dạng của ô là General trước khi hàm được nhập vào, kết 

quả sẽ được thể hiện ở dạng ngày tháng năm và giờ phút 

giây. 

VD: NOW() 

SECOND 

(serial_number)  

Trả về phần giây của một giá trị thời gian. Kết quả trả về 

là một số nguyên từ 0 đến 59. 

VD: = SECOND ("1:30:20 PM") → 20 

TIME (hour, minute, 

second) 

Trả về phần thập phân của một giá trị thời gian (từ 0 đến 

nhỏ hơn 1). Nếu định dạng của ô là General trước khi hàm 

được nhập vào, kết quả sẽ được thể hiện ở dạng giờ phút 

giây. 

VD: =TIME(16,35,40) → 4:35:40 PM 

TIMEVALUE (time_text) 

Trả về phần thập phân của một giá trị thời gian (từ 0 đến 

nhỏ hơn 1) thể hiện bởi time_text(chuyển đổi một chuỗi 

văn bản có dạng thời gian thành một giá trị thời gian có 

thể tính toán được). 

VD: =TIMEVALUE("25:45") → 1:45:00 AM 

TODAY () 

Trả về số tuần tự thể hiện ngày tháng hiện tại. Nếu định 

dạng của ô là General trước khi hàm được nhập vào, kết 

quả sẽ được thể hiện ở dạng ngày tháng năm. 

VD: =TODAY () 

WEEKDAY 

(serial_number, 

return_type) 

Trả về thứ trong tuần tương ứng với ngày được cung cấp. 

Kết quả trả về là một số nguyên từ 1 đến 7. 

VD: =WEEKDAY("24/12/2013") → 3 

WEEKNUM 

(serial_number, 

return_type) 

Trả về một số cho biết tuần thứ mấy trong năm. 

VD: =WEEKNUM("16/02/2013") → 7 

WORKDAY (start_day, 

days, holidays) 

Trả về một số tuần tự thể hiện số ngày làm việc, có thể là 

trước hay sau ngày bắt đầu làm việc và trừ đi những ngày 

cuối tuần và ngày nghỉ (nếu có) trong khoảng thời gian 

đó. 

VD: = WORKDAY("01/04/13",30,{"30/04/13","01/05/2013"}) 

     → 15/05/2013 
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Cú pháp Ý nghĩa 

YEAR (serial_number) 

Trả về phần năm của một giá trị ngày tháng, được đại diện 

bởi số tuần tự. Kết quả trả về là một số nguyên từ 1900 

đến 9999. 

VD: = YEAR ("30/04/13") → 2013 

YEARFRAC (start_date, 

end_date, basis) 

Trả về tỷ lệ của một khoảng thời gian trong một năm. 

VD: =YEARFRAC("01/01/2013","30/06/2013") → 50% 

 

2.2.9. Các hàm tìm kiếm (Lookup & Reference) 
1.1.1.2. Hàm VLOOKUP 

- Chức năng : Tìm giá trị lookup_value trong cột trái nhất của bảng 

table_array theo chuẩn dò tìm range_lookup, trả về trị tương ứng trong cột thứ 

col_index_num (nếu tìm thấy).  

Cú pháp: 

 

 

- range_lookup = 1: Tìm tương đối, danh sách các giá trị dò tìm của bảng 

Table_array phải sắp xếp theo thứ tự tăng dần. Nếu tìm không thấy sẽ trả về giá trị lớn 

nhất nhưng nhỏ hơn lookup_value.  

- range_lookup = 0: Tìm chính xác, danh sách các giá trị dò tìm của bảng 

Table_array không cần sắp xếp thứ tự. Nếu tìm không thấy sẽ trả về lỗi #N/A.  

Ví dụ:  

 

Hình 2.2.43 

 

VLOOKUP(lookup_value, Table_array, col_index_num, range_lookup) 
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1.1.1.3. Hàm HLOOKUP 

- Chức năng : Tìm giá trị lookup_value trong dòng trên cùng của bảng  

table_array theo chuẩn dò tìm range_lookup, trả về trị tương ứng trong dòng thứ 

row_index_num (nếu tìm thấy).  

Cú pháp: 

 

 

 

 Ý nghĩa của các đối số của hàm Hlookup tương tự như hàm Vlookup 

Ví dụ: 

 

Hình 2.2.44 

 

1.1.1.4. Hàm MATCH 

- Chức năng: Hàm trả về vị trí  của lookup_value trong mảng lookup_array 

theo cách tìm match_type 

- Cú pháp: 

 

 

 

match_type = 1: Tìm tương đối, danh sách các giá trị dò tìm của 

bảng Table_array phải sắp xếp theo thứ tự tăng dần. Nếu tìm không thấy sẽ 

trả về vị trí của giá trị lớn nhất nhưng nhỏ hơn lookup_value. 

match_type = 0: Tìm chính xác, danh sách các giá trị dò tìm của 

bảng Table_array không cần sắp xếp thứ tự. Nếu tìm không thấy sẽ trả về lỗi 

#N/A. 

HLOOKUP(lookup_value, Table_array, row_index_num, range_lookup) 

MATCH(lookup_value, lookup_array, match_type) 
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match_type = -1: Tìm tương đối, danh sách phải sắp xếp các giá trị 

dò tìm của bảng Table_array theo thứ tự giảm dần. Nếu tìm không thấy sẽ trả 

về vị trí của giá trị nhỏ nhất nhưng lớn hơn lookup_value. 

Ví dụ: 

 

Hình 2.2.45 

 

1.1.1.5. Hàm INDEX 

Chức năng: trả về giá trị trong ô ở hàng thứ row_num, cột thứ 

column_num trong mảng array. 

Cú pháp: 

 

 

 

Ví dụ: 

 

Hình 2.2.46 

 

2.2.10. Các hàm thông tin (ISfunction)  
Các hàm thông tin dùng để kiểm tra xem kiểu của một giá trị hay của một ô có 

thỏa mãn một điều kiện nào đó không. Chẳng hạn: ô dữ liệu có phải là giá trị số không? Có 

phải là chuỗi ký tự không?...  

Các hàm thông tin luôn trả về một trong hai giá trị TRUE hoặc FALSE. Như 

vậy các hàm này có thể đáp ứng được trong các trường hợp mà có một số dữ liệu ngoại lệ 

trong một bảng dữ liệu cần tính toán.  

ISERROR(value): trả về giá trị TRUE nếu value là một lỗi bất kỳ, ngược lại thì 

trả về giá trị FALSE.  

ISNA(value): trả về giá trị TRUE nếu value là lỗi #N/A, ngược lại thì trả về giá 

trị FALSE.  

ISNUMBER(value): trả về giá trị TRUE nếu value là giá trị số, ngược lại thì trả 

về giá trị FALSE.  

INDEX(array, row_num, column_num) 
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ISTEXT(value): trả về giá trị TRUE nếu value là  một chuỗi, ngược lại thì trả về  

FALSE. 

2.2.11. Các hàm Cơ sở dữ liệu 
Các hàm cơ sở dữ liệu mang tính chất thống kê những mẫu tin trong CSDL 

có trường thỏa điều kiện của vùng tiêu chuẩn đã được thiết lập trước. 

Cú pháp chung: 

 

   

database: địa chỉ vùng CSDL (Chọn địa chỉ tuyệt đối để sao chép).  

field: cột cần tính toán, field có thể là tên trường, địa chỉ của ô tên field hoặc số 

thứ tự của trường đó (cột thứ nhất của vùng CSDL đã chọn tính là 1 và tăng dần 

sang trái).  

criteria: địa chỉ vùng điều kiện. 

Tên hàm Ý nghĩa và ví dụ 

DAVERAGE(daTabase, field, criteria)  

Tính trung bình cộng các giá trị trong cột 

field của các mẫu tin thỏa điều kiện 

criteria.  

=DAVERAGE($A$1:$D$8,D1,F1:F2) 

DMAX(daTabase, field, criteria)  

Tìm trị lớn nhất trong cột field của các 

mẫu tin thỏa điều kiện criteria.  

=DMAX($A$1:$D$8,D1,F1:F2) 

DMIN(daTabase, field, criteria)  

Tìm trị nhỏ nhất trong cột field của các 

mẫu tin thỏa điều kiện criteria.  

=DMIN($A$1:$D$8,D1,F1:F2) 

DCOUNT(daTabase, field, criteria)  

Đếm các ô kiểu số trong cột field của các 

mẫu tin thỏa điều kiện criteria.  

=DCOUNT($A$1:$D$8,D1,F1:F2) 

DCOUNTA(daTabase, field, criteria)  

Đếm các ô khác rỗng trong cột field của 

các mẫu tin thỏa điều kiện criteria.  

=DCOUNTA($A$1:$D$8,D1,F1:F2) 

 

2.2.12. Các lệnh xử lý dữ liệu 
1.1.1.6. Lọc dữ liệu tự động (AutoFilter).  

Chức năng: Lệnh Tab Data→Group Sort & Filter→Filter dùng để lọc các 

mẫu tin thỏa mãn những tiêu chuẩn nào đó từ cơ sở dữ liệu ban đầu. Kết quả chỉ hiển 

thị những mẫu tin thỏa điều kiện còn những mẫu tin khác sẽ tạm thời bị che. 

Cách thực hiện  

- Chọn vùng CSDL với tiêu đề là một hàng.  

=Tên hàm(database, field, criteria) 
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- Chọn Tab Data→Group Sort & Filter→Filter, Excel sẽ tự động xuất 

hiện các nút thả cạnh tên field cho phép chọn điều kiện lọc tương ứng với các field 

đó.  

- Chọn điều kiện lọc trong hộp liệt kê của từng  field tương ứng.  

- Chọn Text Fillter để thực hiện chức năng lọc nâng cao theo yêu cầu của 

người dùng: 

 
Hình 2.2.47 

 

 Show rows where: cho phép người dùng chọn điều kiện và nhập giá trị so 

sánh ở combobox kế bên. Người dùng có thể kết hợp với điều kiện “và”, “hoặc” phía dưới. 

1.1.1.7. Lọc dữ liệu nâng cao (Advanced Filter)  

Chức năng: Lệnh Tab Data→ Group Sort & Filter→ Advanced dùng để 

trích ra các mẩu tin theo các điều kiện chỉ định trong vùng điều kiện được tạo trước.  

Cách thực hiện:  

Bước 1: Tạo vùng điều kiện lọc. Sử dụng một trong hai cách sau: 

Cách 1: Sử dụng tên trường để tạo vùng điều kiện: vùng điều kiện sẽ có ít 

nhất hai hàng, hàng đầu chứa các tên field điều kiện, các hàng khác dùng để mô tả điều 

kiện.  

- Chọn các ô trống trong bảng tính để làm vùng điều kiện. 

- Sao chép tên field điều kiện làm tiêu đề của vùng điều kiện.  

- Nhập trực tiếp các điều kiện vào ô dưới tên trường tương ứng. Các điều 

kiện ghi trên cùng một hàng là các điều kiện thỏa mãn đồng thời (AND), những điều 

kiện ghi trên các hàng khác nhau là những điều kiện thỏa mãn không đồng thời (OR).  

Ví dụ: 

 

 

 

 

Cách 2: Sử dụng công thức để tạo vùng điều kiện : vùng điều kiện  sẽ có hai 

ô, ô trên chứa tiêu đề như: “điều kiện”, …hoặc bỏ trống nhưng phải khác với tên 

trường, ô dưới là công thức mô tả điều kiện.  

Đối tượng Điểm 

A >5 
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- Chọn hai ô trống trong bảng tính để làm vùng tiêu chuẩn.  

- Nhập tiêu đề ở ô trên của vùng tiêu chuẩn.  

- Nhập công thức vào ô bên dưới mô tả điều kiện, dùng mẫu tin đầu tiên 

trong cơ sở dữ liệu để đặt điều kiện so sánh, hàm AND dùng để lập các điều kiện thỏa 

mãn đồng thời, hàm OR dùng để lập các điều kiện thỏa mãn không đồng thời.  

Ví dụ: 

 

Hình 2.2.48 

 

Bước 2: Vào Tab Data→Group Sort & Filter→ Advanced, xuất hiện 

hộp thoại gồm các tùy chọn sau:  

Action:  

Filter the list, in-place: kết quả hiển thị trực tiếp trên vùng CSDL.  

Copy to another location: kết quả được đặt tại một vị trí khác.  

 

Hình 2.2.49 

 

- List range: chọn địa chỉ vùng CSDL. 

- Criteria range: chọn địa chỉ vùng tiêu chuẩn.  

- Copy to: chọn địa chỉ của ô đầu tiên trong vùng kết quả (phải chọn mục 

Copy to another location).  

- Unique records only: nếu có nhiều mẫu tin giống nhau thì chỉ lấy duy 

nhất một mẫu tin đại diện, ngược lại thì lấy hết các mẫu tin thỏa điều kiện của 

vùng tiêu chuẩn (dù giống nhau).  

1.1.1.8. Subtotals 
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Chức năng: Thống kê dữ liệu theo từng nhóm trong cơ sở dữ liệu. Ví dụ tính 

tổng tiền lương theo từng nhóm ĐƠN VỊ. 

Cách thực hiện: Xét CSDL BẢNG LƯƠNG dưới đây. Vấn đề đặt ra là cần 

tính tổng tiền lương theo từng nhóm ĐƠN VỊ.  

 

Hình 2.2.50 

 

- Dùng lệnh Tab Data→Group Sort & Filter→Sort để sắp xếp dữ liệu 

theo ĐƠN VỊ, mục đích để các mẫu tin có cùng ĐƠN VỊ thì nằm liền kề nhau.  

- Chọn bảng CSDL cần tổng hợp với tiêu đề là một hàng.  

- Vào Tab Data→Group Outline→Subtotals, xuất hiện hộp thoại Subtotal 

: 

 

Hình 2.2.51 
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+ At each change in: chọn tên trường cần tổng hợp. 

+ Use function: chọn hàm sử dụng tính toán hay thống kê.  

+ Add subtotal to: Chọn tên trường chứa dữ liệu cần thực hiện tính toán 

hay thống kê.  

+ Replace current subtotals: Thay thế các dòng tổng hợp cũ để ghi dòng 

tổng hợp mới.  

+ Page break between groups: Tạo ngắt trang giữa các nhóm. 

+ Summary below data: Thêm dòng tổng hợp sau mỗi nhóm. 

Kết quả: 

 

 

Hình 2.2.52 

 

 

Làm việc với màn hình kết quả sau khi tổng hợp. 

Click vào các nút  để chọn các mức dữ liệu bạn muốn xem.  

+ Chỉ hiển thị tổng chính (Grand Total Only).  

+ Hiển thị tổng chính và tổng phụ (Grand Total And Subtotal).  

+ Hiển thị chi tiết tất cả các mẫu tin cùng các tổng hợp (All Record).  
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Hình 2.2.53 

 

2.3.  Trình diễn dữ liệu 

2.3.1. Thao tác với PivotTables  
Chức năng: Thống kê dữ liệu theo nhiều cấp độ khác nhau với nhiều hình thức 

đa dạng từ một bảng dữ liệu chính. 

Cách thực hiện: 

- Đặt con trỏ trong bảng dữ liệu. 

- Chọn lệnh Tab Insert→Group Tables→PivotTable→ PivotTable 

xuất hiện hộp thoại yêu cầu chọn vùng dữ liệu làm thống kê và nơi xuất bảng thống 

kê. 

 

Hình 2.3.1 

 

- Select a Table or range: Cho phép chọn vùng dữ liệu là Sheet hiện hành. 

- Use an external data source: Cho phép chọn vùng dữ liệu từ file Excel 

có sẵn. 

- New Worksheet: Phát sinh bảng thống kê trên sheet mới. 

- Existing Worksheet: Phát sinh bảng thống kê từ địa chỉ được nhập vào. 

- Click OK xuất hiện hộp thoại cho phép kéo thả các field là điều kiện 

thống kê. 
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Hình 2.3.2 

 

- Vùng Row Labels và Column Labels: sẽ chứa field làm điều kiện thống 

kê. 

- Vùng Values:  chứa những field số liệu muốn thống kê. 

- Drag chuột kéo field vào vùng tương ứng kết quả sẽ tự động cập nhật tạo 

thành bảng thống kê. 

2.3.2. Thống kê bằng chức năng Consolidate 
- Chức năng: Consolidate cho phép hợp nhất dữ liệu từ nhiều vùng dữ 

liệu nguồn (Sources) và hiển thị kết quả trong vùng dữ liệu đích (Destination).  

- Giả  sử  công ty ABC có 3 cửa hàng, mỗi cửa hàng có một bảng báo cáo  

doanh thu năm 2013. Công ty có nhu cầu tổng hợp các báo cáo của 3 cửa hàng thành 

một báo cáo doanh thu năm 2013 của công ty. 
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Hình 2.3.3 

 

Thực hiện các bước sau: 

Bước 1. Chọn vùng dữ liệu đích bằng cách trỏ chuột vào một ô bất kỳ ở vùng đó. 

Bước 2. Chọn Tab Data → group Data Tools → Consolidate, xuất hiện hộp 

thoại Consolidate. 
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Hình 2.3.4 

 

- Hộp  Function: chọn hàm sử  dụng (Sum, Min, Max, …), thông thường 

khi tổng hợp dữ liệu bạn chọn hàm Sum để tính tổng. 

- Hộp Reference: để tham chiếu lần lượt các vùng dữ liệu nguồn. 

- Hộp  All references: chứa tất cả  các vùng dữ  liệu nguồn cần thiết cho 

việc hợp nhất. Để xóa một vùng dữ liệu trong hộp All references, bạn chọn vùng đó, 

rồi nhấp nút Delete. 

- Top row: chọn nếu muốn dùng tên cột của vùng nguồn, 

- Left column: chọn nếu muốn dùng các giá trị  của cột đầu tiên của vùng 

nguồn, ở  đây là giá trị của cột Mặt hàng, 

- Create links to source data: chọn nếu muốn dữ  liệu hợp nhất được 

cập nhật mỗi khi có thay đổi ở vùng dữ liệu nguồn. 

 

Hình 2.3.5 
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2.3.3. Thao tác với PivotCharts 
Một PivotChart chẳng có gì khác hơn là một biểu đồ Excel, được tạo ra từ dữ 

liệu của một PivotTable. Thật ra thì cũng có một vài tính năng mà bạn không tìm thấy ở 

những biểu đồ bình thường. Tuy nhiên, phần lớn thì một PivotChart cũng giống như bất kỳ 

một biểu đồ nào trong Excel, những thao tác với các biểu đồ, hoặc việc định dạng cho nó, 

chẳng có gì khác.  

Nếu bạn biết chắc rằng bạn sẽ cần đến một PivotChart, bạn có thể tạo ra 

PivotTable và PivotChart cùng một lần. Thay vì nhấn vào nút PivotTable trong nhóm Insert 

trên thanh Ribbon, bạn hãy nhấn vào cái mũi tên nhỏ ở dưới cái nút đó, và chọn lệnh 

PivotChart. Rồi thì bạn cũng sẽ gặp hộp thoại tạo một PivotTable như ở những bài trên, 

nhưng khi tạo xong PivotTable, thì Excel cũng sẽ tự  động tạo luôn một PivotChart đi kèm 

theo. 

Bây giờ chúng ta sẽ học cách tạo ra một PivotChart từ PivotTable mà bạn đã 

thực hành ở bài trước. Bạn lần lượt theo các bước sau: 

Bước 1. Để con trỏ tại ô nào đó trong bảng thống kê bằng PivotTable  

Bước 2. Vào Tab Option ( PivotTable Tools ) → group Tools → PivotChart  

 

 

Hình 2.3.6 

Bước 3. Trong hộp thoại Insert Chart, bạn chọn loại biểu đồ thích hợp theo yêu cầu. 

 

Hình 2.3.7 
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Bước 4. Nhấn OK để hoàn thành. 

 

Hình 2.3.8 

 

Khi bạn nhấn vào biểu đồ, tức là bạn kích hoạt PivotTable, Excel sẽ hiển thị 

hộp thoại PivotChart Filter Pane như bạn thấy ở hình trên. Bạn có thể dùng Axis 

Fields và Legend Fields trong hộp thoại này để lọc các dữ liệu, điều chỉnh PivotChart hiển 

thị hay không hiển thị biểu đồ của một loại dữ liệu nào đó. Bất kỳ việc lọc dữ liệu nào bạn 

thực hiện trong hộp thoại này, cũng sẽ được áp dụng trong PivotTable, và biểu đồ sẽ tự động 

vẽ lại theo những thay đổi trong PivotTable. 

Ví dụ, bạn nhấn vào Axis Fields, và chỉ chọn hai Trường: Hòa Bình, Nguyễn Du. Biểu đồ sẽ 

tự động vẽ lại như sau: 

 

Hình 2.3.9 

 

2.3.4. Biểu đồ nâng cao 
1.1.1.9. Thêm đường xu hướng vào đồ thị ( TrendLine ) 

Khi vẽ các đồ thị với dữ liệu theo thời gian chúng ta thường vẽ thêm đường xu 

hướng để biết được xu hướng trong tương lai của tập dữ liệu. Một tập số liệu có thể có nhiều 

đường xu hướng tùy theo cách phân tích của chúng ta.  
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Ví dụ : Bạn có một biểu đồ, bạn muốn vẽ đường trendline cho đồ thị, bạn thực 

hiện:  

- Trên Chart Tools → Tab Layout → group Analysis → Trendline. 

 

 

Hình 2.3.10 

 

- Chọn một trong sáu kiểu đường xu hướng/hồi quy: tuyến tính (Linear), 

lôga (Logarithmic), đa thức (Polynomial), luỹ thừa (Power), mũ (Exponential), và 

bình quân dịch chuyển (Moving Average). 

- Hoặc bạn có thể chọn  More Trendline Options để thêm các tùy chọn. 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 161 

 

Hình 2.3.11 

 

- Sau đó nhấn OK để hoàn thành. 

- Để xóa các Trendline , bạn chọn Chart Tools → Tab Layout → group 

Analysis → Trendline → None. 

1.1.1.10. Tạo Template cho biểu đồ 

 

Hình 2.3.12 

 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 162 

Bạn muốn thiết kế một mẫu biểu đồ riêng theo ý mình và dùng mẫu đó cho 

những biểu đồ tiếp sau. Ví dụ bạn có một mẫu biểu đồ như hình trên, bạn muốn áp dụng cho 

những bài tập sau, bạn sẽ lưu nó như một Template trong Excel. Bạn lần lượt thực hiện: 

Bước 1. Sau khi bạn thiết kế một mẫu theo ý muốn, trong Chart Tools → 

Tab Design → group Type → Save As Template 

 

Hình 2.3.13 

 

Bước 2. Chọn Save để lưu lại mẫu. 

 Sử dụng Templates: Để sử dụng mẫu biểu đồ đã lưu, bạn thực hiện: 

Bước 1. Chọn biểu đồ muốn lấy mẫu. 

Bước 2. Vào Chart Tools → Tab Design → group Type → Change 

Chart Type 

 

Hình 2.3.14 

Bước 3. Trong hộp thoại Change Chart Type chọn thư mục Templates 

→ khung My Templates  chọn mẫu bạn đã lưu. 
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Hình 2.3.15 

Bước 4. Chọn OK để hoàn thành. 

 Xóa Templates: Để xóa những mẫu mà bạn đã tạo và lưu, bạn thực hiện: 

Bước 1. Vào Tab Insert → group Charts → Create Chart 

 

 

Hình 2.3.16 

 

Bước 2. Trong cửa sổ Insert Chart → Manage Templates 
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Hình 2.3.17 

 

Bước 3. Trong cửa sổ Templates/ Charts bạn chọn mẫu muốn xóa, nhấn 

Delete. 

 

Hình 2.3.18 
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2.3.5. Tính năng Sparkline 
Excel luôn có dữ liệu đồ thị và biểu đồ rất phong phú để mô tả dữ liệu và xu 

hướng. Với Excel 2010, Microsoft đã bổ sung thêm một tính năng mới - Sparklines. Tính 

năng này cho phép người dùng đặt một đồ thị cỡ nhỏ (mini) hay một dòng nhận định khuynh 

hướng trong một ô (cell). Sparklines là cách nhanh nhất và đơn giản nhất để thêm thành phần 

đồ thị hiển thị vào một cell. 

Giả sử chúng ta có bảng dữ liệu như sau: 

 

Hình 2.3.19 

 

Bước 1. Chọn các ô bạn muốn hiển thị Sparkline. 

Bước 2. Vào Tab Insert → group Sparklines → chọn loại Sparkline bạn cần.  

 

 

Hình 2.3.20 

( Ví dụ ở đây, ta chọn Column ) 

 Bạn sẽ nhận được bảng tạo Sparkline:  

- Data Range: Vùng dữ liệu muốn hiển thị Sparkline 

- Location Range:  Chọn vùng hiển thị Sparkline. 

 

Hình 2.3.21 
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Hình 2.3.22 

 

Bước 3. Chọn OK hoàn thành. 

 

Hình 2.3.23 

 

Sử dụng đúng Sparklines, việc phân tích dữ liệu sẽ nhanh hơn và định hướng 

hơn và chắc chắn bạn cũng sẽ có một khung nhìn đơn giản hơn khi quan sát các thông tin và 

đưa ra quyết định. 

 

2.3.6. Phân tích độ nhạy ( What – If Analysis ) 
Excel luôn có dữ liệu đồ thị và biểu đồ rất phong phú để mô tả dữ liệu và xu 

hướng. Với What-If Analysis (phân tích điều gì sẽ xảy ra) là phương pháp cơ bản nhất để 

truy vấn dữ liệu trong bảng tính. Giả sử, bạn thiết lập công thức tính Lợi nhuận = Doanh thu 

– Chi phí. Bạn tự hỏi: Điều gì sẽ xảy với kết quả Lợi nhuận nếu Doanh thu thay đổi hoặc Chi 

phí thay đổi hoặc cả 2 cùng thay đổi? 

1.1.1.11. Phân tích 1 chiều 
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Ví dụ: Một người kinh doanh máy tính,  mua sản phẩm Laptop với giá 

15,000,000 đồng và bán với giá 17,000,000 đồng.  

Lợi nhuận sẽ là: 17,000,000-15,000,000= 2,000,000 

Lập bài toán: 

 
Hình 2.3.24 

 

Giá mua biến động theo thời gian như hình: 

 

 
Hình 2.3.25 

 

Ta xét độ nhạy của lợi nhuận khi giá mua thay đổi. 

- Chọn vùng : B7:F8 

- Vào Tab Data → group Data Tools → What – If  Analysis → Data Table 
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Hình 2.3.26 

 

- Nếu bạn chạy độ nhạy theo hàng, như trong ví dụ này thì bạn chọn Row input cell 

và nhập vào đang chứa giá trị thay đổi (ở đây ta đang xét giá mua thay đổi). Nếu 

bạn thiết kế giá trị thay đổi theo Cột thì bạn sẽ đưa địa chỉ ô có giá trị thay đổi là: 

Column input cell. 

 

 

Hình 2.3.27 

- Chọn OK  để xem kết quả. 

 

 

Hình 2.3.28 

"Với mỗi thay đổi  của giá mua sẽ làm cho lợi nhuận thay đổi, như ở ví dụ này ta thấy. 

khi giá mua >= 15,000,000 thì lợi nhuận <= 0. người bán không có lợi nhuận” 

1.1.1.1. Phân tích 2 chiều 

Phân tích độ nhạy 2 chiều xét tới sự ảnh huỏng của 2 biến x1 và x2 lên 

biến y. y là biến phụ thuộc của x1 và x2. 

Quay lại với ví dụ trên. ta lấy trường hợp giá mua là x1: thay đổi và giá bán 

sản phẩm x2 thay đổi. 
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Hình 2.3.29 

 

- Chọn vùng B7:F10. 

- Vào Tab Data → group Data Tools → What – If  Analysis → Data Table 

 
Hình 2.3.30 

 

- Sau đó chọn Row input cell và Column input cell theo bảng mà bạn thiết kế. 

- Chọn OK  hoàn thành. 
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Hình 2.3.31 

 

Ngoài ra ta còn có Goal seek (Hàm mục tiêu) thường áp dụng trong các bài toán 

như tính doanh thu hòa vốn, thay đổi một chỉ tiêu chi phí nào đó để có được lợi nhuận như 

mong muốn, tính tổng chi phí cho tổng chi phí ròng phải trả… Và dạng Phân tích tình huống 

(Scenario) : Là dạng phân tích “what-if”, phân tích tình huống thừa nhận rằng các biến nhất 

định có quan hệ tương hỗ với nhau. Do vậy, một số ít biến số có thể thay đổi theo một kiểu 

nhất định tại cùng một thời điểm. Tập hợp các hoàn cảnh có khả năng kết hợp lại để tạo ra 

“các trường hợp” hay “các tình huống” khác nhau là: 

a. Trường hợp xấu nhất/ Trường hợp bi quan 

b. Trường hợp kỳ vọng/ Trường hợp ước tính tốt nhất 

c. Trường hợp tốt nhất/ Trường hợp lạc quan 

Ghi chú: Phân tích tình huống không tính tới xác suất của các trường hợp xảy ra 

 

2.3.7.  Sử dụng dữ liệu liên kết ngoài 
Đôi khi dữ liệu bạn muốn không có trong sổ làm việc Excel – dữ liệu đó có thể ở 

trong một cơ sở dữ liệu, tệp XML, trên web, trong tệp văn bản hoặc ở một trong nhiều vị trí 

khác. Thật tuyệt vời khi làm việc với dữ liệu ngay trong sổ làm việc, nhưng bạn không muốn 

phải nhập đi nhập lại dữ liệu để đảm bảo tính hiện thời của dữ liệu. Việc tạo kết nối cố định 

từ sổ làm việc tới nguồn dữ liệu đó giúp dễ dàng đảm bảo dữ liệu mà bạn làm việc luôn cập 

nhật. 

Các kết nối đến dữ liệu bên ngoài có thể bị tắt trên máy tính của bạn. Để kết nối 

với dữ liệu khi mở sổ làm việc, bạn phải bật kết nối dữ liệu bằng cách sử dụng thanh Trust 

Center hoặc bằng cách đặt sổ làm việc vào một vị trí tin cậy. 

Trong group Get External Data trên tab Data, bạn có thể tạo kết nối dữ liệu với 

các nguồn dữ liệu khác nhau. 
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Hình 2.3.32 

 

1.1.1.2. Sử dụng liên kết từ Access 

- Trên tab Data → group Get External Data → From Access.  

- Trong hộp thoại Select Data Source, hãy duyệt đến cơ sở dữ liệu Access. 

- Trong hộp thoại Select Table, hãy chọn bảng hoặc truy vấn mà bạn muốn sử dụng và 

bấm OK. 

 

Hình 2.3.33 

 

- Trong hộp thoại Import Data, hãy chọn nơi đặt dữ liệu trong sổ làm việc của bạn và 

chọn xem dữ liệu dưới dạng Table, PivotTable Report hay PivotChart. 

 

Hình 2.3.34 
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- Bấm vào nút  Properties để đặt các thuộc tính nâng cao cho kết nối đó ví dụ như tùy 

chọn để làm mới dữ liệu đã được kết nối. 

 

Hình 2.3.35 

 

- Bạn có thể tùy ý thêm dữ liệu vào Mô hình Dữ liệu để có thể kết hợp dữ liệu của mình 

với các bảng hoặc dữ liệu khác từ các nguồn khác, tạo mối quan hệ giữa các bảng và 

bạn có thể thực hiện được nhiều thao tác hơn so với báo cáo PivotTable cơ bản. 

- Bấm OK để kết thúc. 
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Hình 2.3.36 

 

1.1.1.3. Sử dụng liên kết từ Web 

Hằng ngày, bạn đều phải vào Internet để xem xét giá cổ phiếu của mình. Bạn có 

thể Copy và Paste một cách thủ công bảng giá CK này vào bảng tính, hoặc Website có thể 

cung cấp chức năng Download về Excel trang bảng giá đó. Đây là cách dễ nhất để đưa 

CSDL của trang Web vào Excel. 

Hãy tạo kết nối với trang web để sử dụng dữ liệu từ các bảng trong trang web 

trong sổ làm việc của bạn. 

- Trên tab Data → group Get External Data → From Web.  

- Trong hộp Address (Địa chỉ), hãy nhập địa chỉ web của trang có dữ liệu bạn 

muốn kết nối, và Click → Go. 

 

 

Hình 2.3.37 

- Chỉ báo mũi tên như  này có nghĩa là có dữ liệu bên cạnh mà bạn có thể nhập. 
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Hình 2.3.38 

- Hãy bấm vào chỉ báo mũi tên, bấm nút Import → chọn vị trí đặt dữ liệu → OK. 

 

Hình 2.3.39 

- Kết quả: 

 

Hình 2.3.40 

 

- Để cập nhật dữ liệu, bạn vào Data →groups Connections → Refresh All.  
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Hình 2.3.41 

1.1.1.4. Sử dụng liên kết từ file Text 

Bạn có thể chọn tab Data → group Get External Data → From Text từ, 

tìm đường dẫn đến Text File.  

 

Hình 2.3.42 

 

- Trên tab Data → group Get External Data → From Text.  

 

Hình 2.3.43 

 

- Chọn tập tin bạn muốn Import, sau đó chọn Import 

- Cửa sổ Text Import Wizard sẽ hướng dẫn bạn từng bước để đưa dữ liệu Text vào 

Excel. 

- Chọn vị trí đặt dữ liệu và bấm OK 
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Hình 2.3.44 

 

1.1.1.5. Sử dụng liên kết từ các nguồn khác 

Ngoài liên kết với các dữ liệu thông thường, Excel 2010 còn có thể liên kết 

với các dữ liệu từ các cơ sở dữ liệu : XML, SQL Sever,… 

 

Hình 2.3.45 
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2.4.  Làm Việc Với Macros Và Forms 

2.4.1.  Tạo và thực hiện macros 
Macro là công cụ cho phép ghi lại các thao tác (các lệnh) của người sử dụng 

dưới dạng một danh sách các lệnh. Khi ta gọi tới một  macro (chạy macro), nó sẽ  thực hiện 

lại các thao tác (các lệnh) đó một cách tự động. 

Như vậy muốn tự  động hóa một quá trình, ta cần thực hiện các công việc đó, 

dùng macro ghi lại và khi cần thực hiện quá trình đố tự động, ta cho chạy macro. 

Để làm việc với Macro, bạn cần thực hiện một số tùy chọn sau: 

 

Hình 2.4.1 

 

- Thiết lập thông số cho phép Macro hoạt động trong Excel 2010 
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Hình 2.4.2 

 

 

Hình 2.4.3 

 

Ví dụ: Bạn cần thiết kế một giao diện tìm kiếm thông tin như sau. Khi người dùng 

nhập vào một hoặc nhiều tiêu chí trên các ô tìm kiếm và nhấn nút Tìm kiếm. Kết quả hiển thị 

ở khung Kết quả tìm kiếm phía dưới. 
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Hình 2.4.4 

 

Để  thiết kế  công cụ  tìm kiếm, thực chất  là  sử  dụng chức năng lọc  nâng cao 

Advanced fillter), tuy nhiên ta không lọc thủ  công mà làm thao tác đó 1 lần, ghi lại bằng  

Macro và khi cần tìm kiếm thì cho chạy Macro (nhấn nút Tìm kiếm) để nó thực hiện lại thao 

tác mà ta đã ghi. 

 

 Tạo Macro 

- Vào Developer → Code → Record macro 

 

 

Hình 2.4.5 

 

- Đặt tên cho Macro, chọn phím tắt nếu cần, OK 
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Hình 2.4.6 

 

- Thực hiện các thao tác muốn ghi lại. Trong  ví dụ  này ghi lại thao tác 

lọc bằng Advanced Fillter: lọc bảng dữ  liệu gốc với vùng điều kiện lọc, kết quả  lọc tham 

chiếu đến vùng kết quả. (Xem lại phần trích lọc nâng cao) 

- Bấm nút Stop Recording để kết thúc 

 

 

Hình 2.4.7 

 

 Thực Thi Macro  

Để thực thi Macro, ta có thể thực hiện một trong ba cách: 

1. Hộp thoại Macro 

- Chọn Developer → Code → Macros. Xuất hiện hộp thoại Macro. 

- Chọn một Macro muốn thực thi, nhấn Run 
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Hình 2.4.8 

 

2. Gán phím tắt 

- Trên Tab Developer →Macro → Option 

- Trong hộp thoại Macro Option nhập phím tắt bạn muốn sử dụng. 

 

Hình 2.4.9 

 

- Chọn OK . 
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- Vậy để sử dụng Macro bạn chỉ cần gõ tổ hợp phím tắt vùa gán là Macro 

sẽ được thực thi. 

3. Gán bằng biểu tượng trên thanh Ribbon 

- Trên Tab File → Options → Customize Ribbon →Macro ( trong 

Choose commands from ) 

 

Hình 2.4.10 

 

- Chọn New Tab để thêm lệnh Macro vào một Tab mới. 
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Hình 2.4.11 

 

- Gán các Macro vào Tab vừa tạo. 

 

Hình 2.4.12 
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Hình 2.4.13 

- Chọn OK  để hoàn thành 

 

 

Hình 2.4.14 

 

4. Gán Macro trên thanh Quick Access Toolbar 

- Trên Tab File → Options → Quick Access Toolbar →Macro ( trong 

Choose commands from ) 

 

Hình 2.4.15 

 

- Chọn Macro mà bạn muốn hiển thị → Add 
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- Bạn có thể thay đổi biểu tượng bằng cách chọn Modify → Chọn biểu 

tượng → OK. 

 

Hình 2.4.16 

 

- Kết quả biểu tượng Macro sẽ được hiển thị trên thanh Quick Access 

Toolbar 

 

Hình 2.4.17 

 

2.4.2.  Thao tác với form controls 
Controls nói chung là các điều khiển giao diện người dùng trên Windows, ta 

nhìn thấy nó trên Form đó, như là: Label, Textbox, Button, Combo, Listbox, Treeview, 

ListView,... 

Nếu các controls được tạo ra từ thư viện dll/ocx bên ngoài ứng dụng, gọi là 

ActiveX Controls, nếu chúng có sẵn trong ứng dụng thì chỉ nói là controls. 

Trong Excel có 2 nhóm:  

- Forms: các controls nằm trong này có sẵn trong Excel thì coi là 

Controls. 
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- Userform: các controls nằm trong form này (chúng có trong "Control 

Toolbox") được coi là ActiveX Controls vì nó là trong thư viện ngoài FM20.DLL, và 

các thư viện khác *.OCX. 

- Để làm việc với Form Controls, bạn cần thực hiện một số tùy chọn sau: 

 

Hình 2.4.18 

Trong thẻ Developer, bạn chọn nút Insert (không phải thẻ Insert trong giao 

diện), và lựa chọn các đối tượng để chèn vào. Các đối tượng được chọn là các đối tượng nằm 

trong phần Form Controls. Mỗi biểu tượng tương ứng với việc chèn một đối tượng vào trang 

tính. 

 

Hình 2.4.19 

 Spin Button – điều khiển giá trị của ô tính 

Đây là đối tượng tương đối khá dễ sử dụng. Với Spin Button, người dùng có thể 

bấm vào đó để thay đổi giá trị tăng hoặc giảm trong ô tính bằng cách bấm vào nút mũi tên 
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tam giác lên hoặc xuống. Biểu tượng của Spin Botton hình chữ nhật có hai tam giác hướng 

phần đáy về nhau trong phần Form Controls. 

 

Hình 2.4.20 

 

Ví dụ: Bạn cần tính tiền hàng tháng phải nộp ngân hàng  khi vay: 

 

Hình 2.4.21 

 

Lãi suất thì có thể thay đổi theo thời gian, bạn dùng snip control để tăng giảm lãi suất. 

Bước 1. Vào Tab Developer → Insert →  Snip Button → Vẽ biểu tượng Snip vào 

nơi bạn muốn. 

 

Hình 2.4.22 
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Bước 2. Thiết lập các thuộc tính và dữ liệu cho Snip Control, R_Click lên biểu tượng 

→Format Control 

 

Hình 2.4.23 

 

 

 

Hình 2.4.24 

Bước 3. Click OK để hoàn thành. 

 

 Scroll Bar – điểu khiển giá trị của ô tính qua thanh trượt 

Tương tự như Spin Button, đối tượng này cũng giúp cho bạn điển khiển giá trị của 

ô tính. Điều khác biệt giữa Scroll Bar và Spin Button là Scroll Bar có thanh trượt chính giữa 

hai mũi tên tam giác, và bạn có thể sử dụng thay trược này để kéo qua lại để điều chỉnh giá 

trị thay vì chỉ có thể bấm vào nút mũi tên như Spin Button. Cả hai đối tượng Spin Button và 

Scroll Bar đều chỉ cho phép tuỳ chỉnh giá trị từ 0 đến 30000. 

Ta sẽ thiết kế Scroll Bar theo ví dụ trên: 
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Bước 1. Vào Tab Developer → Insert →  Scroll Bar → Vẽ biểu tượng vào nơi bạn 

muốn. 

 

Hình 2.4.25 

Bước 2. Thiết lập thuộc tính và liên kết dữ liệu cho Scroll Bar. 

 

Hình 2.4.26 

 

Bước 3. Chọn OK để hoàn thành. 

Công tụ Scroll Bar giống như một thanh cuộn của một cửa sổ. Bạn dùng Scroll 

Bar để chọn một con số từ một dãy các giá trị. Nhấp chuột vào các mũi tên (ở hai đầu) hoặc 

rê hộp cuộn (cái nút hình vuông ở giữa Scroll Bar) sẽ thay đổi giá trị của nó. Giá trị này là 

kết quả trả về ở ô liên kết. Bạn có thể tạo một thanh cuộn ngang hoặc một thanh cuộn dọc. 
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 Option Button  

Option button (các nút tùy chọn) là những công cụ điều khiển thường xuất hiện 

với một nhóm gồm hai hoặc nhiều lựa chọn, và người sử dụng chỉ có thể kích hoạt được một 

lựa chọn trong nhóm đó (nghĩa là chỉ được phép chọn một tùy chọn trong nhiều tùy chọn), 

và tuỳ chọn này sẽ gán giá trị cho một ô nào đó. Các Option Button phải được đưa vào một 

vùng xác định (chỉ cho phép chọn một Option Button trong vùng đó). 

Để tạo vùng xác định chứa các Option Button, bạn chọn biểu tượng Group Box 

(hình vuông có chữ “xyz” phía trên) trong nút Insert. 

 

Các bước thiết kế Option Button: 

Bước 1.  Vào Tab Developer → Insert →  Option button → Vẽ biểu tượng 

vào nơi bạn muốn. 

 

Hình 2.4.27 

 

Bước 2. Để chỉnh sửa lại chữ tên của lựa chọn, bạn bấm chuột phải vào Option 

Button tương ứng, chọn Edit Text rồi nhập vào. Để tuỳ chỉnh chức năng của các Option 

Button, bạn bấm chuột phải vào Option Button đó và chọn Format Control.  
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Hình 2.4.28 

 

Bước 3. Trong thẻ Control của hộp thoại hiện ra, bạn có thể chọn tuỳ chọn 

Checked hoặc Unchecked tương ứng với việc Option Button đó có được chọn làm mặc 

định sẵn hay không, phần Cell link bạn chọn ô liên kết đến Option Button. Khi một 

Option Button trong vùng xác định đã được lựa chọn vị trí ô liên kết thì mọi Option 

Button khác trong vùng xác định đó đều được ấn định với cùng một ô liên kết ấy. 

 

Hình 2.4.29 

 

Ô liên kết sẽ nhận giá trị trả về là một con số, tương ứng với thứ tự khi bạn tạo 

ra từng Option Button trong vùng xác định. Ví dụ, khi người dùng chọn tuỳ chọn được bạn 

tạo ra đầu tiên, ô liên kết sẽ nhận giá trị 1, khi người dùng chọn tuỳ chọn thứ hai, ô liên kết 

sẽ nhận giá trị là 2…  

Với cách hoạt động này, bạn có thể sử dùng hàm IF trong Excel kết hợp với 

Option Button để áp dụng trong rất nhiều việc. Bạn có thể đặt điều kiện, nếu ô liên kết nhận 

giá trị là 1, 2, 3… thì kết quả sẽ được hiển thị tương ứng. Dưới đây là một ví dụ: 

 

Hình 2.4.30 

 

 Check Box 
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Các Check Box (hộp kiểm) cho phép bạn đưa ra các tùy chọn mà người dùng có 

thể bật hoặc tắt (chọn hay không chọn). Giống như các Option Button, Excel vẽ các Check 

Box với trạng thái mặc định là không được chọn. Nếu bạn muốn một Check Box cụ thể nào 

đó xuất hiện với trạng thái ban đầu là được chọn, bạn dùng hộp thoại Format Control để kích 

hoạt tùy chọn Checked như đã nói trong bài trước. 

Bước 1. Vào Tab Developer → Insert →  Check Box → Vẽ biểu 

tượng vào nơi bạn muốn. 

 

 

Hình 2.4.31 

 

Bước 2. Sau khi tạo Check Box, bạn bấm chuột phải vào Check Box, 

chọn Format Control và chọn thẻ Control. Các tuỳ chọn Checked, Unchecked và 

Mixed tương ứng với các tuỳ chọn mặc định của Check Box là được chọn, không 

được chọn hoặc không xác định. Ô liên kết được lựa chọn tại phần Cell link. 

 

Hình 2.4.32 
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Hình 2.4.33 

 

Hình 2.4.34 

 

 List Box & Combo Box 

Công cụ List Box tạo ra một danh sách mà từ đó người dùng có thể chọn ra một 

mục. Các mục trong danh sách này được định nghĩa bởi những giá trị trong một dãy ô đã 

được xác định trong bảng tính, và giá trị trả về tại ô liên kết là số thứ tự của mục được chọn 

trong danh sách. Combo Box cũng tương tự như List Box, cái khác là công cụ này chỉ hiện 

ra mỗi lần một mục trong danh sách, muốn xem những mục khác thì bạn phải nhấn cho nó 

mở ra. 

List Box và Combo Box khác với những công cụ điều khiển khác, bởi vì bạn phải 

xác định một dãy chứa các mục xuất hiện trong danh sách. Những bước sau đây hướng dẫn 

bạn cách làm điều đó:  

Bước 1. Chọn Tab Developer → Insert →  Combo Box ( hoặc    List Box 

) → Vẽ biểu tượng vào nơi bạn muốn. 
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Hình 2.4.35 

 

 

Bước 2. Sau khi tạo Combo Box ( List Box ), bạn bấm chuột phải , chọn Format 

Control và chọn thẻ Control. Thiết lập các tùy chọn: 

 

Hình 2.4.36 

 

Bước 3. Chọn OK hoàn thành. 
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Hình 2.4.37 

 

Hình 2.4.38 

 

Ví dụ : Sau khi đã tạo xong Combo Box cho các loại kỳ hạn, bạn thiết lập công 

thức vào ô Số tháng và dựa vào đó tính ô Thanh toán tiền hàng tháng phải trả. 

 

Hình 2.4.39 

 

Khi bạn thay đổi giá trị bằng cách chọn Combo Box thì các giá trị liên quan sẽ 

thay đổi theo. 
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Hình 2.4.40 
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3. SỬ DỤNG INTERNET 

3.1. Giới thiệu Internet 
Internet là hệ thống thông tin toàn cầu có thể được truy nhập công cộng gồm các 

mạng máy tính được liên kết với nhau. Hệ thống này truyền thông tin theo kiểu chuyển mạch 

gói dữ liệu (packet switching) dựa trên bộ giao thức đã được chuẩn hóa (giao thức TCP/IP). 

Hệ thống này bao gồm hàng ngàn mạng máy tính của các doanh nghiệp, của các viện nghiên 

cứu và các trường đại học, của người dùng cá nhân, và các chính phủ trên toàn cầu. 

Tiền thân của mạng Internet ngày nay là mạng ARPANET do  bộ quốc phòng Mỹ 

liên kết với một số trường ĐH của Mỹ thực hiện. 

Hiện nay nhu cầu khai thác thông tin trên mạng Internet ngày càng tăng. Vì vậy 

trong chương này sẽ giới thiệu những khái niệm cơ bản về Internet, các dịch vụ trên Internet 

và cách sử dụng trình duyệt Internet Explorer để khai thác thông tin trên Internet.  

Mạng Internet có thể chỉ dừng lại ở đấy nếu như không có sự ra đời của World Wide 

Web, được phát minh bởi Tim Berners-Lee trong thời gian làm việc tại CERN (Tổ chức 

nghiên cứu nguyên tử của Châu Âu đặt tại Thụy Sĩ). Ông Tim đã tìm ra cách thức để máy 

tính ở các vị trí, địa điểm khác nhau có thể hiển thị những văn bản có liên kết đến các tập tin 

văn bản khác. Kết quả nghiên cứu của ông Tim đó là ngôn ngữ đánh dấu siêu văn bản 

HTML (Hyper Text Markup Language).  

Để hiểu nguyên lý hoạt động của Internet theo cách đơn giản nhất, ta có thể hình 

dung thông tin gởi và nhận từ các máy tính giống như việc gởi thư qua hệ thống bưu điện. 

Khi muốn gởi thư, người ta thường đến một trạm bưu điện gần nhất để bỏ thư vào thùng. Tại 

đây thư của chúng ta và của nhiều người khác nữa sẽ được phân loại theo địa chỉ rồi tiếp tục 

được gởi lên tuyến cao hơn. Quy trình cứ tiếp tục như thế cho đến khi thư của chúng ta tới 

được địa chỉ của người nhận.  

Tương tự như vậy, khi nhận và gởi thông tin trên Internet, thông tin cần phải được 

xác định địa chỉ duy nhất. Địa chỉ Internet của các tư liệu được quản lý bằng bộ định vị tài 

nguyên đồng dạng URL (Uniform Resource Locator). Mỗi trang Web khi được đưa lên 

Internet sẽ có ít nhất một địa chỉ URL tham chiếu đến nó. 

 

3.2. Một số khái niệm 
 Địa chỉ IP (Internet Protocol Address) 

Khi tham gia vào Interntet, mỗi máy tính gọi là host, phải có một địa chỉ IP dùng 

để nhận dạng. Địa chỉ IPv4 được chia làm 4 số thập phân có giá trị từ 0-255, phân cách nhau 

bằng dấu chấm (ví dụ như: 172.16.19.5 hoặc 172.16.0.3). Để truy xuất trang chủ của ĐH 

Công Nghệ Đồng Nai thì gõ IP là 125.234.251.138 vào trình duyệt. 

Cách đánh IP gồm 4 số thập phân như trình bày ở trên gọi là IPv4. Hiện nay do 

tốc độ phát triển quá nhanh của Internet, IPv4 (có chiều dài 32 bit) đã cạn kiệt. Internet đang 

chuyển đổi dần sang IPv6 (128 bit).   
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 Hệ thống tên miền DNS (Domain Name System)  

Đối với con người, cách truy xuất một website (như trang chủ trường ĐH Nghệ 

Đồng Nai nói trên) bằng IP như trên là rất khó nhớ. Do đó hệ thống tên miền DNS giúp ánh 

xạ giữa tên và IP giúp dễ dàng sử dụng hơn. Ví dụ, www.dntu.edu.vn dễ nhớ hơn nhiều so 

với IP là 125.234.251.138. Tên miền DNS do các DNS server đảm trách, do đó chúng ta 

phải trả phí hàng năm cho việc đăng ký tên miền.  

Các phần com, edu hay vn trong địa chỉ tên miền ở trên được gọi là tên miền cấp 

1, chia làm 2 nhóm chính:  

Domain mang tính tổ chức:  

Domain  Tổ chức  

com (Commercial)  Thương mại  

edu (Educational)  Giáo dục  

gov (Governmental)  Nhà nước  

int (International)  Tổ chức quốc tế  

mil (Military)  Quân đội  

net (Networking)  Tài nguyên trên mạng  

org (Organizational)  Các tổ chức khác  

 

Domain mang tính địa lý: Gồm 2 ký tự tắt đại diện cho từng quốc gia, như vn (Việt 

Nam), au (Úc), in (Ấn Độ), … 

❖ IAP  

IAP (Internet Access Provider)  là nhà cung cấp dịch vụ đường truyền để kết nối 

với Internet, quản lý cổng (gateway) nối với quốc tế. Các máy tính ở các quốc gia khác 

muốn kết nối với nhau phải có cơ sở hạ tầng, do đó phải nhờ đến IAP. Tại Việt Nam, IAP là 

công ty dịch vụ truyền số liệu VDC thuộc tổng công ty bưu chính viễn thông, cơ quan thực 

hiện trực tiếp là VNN.  

❖  ISP  

ISP (Internet Service Provider)  là nhà cung cấp dịch vụ Internet cho các tổ chức 

và cá nhân. ISP phải thuê đường truyền và cổng của một IAP. Việt Nam có nhiều ISP 

thương mại: Công ty dịch vụ truyền số liệu VDC, Công ty FPT, … 

Khi đăng ký với một ISP, người dùng được cung cấp một tài khoản để quản lý 

truy cập và tính phí. Mỗi tài khoản bao gồm tên (User name) và mật khẩu đăng nhập 

(Password). Tài khoản này thường được lưu sẵn trong các thiết bị (như các modem) được 

cấu hình bởi ISP nên người dùng không sử dụng trực tiếp. 

 

3.3. Các dịch vụ thông dụng trên Internet 
 Dịch vụ truy xuất từ xa (Remote Login) 

http://www.dntu.edu.vn/
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Dịch vụ truy xuất từ xa cho phép nối kết, và sử dụng một máy tính ở vị trí khác. 

Ví dụ, Telnet là một dịch vụ cho phép remote login. Ngày nay, nhiều dịch vụ an toàn hơn đã 

ra đời thay thế cho telnet như ssh, vpn… 

 Dịch vụ thư điện tử (Mail Service) 

Để có thể gửi hoặc nhận các thư điện tử (Electronic Mail - Email) từ bất cứ một 

nơi nào với điều kiện là người nhận và người gửi phải có một địa chỉ Email và máy tính sử 

dụng có nối mạng Internet.  

 Dịch vụ tin điện tử (News) 

Cho phép trao đổi các bài báo và bản tin điện tử (bulletin) xuyên suốt Internet. 

Các bài báo được đặt tại trung tâm cơ sở dữ liệu trên suốt không gian Internet. Người dùng 

truy cập vào cơ sở dữ liệu đó để lấy về các bài báo họ cần. Điều này làm giảm tắc nghẽn trên 

mạng và loại trừ việc lưu trữ nhiều bản sao không cần thiết của mỗi bài báo trên từng hệ 

thống của người dùng.  

 Dịch vụ truyền tập tin (FTP: File Transfer Protocol) 

FTP là một hệ thống chính yếu để chuyển tải file giữa các máy vi tính vào 

Internet. File được chuyển tải có dung lượng rất lớn. FTP hầu hết được sử dụng cho việc 

chuyển tải những dữ liệu mang tính cá nhân.  

Thông thường, bạn sẽ dùng FPT để chép file trên một máy chủ từ xa vào máy 

của bạn, việc xử lý này gọi là nạp xuống (downloading). Tuy nhiên, bạn cũng có thể chuyển 

file từ máy của bạn vào máy chủ từ xa, điều này gọi là nạp lên (uploading). Thêm vào đó, 

nếu cần thiết, FTP sẽ cho phép bạn chép file từ một máy chủ từ xa tới một máy khác.  

 Dịch vụ Web (World Wide Web – WWW) 

Đây là dịch vụ được dùng nhiều nhất. Người ta viết tắt là WWW hay gọi ngắn 

gọn là Web. Web chứa thông tin bao gồm văn bản, hình ảnh, âm thanh và thậm chí cả video 

được kết hợp với nhau. Web cho phép bạn có thể thâm nhập vào mọi ngõ ngách trên 

Internet, là những điểm chứa dữ liệu gọi là Web site. Nhờ có Web, nên dù không phải là một 

chuyên gia, bạn vẫn có thể sử dụng Internet.  

Phần mềm sử dụng để nạp, dịch và hiển thị Web gọi là trình duyệt Web (Web 

browser). Hiện nay, trình duyệt thông dụng nhất là là Internet Explorer của Microsoft, ngoài 

ra còn có Mozilla Firefox, Chrome của Google, Opera, Safari của Apple … 

 

 

3.4. Trình duyệt web 

3.4.1. Các trình duyệt thông dụng 
Hiện nay có rất nhiều hãng cung cấp trình duyệt miễn phí, nhưng tựu trung lại có 

3 sản phẩm thông dụng sau: 

✓ Chrome   

✓ Firefox 
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✓ Internet Explorer 

 

3.4.2. Sử dụng trình duyệt 
Khi cài đặt máy tính thì phần mềm IE đã được tích hợp sẵn,  

Để khởi động trình duyệt: Chọn Start/ All Programs/ Internet Explorer. 

 

 

Các nút công cụ cho phép thực hiện các thao tác nhanh hơn. Chức năng của các nút 

trên thanh công cụ như sau:  

− Back: Trở về trang trước đó.  

− Forward: Hiển thị trang kế tiếp trong lịch sử duyệt.  

− Stop: Ngưng tải trang web hiện hành từ máy chủ.  

− Refresh: Tải lại nội dung trang Web hiện hành.  

− Home: Hiển thị trang home, địa chỉ trang này được config theo mỗi máy khác nhau, là 

website tự động nạp mỗi khi khởi động IE.  

− Favorites: Danh sách những trang Web ưa thích.  

− New Tab: Thêm một Tab mới. 

− Address: Dùng để nhập địa chỉ của trang Web muốn truy cập. Thanh địa chỉ cũng hiện 

lên địa chỉ của trang Web hiện hành. Bạn có thể Click vào hộp thả xuống để chọn địa chỉ 

của những trang Web thường truy cập. 

− Current Tab: Tab hiện đang hiển thị. 

− Tools: Chứa các nhóm công cụ của Internet Explorer. 

− Trạng thái nạp : Dùng để hiển thị tiến trình nạp trang Web khi trang Web đang được 

nạp. Sau khi nạp xong biểu tượng nạp sẽ được chuyển thành biểu tượng Internet 

Explorer. 

 Lưu nội dung trang Web  

Người dùng có thể lưu nội dung của các trang Web trên máy cục bộ, sau đó ta có 

thể xem nội dung của các trang này mà không cần phải có kết nối Internet. Sau khi truy cập 
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đến trang Web cần lưu nội dung, chọn Tools→File→Save As, và chọn vị trí cùng với tên file 

cần lưu. 

 Lưu các địa chỉ thường dùng  

Chức năng này giúp người dùng lưu địa chỉ của các trang Web thường sử dụng, 

giúp người dùng không cần phải nhớ chỉ của nó. Sauk hi truy cập đến trang Web cần lưu địa 

chỉ, Chọn Favorites/ Add to Favorites, nhập tên cho địa chỉ muốn lưu->OK. 

 

3.5. Tìm kiếm thông tin trên Internet 

Tìm kiếm thông tin là hoạt động phổ biến đối với người sử dụng Internet. So với 

thông tin được lưu trữ trên những phương tiện khác, thông tin được lưu trữ trên Internet 

phong phú và tìm kiếm dễ dàng hơn. Ngoài ra, kết quả tìm kiếm đạt được nhiều hơn so với 

việc tìm kiếm thông tin được lưu trữ trên các phương tiện khác. Đây là điểm mạnh nhưng đôi 

khi cũng là điểm yếu của Internet vì khi tìm được quá nhiều thông tin liên quan đến thông tin 

cần tìm, ta phải tốn thời gian để lọc lại những thông tin phù hợp.  

Hiện tại có nhiều hãng cung cấp dịch vụ tìm kiếm khác nhau: google 

(www.google.com), microsoft (www.bing.com), yahoo (www.yahoo.com)… Mỗi hãng có 

những điểm mạnh và điểm yếu riêng, tuy nhiên dẫn đầu hiện nay là www.google.com.  

Nhập thông tin muốn tìm vào hộp văn bản rồi nhấn Enter hoặc Click vào nút lệnh 

Google Search. Thông tin tìm kiếm thường là các từ khóa (Keyword) hoặc một cụm từ đặc 

trưng nhất. Việc chọn từ khóa chính xác cho giúp cho việc tìm kiếm dễ dàng, nhanh chóng. 

 

 

 

http://www.google.com/
http://www.bing.com/
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Chú ý:  

− Đặt dấu “ trước từ khóa để yêu cầu tìm kiếm chính xác cụm từ cần tìm (liên kết 

AND). 

− Không nên nhập vào những từ khóa có nội dung tổng quát vì kết quả tìm kiếm 

sẽ rất nhiều, thông tin được trả về sẽ không gần với nội dung muốn tìm.  

 Tìm kiếm nâng cao với Google  

Trong trường hợp muốn có kết quả tìm kiếm gần với thông tin đang tìm, ta sử dụng 

chức năng tìm kiếm nâng cao của Google (Advanced Search).  

− Find results: Đặt điều kiện cho kết quả tìm kiếm. 

− With all of the Words: Kết quả tìm kiếm phải bao gồm tất cả các từ cần tìm  

− With the exact phase: Kết quả tìm kiếm phải có chính xác cụm từ cần tìm.  

− With at least one of the Word: Kết quả tìm kiếm phải có ít nhất một trong những từ 

cần tìm  

− Without the Word: Kết quả tìm kiếm không chứa những từ này  

Hiển thị kết quả trả về: chọn số kết quả trả về từ hộp kê thả, mặc nhiên sẽ trả về 10 

kết quả nếu tìm được từ 10 trang Web trở lên.  

Ngoài ra ta có thể đặt thêm điều kiện vào những tùy chọn khác như ngôn ngữ, thời 

gian, định dạng, … 

 

3.6. Dịch vụ Email 

 Giới thiệu 

Thư điện tử (Email) là phương tiện liên lạc vô cùng tiện lợi trong thời đại công 

nghệ thông tin ngày nay. Sử dụng Email ta có thể trao đổi thông tin với bạn bè, đồng nghiệp 

trên toàn cầu mà không quan tâm đến việc người nhận ở đâu.  

Địa chỉ Email (Email Address), gọi tắt là email, là một định danh duy nhất trên 

Internet cho phép người sử dụng giao dịch với nhau. Cấu trúc một địa chỉ Email: <Tên tài 

khoản>@<Tên miền>. Tên miền: Tên của máy chủ cung cấp dịch vụ Email (Email Server), 

tên tài khoản là tên được đăng ký, để phân biệt với các địa chỉ Email khác có cùng tên miền.  

Ví dụ: ttcntt@yahoo.com; email@dntu.edu.vn; list@hotmail.com; … 

Muốn gởi email thì người dùng phải có nối kết Internet (hoặc nối kết vào Mail 

Server. Khi người A gởi Email cho người B, nội dung thư sẽ được lưu trữ tại Email Server. 

Chỉ duy nhất người B có thể đăng nhập vào tài khoản của mình và đọc tất cả Email gởi cho 

mình. Có nhiều cách để làm việc với email: sử dụng Webbrowser để sử dụng Webmail (nếu 

nhà cung cấp email có dịch vụ này), hoặc dùng công cụ khác. 

Webmail là hệ thống cung cấp các dịch vụ Email thông qua một Website. Người dùng 

sử dụng Webbrowser truy cập vào địa chỉ Website của nhà cung cấp dịch vụ, sử dụng tài 

khoản Email đã được cung cấp để sử dụng các dịch vụ Email. Một số webmail thông dụng: 

www.gmail.com, www.hotmail.com, www.mail.yahoo.com... Cách sử dụng các dịch vụ 

http://www.gmail.com/
http://www.hotmail.com/
http://www.mail.yahoo.com/
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email của các hang lớn gần như tương tự, do đó trong giáo trình này chỉ tập trung mô tả về 

dịch vụ email của Google. Google tự động hiển thị ngôn ngữ theo vùng truy xuất email, tức 

là tiếng Việt, và cung cấp nhiều dịch vụ khác dựa trên tài khoản email mà thế giới rất ưa 

chuộng. 

 Đăng ký tài khoản email 

Để đăng ký một tài khoản Email mới: từ 

Webmail (chẳng hạn, từ trang www.gmail.com), chọn 

mục Tạo tài khoản.  

Sau đó điền các thông tin vào biểu mẫu, và bấm nút tạo tài khoản. 

Lưu ý là gmail yêu cầu bạn phải có số điện thoại di động để gởi mã xác nhận nhằm 

bảo vệ người dùng. 

 

 

 

 Sử dụng email với Webmail 
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Sau khi đã có tài khoản Email, trước khi sử dụng Email phải đăng nhập từ trang 

www.gmail.com.  

Các email nhận được sẽ hiển thị khi chọn mục Thư. 

Để soạn Email mới, chọn nút Compose. Nhập nội dung Email với các mục như sau: 

Tới (Email một hay nhiều người nhận -cách nhau bằng dấu ;);  CC (Email người đồng nhận); 

BCC (Email người đồng nhận nhưng không hiển thị cho biết cùng nhận Email với hai nhóm 

Email ở trên); Chủ đề (Subject -tiêu đề Email); Body (nội dung Email);  

Để gởi file đính kèm Email, chọn nút Đính kèm. Sau đó chọn file cần gởi đi. 

Chú ý: sau khi sử dụng Email xong, chúng ta phải Sign-out để tránh việc mất tài 

khoản Email, bảo vệ thông tin riêng tư.  

 

 

 

 

 

Nội dung thư gửi 

Nút gửi 

Định 

dạng font 

To: người nhận 

CC: người đồng kính gửi. 

BCC: giống CC nhưng người nhận 

sẽ không biết (trừ người BCC) 

Tiêu đề thư 

Đính kèm 

FILE 

Chèn 

hình ảnh 

Xóa thư 
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 Sử dụng email với Outlook Express 

Outlook Express là phần mềm quản lý Email của 

hãng Microsoft Windows (tương tự với Thunderbird của 

Mozilla). Phần mềm này cung cấp hầu hết các tính năng cần 

thiết để người dùng có thể quản lý Email một cách hiệu quả. 

Outlook Express sẽ giúp giao tiếp với Email Server để 

chuyển-nhận Email với  một số tính năng quản lý rất tiện 

dụng. Khởi động Outlook Express từ mục All Programs→ 

Outlook Express. 

Để sử dụng email với Oulook, đầu tiên chúng ta phải khai báo tài khoản email cho 

Outlook. Từ menu Info, chọn Add Account.  

Sau đó nhập thông tin email 

Thanh công cụ: 

- New E-Mail: Soạn Email mới.  

- Reply: trả lời Email đang mở 

cho người gởi.  

- Forward: Gởi Email nhận được 

cho những người khác.  

 

 

 
 

 

3.7. Dịch vụ Office Online 

Phần mềm online là các phần mềm thực thi tại các máy chủ, và trả về kết quả cho 

người dùng cuối. Office Online là một trong các phần mềm online được cung cấp miễn phí, 

cho phép nhiều người dùng đồng thời soạn thảo một văn bảng, bảng tính, file trình diễn 

online, đồ họa.. và chia sẻ cho những người khác với khả năng phân quyền giúp bảo vệ 

thông tin được tòa vẹn. Office Online ngày càng tiện dụng và mạnh mẽ khi công nghệ điện 

toán đám mây được các hãng lớn đầu tư phát triển trong các năm gần đây. Có nhiều hãng 

cung cấp Office Online như Mirosoft với dịch vụ Officelive, Google với Google Docs & 

Spreadsheets, ThinkFree Online và Zoho Office Suite … Trong tài liệu này chỉ đề cập đến 

dịch vụ của Google, là Google Docs (soạn thảo văn bản -) & Spreadsheets (bảng tính) ở địa 

chỉ https://docs.google.com. Bạn phải có tài khoản gmail để đăng nhập và sử dụng dịch vụ 

miễn phí này.  

https://docs.google.com/
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Sau khi đăng nhập, từ màn hình chính của googledoc, chọn Create new, và chọn tiếp 

Document (nếu soạn văn bản), Presentation (nếu soạn thảo trình diễn), Spreadsheet (nếu 

soạn thảo bảng tính)… 

 

Màn hình soạn thảo của googledoc với chức năng giống như với bản Office thông 

thường, do đó cách sử dụng hầu như tương tự, học viên tự tìm hiểu.  

Sau khi soạn thảo xong, người dùng có thể download file về máy mình bằng cách sử 

dụng menu File – Download as. Hoặc có thể chia sẻ tài liệu này cho nhiều người xác xem 

hay đồng soạn thảo bằng cách bấm nút Share và phân quyền. 
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3.8. Dịch vụ chia sẽ thông tin trực tuyến 

Với sự phát triển của máy chụp ảnh số, điện thoại chụp ảnh, ngày nay hầu như người 

nào cũng có thể chụp được ảnh mọi lúc mọi nơi. Các ảnh số này có thể được upload lên 

internet, quản lý theo ngày tháng, nơi chụp, và chia sẻ cho nhiều người hoặc chỉ đơn giản là 

nơi lưu ảnh an toàn cho chính mình. Nhiều dịch vụ cung cấp chức năng lưu ảnh miễn phí, 

nhưng thông dụng nhất là dịch vụ Web Picasa của google hỗ trợ tiếng Việt và hệ thống bản 

đồ quốc tế. Dĩ nhiên là bạn phải có tài khoản của google.  

Truy xuất vào trang  https://picasaweb.google.com, chọn nút Tải lên, nhập thông tin 

về album hình, sau đó tiến hành upload hình. Với giao diện tiếng Việt thân thiện, học viên tự 

tìm hiểu và sử dụng chức năng quản lý – xem ảnh.  

 

3.9. Dịch vụ Online Calendar 

Ngày nay, tốc độ công nghiệp yêu cầu chúng ta 

phải sắp xếp và bố trí lịch biểu, nghi nhớ các ngày lễ, sự 

kiện quan trọng, nhắc nhở các công việc cần làm…. 

Thông thường người ta hay sử dụng PDA (máy trợ giúp 

cá nhân như Palm) hay các dòng smart phone như Iphone, 

Windows phone, Adroid phone..). Tuy nhiên, dịch vụ lịch 

trực tuyến là không thể thiếu vì nó đồng bộ lịch với PAD, 

Smartphone, giúp người dùng soạn thảo, xem lịch mọi lúc 

mọi nơi. Nếu bạn đang sử dụng smartphone thì không thể 

bỏ qua dịch vụ này, và đừng quên đồng bộ cả danh bạ 

điện thoại để không bao giờ bị mất danh bạ ngay cả khi bị mất điện thoại.   

Tài liệu này chỉ đề cập đến dịch vụ Calendar của Google. Đăng nhập vào tài khoản 

gmail từ trang https://www.google.com/calendar 

Bạn có thể xem lịch theo ngày, tuần, tháng. Để them sự kiện cho lịch, click  nút Tạo 

sự kiện, sau đó nhập thông tin cho sự kiện: tiêu đề, địa điểm, thời gian, mô tả, lời nhắc… 

Với giao diện tiếng Việt thân thiện, học viên tự tìm hiểu và sử dụng chức năng quản lý lịch 

online. 

https://picasaweb.google.com/
https://www.google.com/calendar
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3.10. Google Form 
Bất cứ doanh nghiệp nào cũng cần 

những ý kiến của khách hàng để hoạt 

động và có hướng kinh doanh tốt hơn. Để 

có thể khảo sát và lấy ý kiến của người 

dùng thông qua các phiếu khảo sát thì rất 

khó khăn và tốn kém về mặt thời gian và 

tiền bạc. Với sự phát triển mạnh mẽ của 

công nghệ thông tin hiện nay, Google,Microsoft và rất nhiều hãng phần mềm khác đã đưa 

đến cho doanh nghiệp một công cụ hết sức tiện dụng và tiết kiệm thời gian, tiền bạc nhưng 

lại mang lại hiệu quả cao cho công việc khảo sát hay lấy ý kiến từ khách hàng. Với Google 

Form (Microsoft hay các hãng khác tương tự) thì chỉ vài lần click chuột bạn đã tạo ra được 

một bản khảo sát Online nhanh chóng, tiện dụng và khoa học gửi đến khách hàng.  
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 Tạo một Google Form 

Để tạo một Google Form thì bạn cần phải có tài khoản google (Gmail) – nếu chưa có 

bạn có thể tạo mới hoàn toàn miễn phí.  

Khi đã có tài khoản Google, bạn truy cập vào trang drive.google.com và đăng nhập với 

thông tin tài khoản của mình. 

Chọn mục “Tạo / Mẫu” như hình bên dưới để tiến hành tạo Google Form: 

 

➢ Thiết kế bản khảo sát Online của bạn 

Trước khi thiết kế giao diện cho form của mình. Bạn cần lưu ý một số tùy chọn sau cho 

Form của mình : 

 

 

• Yêu cầu đăng nhập (ĐH Công Nghệ Đồng Nai) để xem biểu mẫu này: Người nhận sẽ 

được yêu cầu đăng nhập tài khoản Google doanh nghiệp/tổ chức của bạn để trả lời 

form.(Bạn phải sử dụng tài khoản của doanh nghiệp/tổ chức của mình để tạo form) -> 

Chỉ khảo sát trong nội bộ. 

Tạo một thư mục Online giúp bạn phân 

loại, quản lý dữ liệu tốt hơn 

Tạo một tài liệu văn bản (doc) 

Tạo một tài liệu trình chiếu 

(Power Point) 

Tạo một bảng tính Excel 

Tạo một bản khảo sát / đăng ký 

Online 
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• Tự động thu thập tên người dùng (ĐH Công Nghệ Đồng Nai) của người dùng: Google 

sẽ thu thập tên người trả lời form theo tổ chức của bạn. 

• Hiển thị thanh tiến trình ở cuối trang biểu mẫu: Hiển thị % người trả lời đã hoàn thành 

form. 

• Chỉ cho phép một phản hồi mỗi người (yêu cầu đăng nhập): chỉ cho phép người trả lời 

gửi form 1 lần – Google sẽ bắt buộc người trả lời đăng nhập (tài khoản google) trước 

khi trả lời form. 

• Xáo trật tự câu hỏi: Câu hỏi sẽ đảo lộn ngẫu nhiên không theo trật tự bạn thiết kế 

form. 

Giao diện chính của màn hình thiết kế Google Form: 

 

 

 

 

Google Form cung cấp cho bạn nhiều loại câu trả lời để giúp bạn khảo sát dễ dàng 

hơn: văn bản, văn bản của đoạn văn (đoạn văn bản), nhiều lựa chọn, hộp kiểm, chọn từ danh 

sách, ngày……. 
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• Văn bản: Cho phép người trả lời nhập vào 1 đoạn văn bản ngắn (ví dụ: họ tên, mssv, 

lớp,….) 

 

• Văn bản của đoạn: Cho phép nhập vào 1 đoạn văn bản (ví dụ: phản hồi của khách 

hàng về sản phẩm….) – bên cạnh dó bạn còn có thể thiết lập số ký tự tối thiểu (tối đa) 

cho câu trả lời thông qua phần xác thực dữ liệu. 
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• Nhiều lựa chọn: Cho phép đưa ra nhiều lựa chọn trong Form (người dùng chỉ được 

chọn duy nhất 1 giá trị ) (Radio button) 

 

• Hộp kiểm: tương tự như radio button, nhưng người dùng có  thể chọn nhiều giá trị 

đồng thời. (Check box) 

 

• Chọn từ danh sách: tương tự như radio button, chỉ khác ở phần giao diện hiển thị 

(người dùng bấm vào mũi tên sẽ hiển thị một danh sách để lựa chọn) (Combo box) 
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Trên đây là các công cụ cơ bản, học viên tự tìm hiểu thêm một số công cụ còn lại. 

 Hoàn thành Google form và chia sẻ: 

➢ Xem lại Form trước khi gửi 

Sau khi thiết kế giao diện form xong, để xem form (ở giao diện người dùng) như thế 

nào, đã hợp lý chưa thì google cung cấp cho người tạo form chức năng xem biểu mẫu trực 

tiếp. 

Từ thanh công cụ bạn chọn “xem biểu mẫu trực tiếp” như hình: 

 

Google Form sẽ hiển thị ở giao diện người dùng cho bạn xem thử : 
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➢ Hoàn tất và chia sẻ Google Form 

Sau khi thiết kế giao diện cho form xong, bạn có thể chọn các tùy chọn (nếu muốn) 

sau đó bấm bấm gửi biểu mẫu để kết thúc quá trình tạo Form. 

 

 

Gửi Form khảo sát cho người dùng/ khách hàng…. 
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➢ Xem câu trả lời 

Sau khi người dùng/ khách hàng trả lời khảo sát xong, Google sẽ tự động lưu lại 

thành một file Excel cho bạn dễ dàng quản lý.  

Từ giao diện thiết kế form, bạn có thể chọn xem câu trả lời trực tiếp : 

 

Hoặc vào Google Drive của bạn mở  file (Excel) thống kê câu trả lời của Form tương ứng: 

Gửi link trực tiếp 

Chia sẻ lên mạng xã hội 

Gửi qua Email 

Kết thúc quá trình tạo Form 
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Giao diện thống kê câu trả lời khảo sát: 

 

 

 

4. AN TOÀN THÔNG TIN 
Phần này sẽ trình bảy cách bảo vệ máy tính, chẳng hạn như: Thiết lập mật khẩu cho 

máy tính, mã hóa dữ liệu bằng Bitlocker, cách nén tập tin với mật khẩu và cuối cùng là virus 

máy tính. 

➢ Thiết lập mật khẩu cho máy tính 

Việc thiết lập mật khẩu cho máy tính là vô cùng quan trọng, nó bảo vệ dữ liệu cá nhân 

của người sử dụng, đặc biệt là những dữ liệu nhạy cảm. 
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Có rất nhiều cách để mở màn hình thiết lập mật khẩu cho máy tính, cách nhanh nhất 

là trong hộp tìm kiếm (Windows + Q) ta gõ từ user, chương trình sẽ hiển thị User account 

cho phép ta mở màn hình quản lý tài khoản: 

 

Chọn User Accounts ở trên để mở màn hình quản lý tài khoản. 

Nhấn chọn “Create a password for your account”: 

 

 

 

Màn hình thiết lập mật khẩu sẽ xuất hiện: 
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- New password: Nhập mật khẩu (nên nhập mật khẩu kết hợp các ký tự, số, ký hiệu) để 

tăng độ mạnh cho mật khẩu. 

- Confirm new password: Nhập lại mật khẩu (nhập giống như mục New password). 

- Bấm Create Password để thiết lập mật khẩu. Sau khi thiết lập xong thì ta có thể đổi 

mật khẩu (Change your password), xóa mật khẩu (Remove your password). 

 

 

Đối với máy tính sử dụng tài khoản Microsoft: 

 Đối với những người sử dụng windows 8/8.1 thì sẽ có một hệ thống Store dành riêng 

cho windows (tương tự với Windows Phone). Thông qua store người dùng có thể cài các ứng 

dụng chạy ở dạng Metro ( Windows Mail, Game,…). Để vào được store thì máy tính của bạn 

bắt buộc phải sử dụng tài khoản Microsoft. Bài hướng dẫn sau sẽ giúp bạn : 

 Tương tự như trên,  ta Search “user” và chọn “Add,delete, and manage other user 

accounts” 
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 Trong phần Other accounts -> chọn Add an account : 

 

 Nhập tài khoản Microsoft của bạn vào khung: 
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 Sau khi nhập hệ thống sẽ yêu cầu Password. Điền mật khẩu tài khoản Microsoft của 

bạn vào và kết thúc. Lúc này máy tính của bạn đã có thể truy cập Store và tận hưởng những 

ứng dụng dành riêng cho Windows 8/8.1. 

 

➢ Mã hóa dữ liệu bằng Bitlocker 

Chức năng này rất quan trọng hữu ích giúp người sử dụng bảo vệ được dữ liệu, kể cả 

dữ liệu được lưu trữ trong USB khi không may bị mất. Cụ thể ta sẽ đề cập tới 3 vấn đề sau: 

✓ Kích hoạt tính năng Bitlocker 

✓ Hiệu chỉnh thông tin Bitlocker 

✓ Phục hồi mật khẩu  

✓ Ngừng kích hoạt tính năng Bitlocker 

Ta bắt đầu thực hiện Bitlocker: 

✓ Kích hoạt tính năng Bitlocker 

 

Bấm chuột phải vào USB/chọn Turn on BitLocker…Màn hình Starting BitLoker xuất hiện: 

 

Đợi một thời gian ngắn, màn hình chọn kiểu mã hóa sẽ xuất hiện: 
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Chọn Use a password to unlock the drive, nhập mật khẩu rồi bấm Next. 

Màn hình chọn tập tin phục hồi sẽ xuất hiện như bến dưới: 

 

 

Chọn Save the recovery key to a file, lưu vào một ổ đĩa cứng nào đó (chú ý là lưu trong thư 

mục nào đó của ổ cứng, không lưu ở ngoài): 

 

 

Ta có thể xem nội dung của tập tin khôi phục này (chú ý Bitlocker Recovery Key): 
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Tiếp tục bấm nút Next, màn hình Start Encrypting xuất hiện: 

 

 

Bấm nút Start Encrypting để bắt đầu mã hóa, tùy vào tốc độ xử lý của mỗi máy tính mà 

thời gian chờ sẽ lâu hay mau: 

 

Chờ cho tới khi quá trình mã hóa kết thúc: 
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Bấm Close để đóng màn hình thông báo này, quan sát ổ USB sau khi mã hóa: 

 

 

 

Như vậy đã mã hóa thành công, từ đây khi USB được gắn vào các máy tính thì hệ thống sẽ 

yêu cầu nhập mật khẩu: 

Q  

Nhập mật khẩu xong, bấm nút Unlock để giải mã. 
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Nếu ta không nhập mật khẩu và cố gắng truy xuất vào USB thì sẽ nhận được thông báo: 

 

 

✓ Hiệu chỉnh thông tin Bitlocker 

Để hiệu chỉnh được thông tin Bitlocker cho USB đã bị mã hóa thì ta phải nhập mật 

khẩu giải mã trước, sau đó bấm chuột phải vào USB rồi chọn Manage Bitlocker: 

 

Màn hình hiệu chỉnh thông tin sẽ xuất hiện như bên dưới: 

 

Ta chỉ cần quan tâm tới hai chức năng sau: 

- Change password to unlock the drive: Hiển thị màn hình đổi mật khẩu. 
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- Nhập mật khẩu mới cần thay đổi rồi bấm nút Next, sau khi đổi mật khẩu thành công, 

màn hình dưới đây sẽ xuất hiện: 

 

 Remove password from this drive: Xóa mật khẩu. 

✓ Phục hồi mật khẩu 

Đôi khi ta quên mật khẩu giải nén, để phục hồi lại thì ta sẽ lấy khóa được lưu 

trong tập tin mà lúc đầu ta tiến hành mã hóa (xem lại phần trước): 

 

Tại màn hình yêu cầu nhập mật khẩu, ta chọn I forgot my password, màn hình 

Unlock this drive using your recovery key xuất hiện: 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 226 

 

Trong màn hình này, ta chọn Type the recovery key để hiển thị màn hình nhập 

mã phục hồi mật khẩu xuất hiện, tại màn hình này ta sao chép “BitLocker Recovery Key:” ở 

trong tập tin bên trên vào đây rồi bấm nút Next: 

 

Tập tin có chứa mã phục hồi, ta chép BitLocker Recovery Key ở dòng bôi đen 

bên dưới vào ô Enter your Recovery key ở màn hình trên (mã này sẽ khác nhau ứng với mỗi 

thiết bị phần cứng khác nhau). 

 

Khi màn hình You now have temporary access to this drive dưới đây xuất hiện 

tức là ta đã giải mã thành công. 
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✓ Ngưng kích hoạt tính năng Bitlocker 

Để ngưng tính năng Bitlocker, ta mở màn hình Manage BitLocker như màn hình bên dưới: 

 

Nhập manage bit, hoặc bitlocker vào ô tìm kiếm, hệ thống sẽ hiển thị Manage 

BitLocker cho phép ta chọn lựa. 
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Tại màn hình này ta chọn Turn Off BitLocker 

 

 

 

Sau đó bấm chọn Decrypt Drive để tiến hành ngưng kích hoạt BitLocker: 

 

 

Tùy tốc độ xử lý mà thời gian ngưng kích hoạt sẽ lâu hay mau. 

 

Quá trình ngưng kích hoạt đã thành công. 

 

➢ Nén tập tin với mật khẩu 

Việc nén tập tin là một tiện ích sử dụng mà Microsoft Windows đã cung cấp sẵn 

giúp giảm dung lượng tập tin hay thư mục (Winzip), ta chỉ cấn bấm chuột phải vào tập tin 

hay thư mục rồi chọn Send to / Compressed (zipped) folder: 
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Trước khi nén thì thư mục này có dung lượng là 90MB, sau khi nén chỉ còn 35MB. 

 

Tuy nhiên, hiện nay trong tất cả các máy tính đều được cài đặt thêm phần mềm 

Winrar (vì nó rất thông dụng). Phần mềm này cho phép nén tập tin mạnh hơn Winzip có sẵn 

của Microsoft, và nó cho phép chúng ta thiết lập mật khẩu khi nén. 

Bấm chuột phải vào thư mục (tập tin)/chọn Add to archive: 

 

 

Màn hình nén xuất hiện như bên dưới: 
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Để thiết lập mật khẩu, ta vào tab Advanced: 

 

 

Chọn nút Set password… 

 

Nhập mật khẩu rồi nhấn ok, chờ chương trình nén xong ta sẽ có tập tin đuối là .rar: 
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Ta thấy đó, Winrar giúp tập tin nén có dung lượng nhỏ hơn Winzip (chỉ còn 

27MB). 

Để giải nén, ta bấm chuột phải vào tập tin nén rồi chọn Extract …. Nếu tập tin nén 

nào có mật khẩu thì chương trình sẽ yêu cầu ta nhập mật khẩu, còn không có mật khẩu thì 

chương trình sẽ giải nén luôn. 

 

➢ Virus máy tính 

Việc bảo vệ dữ liệu là vấn đề mà tất cả các người sử dụng máy tính phải quan tâm, 

bao gồm việc mất mát dữ liệu hay bị lộ dữ liệu. Các tác nhân có thể gây hại đến dữ liệu như 

sau: phần cứng máy tính hỏng, đặt biệt là đĩa hỏng do tuổi thọ của đĩa cứng chỉ vài năm tùy 

theo mật độ sử dụng, hỏa hoạn, thiên tai, virus, sự phá hoại của các tin tặc, sự  vô ý của 

người dùng…  

Tùy thuộc vào tầm quan trọng của dữ liệu mà ta sẽ áp dụng những cách bảo vệ khác 

nhau. Đối với những dữ liệu thông thường thì cách bảo vệ hữu hiệu nhất là thường xuyên tạo 

ra các bản sao (backup) của dữ liệu lưu trên đĩa USB, CD-ROM, lưu lên internet, lưu vào 

email…. Lưu ý là các bản sao này phải được lưu bên ngoài máy tính. 

Việc backup thường xuyên giúp không mất dữ liệu, tuy nhiên chúng ta cần phải quan 

tâm đến việc lộ thông tin, như tài khoản ngân hàng, tài khoản đăng nhập máy tính hay phần 
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mềm, tài khoản email…. Kẻ gian sẽ dùng nhiều cách để đánh cắp thông tin, và một trong các 

cách hữu hiệu nhất để chống lại là sử dụng phần mềm diệt Virus.  

Virus tin học (hay còn gọi virus máy tính) là các chương trình đặc biệt do con người 

tạo ra, chạy ẩn, tự lây lan bằng cách nhân bản. Khi máy tính bị nhiễm Virus thì có thể có 

những biểu hiện bất thường như khởi động chậm, thực thi chậm, không in được văn bản ra 

máy in... nhưng hiện nay các loại virus không gây biểu hiện khác thường. Virus có thể làm 

hỏng hệ điều hành, hỏng các phần mềm, phá hủy dữ liệu hay đánh cắp thông tin, password 

của bạn… 

Để chống virus, chúng ta cần sử dụng các chương trình diệt virus mạnh mẽ nhất, 

không nên cài đồng thời nhiều chương trình diệt virus đồng thời. Ở thời điểm hiện tại, một 

số phần mềm diệt Virus mạnh được sử dụng trên khắp thế giới, nhóm có phí như: Norton 

AntiVirus, Kaspersky, BitDefender, ESET NOD32, Trend Micro Antivirus, Avira Antivir, 

McAfree, Avast, …. Nhóm miễn phí như Panda Cloud Antivirus, AVG  Antivirus, 

FortiClient, Avira Antivir Free Edition, BitDefender antivirus free edition, Avast antivirus 

free edition cũng cung cấp rất tốt khả năng tìm và diệt tuy thiếu nhiều tính năng hơn so với 

bản có phí. Đặt biệt phần mềm Microsoft Security Essentials miễn phí của Micorosft được 

đánh giá rất cao, hơn hẳn một số phần mềm diệt Virus có phí khác vì tốc độ cao, máy tính 

chạy nhẹ nhàng, và diệt nhiều chủng loại Virus, khả năng cập nhật Virus mới thông minh và 

tiện lợi. 

Tuy có phần mềm AntiVirus trợ giúp, nhưng kiến thức của sử dụng là rất quan trọng 

khi bảo vệ dữ liệu. Chúng ta không nên thực thi các chương trình không rõ nguồn gốc, 

không mở các tài liệu không rõ nguồn gốc, luôn quét đĩa USB hay CDROM trước khi sử 

dụng, thường xuyên cập nhật chương trình antivirus, không mở các email lạ, không chat với 

người lạ hay click vào đường link Internet mà người khác gởi, không truy xuất các website 

có nội dung không lành mạnh hay website được cảnh báo nguy hiểm vì các website này 

thường ẩn chứa mã độc gây hại cho máy tính. 
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PHẦN WINWORD 

BÀI TẬP WINWORD 1 

(Sử dụng: Template, Column, WortArt, Picture) 

 

húng ta có lẽ ai cũng 

biết tiếng tăm của nhà 

tỷ phú nổi tiếng thế giới của 

Bill Gate và thành công  của 

công ty Microsoft. Một 

trong những bí quyết của sự 

thành công đó là ông rất 

quan tâm đến môi trường 

làm 

việc. 

Thung 

lũng 

Silicon - 

nơi công ty Microsoft toạ 

lạc là một quần thể bao gồm 

tất cả những tiện nghi hiện 

đại nhất phục vụ cho cuộc 

sống, từ việc trang trí những 

căn phòng làm việc và 

phòng ở cũng được sự tham 

gia thiết kế của những 

chuyên gia tâm lý, đến những 

phương tiện phục vụ cho việc 

giải trí được hết sức chú 

trọng. Và đặc biệt là cách cư 

xử, quan tâm đến khả năng 

và cá tính của từng con 

người. 

ó thể nói rằng Bill 

Gate không chỉ là 

chuyên gia về công 

nghệ thông tin mà 

còn là chuyên gia về 

tâm lý học, những tác động 

về mặt tinh thần đã tạo 

những điều kiện thuận lợi 

nhất cho sự sáng tạo của 

nhân viên và đã tạo nên hiệu 

quả vật chất khổng lồ. 

C 

C 

• • • 

Năm 1968, ở tuổi 13 Bill 

Gates bắt đầu làm quen 

với thế giới tin học. Đó 

là thời kỳ của những máy 

tính thế hệ thứ ba với 

mạch tích hợp bán dẫn, 

với hệ điều hành đa 

chương trình, đa xử lý 

mạnh mẽ và mềm dẻo, 

các ngôn ngữ bậc cao 

ALGOL, FORTRAN, 

COBOL,… Với bộ đồ 

Jeans và đôi giày thể 

thao dân dã, cậu bé học 

trò Bill đã chứng tỏ rằng 

không nhất thiết phải 

mặc complet thì mới có 

   

 

 Microsoft 
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BÀI TẬP WINWORD 2 

( Nội dung: Column, WordArt, AutoText, Picture, Comment,DropCap) 

Yêu cầu:  

1. Tạo AutoText để thay thế từ “thời gian “ bằng “tg”  . 

2. Nhập văn bản và thực hiện định dạng theo yêu cầu. 

3. Tạo Comment để ghi chú lại những vị trí đã được định dạng.  (Tại vị trí đó đã sử dụng 

chức năng gì.) 

 

 

 first step every day 

should be to draw up a 

time-table for everything 

you want to do that day. Write out 

everything you want to accomplish, and 

make estimates on how long it’s going to 

take you to finish each step. 

  

Start your day with your most important 

job. If you do that first, you’ll feel better for 

the rest of the day, knowing you don’t have 

to worry about it anymore. And plus, your 

mind is freshest in the morning; it’s a good 

idea to take advantage of that. 

 End your day with something fun. Maybe 

watch a movie, or play a video game, or 

read a fiction book you enjoy. 

  

In the middle of your day you put in the 

rest of the things you want to do. Don’t 

forget to work in time for rest, time for 

meals, and possibly time for a nap in the 

middle of your day. The key is to not waste 

time on things that don’t matter. Make the 

best possible use of your time.  

ước đầu tiên bạn cần thực hiện mỗi 

ngày là lập một thời gian biểu mọi 

việc bạn muốn làm trong ngày đó. Hãy viết 

ra những thứ bạn muốn hoàn thành, và ước 

lượng mất bao lâu để hoàn thành mỗi việc. 

  

Bạn hãy bắt đầu một ngày bằng công 

việc quan trọng nhất của mình. Nếu bạn 

làm nó trước nhất, bạn sẽ cảm thấy thoải 

mái hơn suốt quãng thời gian còn lại trong 

ngày, vì biết rằng mình chẳng cần phải lo 

lắng về công việc ấy nữa. Ngoài ra, đầu óc 

bạn sảng khoái nhất là vào buổi sáng; thật 

sáng suốt nếu tận dụng được điều này. 

  

Hãy kết thúc một ngày bằng việc gì đó 

vui vẻ. Có thể là xem một bộ phim, hay 

chơi trò chơi điện tử, hoặc đọc một cuốn 

tiểu thuyết bạn thích. 

  

Giữa ngày bạn làm những việc còn lại 

mà mình muốn làm. Đừng quên làm việc 

đúng giờ để có thời gian nghỉ ngơi, thời 

gian dùng bữa, và có thể là khoảng thời 

gian chợp mắt ban trưa. Điểm then chốt là 

không lãng phí thời gian vào những việc 

không quan trọng. Hãy sử dụng hiệu quả 

nhất có thể thời gian của bạn. 

Your B 
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BÀI TẬP WINWORD 3 

( Nội dung: Column, WordArt, DropCap, Picture ) 

hững người biết sử dụng vi tính đều 

biết tổ hợp 3 phím Ctrl-Alt-Del có tác 

dụng khởi động lại máy tính. Trong cuộc 

sống vẫn có 3 phím quý 

báu ấy: 

 Control: hãy biết 

điều khiển suy nghĩ, 

hành động của bạn ở mọi trường hợp để 

không phải hối hận vì những gì bạn đã gây 

ra. 

 Alternate: phải biết luân phiên giữa tiếng 

cười và nước mắt. Cuộc sống không phải 

lúc nào cũng suôn sẻ, nhưng bạn phải nhớ 

rằng “sau cơn mưa trời lại sáng”. 

 Delete: hãy xóa bỏ những ý nghĩa tiêu 

cực, những định kiến hẹp hòi và tất cả 

những gì ngăn cản bạn làm việc cùng mọi 

người. Nhiệt tình và hợp tác sẽ là chìa 

khóa đưa bạn đến thành công. 

 

 

ếu bạn đã quen với việc biên tập 

ảnh với ứng dụng Paint của 

Windows và muốn đặt chương 

trình này làm trình 

biên tập ảnh mặc 

định, bạn có thể làm 

theo các bước hướng 

dẫn sau đây. Đầu tiên, 

bạn mở thư mục chứa 

các file ảnh bạn cần biên tập với Paint. 

Sau đó, bạn nhấp phải chuột vào một tấm 

ảnh bất kỳ, tìm đến tùy chọn Open with rồi 

chọn Choose a default program ở menu 

hiện ra. 

Sau cùng, 

bạn 

chọn Pai

nt ở hộp 

thoại Ho

w do you want to open this file. 

N 

N 
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BÀI TẬP WINWORD 4 

(Nội dung: Table, Tab trong Table) 

 

Các phím Chức năng Các phím Chức năng 

Tab Đến ô kế tiếp Shift- Tab Đến ô trước đó 

 Tiến tới 1 kí tự  Lùi về 1 kí tự 

 Lên hàng trên  Xuống hàng dưới 

Enter Chèn 1 paragraph mới Ctrl - Tab Chèn Tab 

THÔNG TIN CÁ NHÂN 

Họ và tên: Đa i 

Tha ng 

Email: 

dthang@gmail.com 
ĐT NR:7658266 ĐTDD:091234578 

Giơ i tí nh : 

 Nam  Nư     

Nga y sinh: ............................  

Nơi sinh : ..............................  

CMND so  : ..............................................................  

Nga y ca p : .......................  Nơi ca p : ....................  

Đi a chí  lie n la c : ...............................................................................................................................................................  

 ...............................................................................................................................................................................................  

Ba n co  ngươ i quen hie  n đang la m vie  c ta i  Co ng ty ABC kho ng?  

     Co     Kho ng    

Ne u co , vui lo ng cho bie t te n, chư c vu , pho ng ban co ng ta c : .....................................................................  

 ...............................................................................................................................................................................................  

 

 

 

STT Thiết bị Giá VNĐ Giá USD 

 Chuột ..........................................................................................  100 5 

 Ổ cứng .......................................................................................  5000 100 

 Board mạch chủ ....................................................................  8050 200 

 Màn hình ..................................................................................  7500 150 

Tổng cộng 20650 455 

 

 

BÀI TẬP WINWORD 5 
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(Nội dung: Picture, tab, symbol, bullets and numbering) 

THÔNG TIN CÁ NHÂN 

 

Họ và tên: ....................................................................................................  

Ngày sinh: ....................................................................................................  

Giới tính: ......................................................................................................  

Địa chỉ: ........................................................................................................  

Địa chỉ email: ..............................................................................................  

Điện thoại liên lạc: .......................................................................................  

MỤC TIÊU 

➢ Hiện tại: Trở thành nhân viên Marketing …. 

➢ Tương lai: Sẽ cố gắng hết mình để trở thành quản lý nhãn hàng trong 5 năm tới. 

HỌC VẤN 

2005-2009 Cử nhân Marketing – xếp loại học lực khá… 

(Liệt kê). (Liệt kê). 

CÁC KỸ NĂNG 

➢ KỸ NĂNG CỨNG: 

✓ Kỹ năng Tiếng Anh: (Liệt kê). 

✓ Kỹ năng Vi Tính: (Liệt kê). 

✓ Có kiến thức và kinh nghiệm trong nghiên cứu Marketing và tổ chức sự kiện tốt. 

➢ KỸ NĂNG MỀM: 

✓ Có khả năng thích nghi với môi trường làm việc nhanh chóng. 

✓ (Liệt kê thêm nếu có). 

KINH NGHIỆM LÀM VIỆC 

VỊ TRÍ TRÁCH NHIỆM 

✓ Tiếp thị 

Công ty Vinamilk 

✓ (Liệt kê trách nhiệm). 

✓ Nhân viên Sales 

Công ty TNHH Pataya, VN 

✓ (Liệt kê trách nhiệm). 

SỞ THÍCH 

✓ (Liệt kê ở đây). 

NGƯỜI THAM KHẢO 

✓ (Liệt kê ở đây). 

BÀI TẬP WINWORD 6 

( Nội dung: Shape, TextBox, Equation ) 
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Yêu cầu: Soạn thảo các công thức toán học: 

2

2

1 1
(1 tan ( )) tan( )

cos ( )
dx ax b dx ax b C

ax b a
= + + = + +

+ 
 

 

 

 

  

[
∝ <  𝒙𝟏 < 𝒙𝟐

𝒙𝟏 < 𝒙𝟐 <∝     {
∆ > 𝟎

𝒂𝒇(∝) > 𝟎
 

1/.
( ) ( )( ) ( ) ( )

nk k nf x x , f x k k 1 ... k n 1 x (n k)-= = - - + £
 

2/ 
( ) ( )( )

nx xf x e , f x e= =
 

3/ 
( ) ( )( ) ( ) ( )( ) ( )

k k2k 2k 1
f x sin x, f x 1 sin x ; f x 1 cos x

+
= = - = -

 

4/ 
( ) ( )( ) ( ) ( )( ) ( )

k k2k 2k 1
f x cos x, f x 1 cos x ; f x 1 sin x

+
= = - = -

 

5/ 

( ) ( )( ) ( )
( )

nn

n 1

1 n !
f x , f x 1

1 x 1 x
+

= = -
+ +

 

6/ 

( ) ( )( )
( )

n

n 1

1 n !
f x , f x

1 x 1 x
+

= =
- -
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BÀI TẬP WINWORD 7 

( Nội dung: Table, Chart ) 

    Bảng thống kê số lượng "followers" của MU tại 1 số quốc gia trên TG: 

Quốc gia Dân số ( Triệu ) 
Số followers của MU 

( Triệu ) 
% Dân số 

Việt Nam 89 25 28.1% 

Nga 143 18 12.6% 

Ấn Độ 1.258 35 2.8% 

Trung Quốc 1.353 108 8% 

Indonesia 244 55 22.5% 

Thái Lan 69 20 229% 

Nigeria 170 35 20.6% 

Hàn Quốc 49 15 30.6% 

Mexico 112 25 22.3% 

Yêu cầu: 

1. Sắp xếp bảng thống kê tăng dần theo Số followers của MU, nếu trùng thì sắp giảm dần 

theo Quốc gia. 

2. Vẽ biểu đồ cho bảng thống kê. 
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Biểu đồ số lượng fan MU theo các quốc gia
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BÀI TẬP WINWORD 8 

( Nội dung: Chart ) 

Bảng thống kê lượng căn hộ được chào bán tại chung cư XYZ. 

Yêu cầu: 

Vẽ biểu đồ cho bảng thống kê. 

 

 

0

2000

4000

6000

8000

10000

12000

14000

Hạng sang và cao cấp Trung bình Bình dân

2009

2010

2011

2012

0 2000 4000 6000 8000 10000 12000 14000

2010

2011

2012

Số lượng

N
ă

m

2010 2011 2012

Bình dân 4883 12860 9546

Trung bình 4898 3074 12778

Hạng sang và cao cấp 2242 4884 13847

 2009 2010 2011 2012 

Hạng sang và cao cấp 4000 2242 4884 13847 

Trung bình 2886 4898 3074 12778 

Bình dân 2808 4883 12860 9546 
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BÀI TẬP WINWORD 9 

(Nội dụng: WordArt, TextBox, Link Text Box,..) 

Đoạn 1: Tạo một file Doan_1.docx  chứa nội dung bên dưới: 

Tất nhiên, làm giàu ai chẳng mơ ước, ai chẳng muốn được đi trên một con 

xe siêu sang nào đó, được sống trong một biệt thự gần hồ, có các em chân dài vây 

quanh? Thực tế cuộc sống không như những gì mình mong ước. Tôi thấy phần lớn 

các cuốn sách dạy làm giàu đều có nguồn gốc từ ngoài châu Á, những doanh nhân 

nổi tiếng được đề cập đến hầu hết đều là những người châu Âu hoặc Mỹ. Xin mạn 

phép đưa ra ý kiến là nó không phù hợp với châu Á, nhất là Việt Nam. 

Các bạn học làm giàu làm gì khi con người chưa hoàn thiện về mặt đạo 

đức, lý trí, hay bản lĩnh, khi các bạn vẫn về nhà cãi 

bố mẹ? Các bạn vẫn chẳng có bản lĩnh khi ra đời, 

chẳng có cái gì khiến bố mẹ yên tâm về mình. Vậy 

các bạn làm ra tiền để làm gì? Đây là Việt Nam, 

không phải Mỹ, không phải nơi khi bố mẹ về già các 

bạn đẩy được vào trại dưỡng lão. Là một đứa con, 

bạn sinh ra không phải đến 18 tuổi có thể tự do đẩy 

nó ra đường để cọ xát. Các bạn làm ra tiền, nhưng không biết cách sử dụng đồng 

tiền thì cũng vứt đi. Cách sử dụng đồng tiền như thế nào đó lại hoàn toàn phụ thuộc 

vào đạo đức và cách đối nhân xử thế của bạn. 

Đoạn 2: Tạo một file Doan_2.docx chứa nội dung: ( sử dụng Link giữa hai text box 

trong đoạn 2 ) 

Đây là Việt Nam, không phải Mỹ, 

không phải nơi khi bố mẹ về già các bạn 

đẩy được vào trại dưỡng lão. Là một đứa 

con, bạn sinh ra không phải đến 18 tuổi có 

Sống ở đời chẳng ai có thể hoàn 

thiện mình 100%, nhưng ít nhất 

phải học cách để sống làm sao cho 
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thể tự do đẩy nó ra đường để cọ xát. Các bạn làm ra tiền, nhưng không biết cách sử 

dụng đồng tiền thì cũng vứt đi. 

Cách sử dụng đồng tiền như thế 

nào đó lại hoàn toàn phụ thuộc vào 

đạo đức và cách đối nhân xử thế 

của bạn. 

Các cụ vẫn nói “Tiên học 

lễ, hậu học văn”, trước tiên hãy học cách làm người trước khi học cách làm cái gì 

đó. Sống ở đời chẳng ai có thể hoàn thiện mình 100%, nhưng ít nhất phải học cách 

để sống làm sao cho vẹn toàn. Cách xử sự hay cách sống, sử dụng đồng tiền của các 

bạn sẽ ảnh hưởng đến con cái, đến cuộc sống sau này. 

Trước khi muốn giàu, các hãy là một con người đúng nghĩa đã.  

Yêu cầu: 

1. Trộn hai đoạn văn trên thành một đoạn hoàn chỉnh, loại bỏ những nội dung dư 

thừa ( giống nhau ) và lưu thành tập tin Kethop.docx . 

2. Sau đó tạo trích dẫn cho đoạn văn : Nhà văn Đỗ Thị Kim Niết – Hội văn học  TP. 

HCM. 

3. Tạo Bookmark cho mỗi đoạn văn sau khi đã kết hợp, và thiết lập Hyperlink với 

những Bookmark vừa tạo. 

4. Tạo Header, Footer theo nội dung văn bản. 

5. Tạo FootNote tại vị trí cuối của đoạn 1, sau khi kết hợp, với nội dung : Việt Nam 

đất nước tôi yêu. 

  

vẹn toàn. Cách xử sự hay cách 

sống, sử dụng đồng tiền của các 

bạn sẽ ảnh hưởng đến con cái, đến 

cuộc sống sau này. 
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BÀI TẬP WINWORD 10 

(Nội dung: Mail Merge) 

1. Tạo DataSource: nguồn dữ liệu chứa trong 1 table lưu tập tin tên DanhSach.docx 

2.  Tạo Main Document: mẫu bảng điểm chứa trong một tập tin mới lấy tên là PhieuDiem.docx.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Yêu cầu:  

1. Thực hiện chức năng mail merge để import dữ liệu vào phiếu thông báo. 

2. Tại vị trí ( 6) Nếu Điểm TB>=5.0 thì “nhận chứng chỉ” ngược lại “phúc khảo điểm 

nếu cần”. 

3. Tạo nhãn thư để gửi phụ huynh. 

BÀI TẬP WINWORD 11 

STT TÊN SV ĐIỂM LÝ THUYẾT 
ĐIỂM THỰC 

HÀNH 
ĐIỂM TB XẾP LOẠI 

1 Nguyễn Văn Mai 8.0 5.0 6.5 Trung Bình 

2 Hoàng Thanh Phương 9.0 8.0 8.5 Giỏi 

3 Trương Thị Thắm 6.0 1.0 3.5 Yếu 

4 Lê Hoàng My 7.0 7.0 7.0 Khá 

5 Nguyễn Hồng Phúc 4 5 4.5 Yếu 

6 Lý Hành Quân 8 9 8.5 Giỏi 

7 Lê Nga 10 10 10.0 Xuất Sắc 

8 Hoàng Long 9 10 9.5 Xuất Sắc 

9 Trần Khánh Du 7 6 6.5 Tb. Khá 

 TRƯỜNG ĐẠI HỌC CÔNG NGHỆ ĐỒG NAI 

 TRUNG TÂM TIN HỌC 

Kính gởi phụ huynh SV:(1) ...................................................................................................  

Điểm Lý Thuyết:(2) ...............................................................................................................  

Điểm Thực Hành: (3) .............................................................................................................  

Điểm Trung Bình: (4) ............................................................................................................  

Xếp Loại; (5) ..........................................................................................................................  

Thứ Tư ngày 5/11 lên (6) .......................................................................................................  

 Tp.HCM ngày….tháng….năm 2014 

 Giám Đốc TTCNTT 

  

 ĐỖ CÔNG THÀNH 



Khoa Hệ thống thông tin – UEL  Tài liệu tham khảo ôn tập môn tin học 

ThS. Trần Duy Thanh (biên soạn)    Trang 245 

(Nội dung: Style & Table of Contents) 

 

Giả sử cần có mục lục sau với nội dung chi tiết của từng mục lục đã có. Thực hiện các 

yêu cầu sau: 

1. Nhập nội dung đã cho, không có định dạng. Vị trí trang của từng mục như  mục lục đã 

cho. 

2. Tạo 3 style có định dạng như dưới đây, đặt tên Level1, Level2, Level3: 

CHƯƠNG 1. NỘI DUNG  → Level1 

1.1. Mục con 1    → Level2 

1.1.1. Mục con 2   → Level3 

3. Gán 3 style đa tạo vào nội dung đã nhập ở câu 1 

4. Tạo bảng mục lục ở trang sau 

5. Cập nhật bảng mục lục: 

✓ Nhấn Ctrl + Enter để thay đổi số trang cho tài liệu →Quan sát bảng mục lục có thay đổi 

không 

✓ Cập nhật bảng mục lục, quan sát kết quả 
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BÀI TẬP WINWORD 12 

(Sử dụng: Form Control) 

Yêu cầu: Tạo Form theo mẫu: 

- Họ tên khách hàng: Text Control 

- Năm sinh: Date Picker Control 

- Nơi sinh: Drop List Control 

- Giới tính: RadioButton ( thuộc nhóm Phai) 

- Sản phẩm thường mua: Check Box Control 
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BÀI TẬP TỔNG HỢP 

(Một số chức năng khác)  

Câu 1: Trình bày nội dung theo mẫu. 

rong cuộc sống luôn có một người bạn có 

thể giải quyết mọi lỗi lầm và hàn gắn mọi 

vết thương. Người bạn đó có trong mỗi 

chúng ta và giúp ta trưởng thành. Vậy có khi 

nào bạn dừng lại và nghĩ về người bạn đó? 

Người bạn có một cái tên rất đẹp, tên người 

bạn đó là THA THỨ. 

Để tôi giới thiệu thêm về người bạn này 

nhé. THA THỨ được sinh ra từ sự thương yêu 

giữa CẢM THÔNG và NHÂN HẬU. Hắn có 

sở thích là được tặng quà cho những người tìm 

đến hắn để vơi đi nỗi bực dọc và tức giận. 

Món quà đó là sự THANH THẢN. 

âu nói ưu thích của hắn là : "có cần tốn thêm 

năng lượng chỉ để bực dọc hay tức giận 

không?". Nếu bạn trả lời với hắn là "không" 

thì mọi chuyện sẽ nhanh chóng giải quyết ổn 

thỏa. 

Câu 2: Tạo bảng 

E
U

R
O

  
 

STT ĐỘI ĐIỂM TRẬN H/S 

1.  ............ Bồ Đào Nha .......................... 6 .............................. 3 .............................. 5/3 

2.  ............ Thổ Nhĩ Kỳ ........................... 6 .............................. 3 .............................. 5/5 

3.  ................CH Sec .............................. 3 .............................. 3 .............................. 4/6 

4.  ............... Thụy Sĩ .............................. 3 .............................. 3 .............................. 3/3 

Câu 3: Insert Clipart, AutoShape, Equation. 

 

 

 

 

Câu 4: Tạo bảng mục lục theo mẫu sau. 

 

T 

C 

𝒆≈ = 𝟏 +
𝒛

𝟏!
+

𝒛𝟐

𝟐!
+

𝒛𝟑

𝟑!
+ ⋯ = ∑

𝒛𝒏

𝒏!

∞

𝒏=𝟎
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BÀI TẬP ÔN TẬP 

Yêu cầu:  

1. Tạo ra một tập tin danh sách gồm các cột: Họ tên, Ngày sinh, Giới tính, Giờ thi, Ngày 

thi, . Tự nhập liệu vào danh sách 10 sinh viên và lưu với tên DanhsachSV.docx. 

2. Tạo Biểu mẫu như bên dưới và lưu thành tập tin TuyenSinh.docx. 

3. Thực hiện chức năng mail merge để import dữ liệu vào Biểu mẫu. Cột phòng thi dựa vào 

giới tính: Nếu giới tính là Nam → Phòng IT01, là Nữ → Phòng IT09 

4. Lưu danh sách các mẫu sau khi trộn với tên: ThuTuyenSinh.docx,  tạo password cho tập 

tin. Sau đó nén tập tin lại và đặt password cho tập tin nén. 

 

 
  ---------  -----------  
➢ Kính gửi: ......................................................................................................  

➢ Ngày sinh: ...................................................................................................  

➢ Giới tính: .....................................................................................................  

Tại trường PTTH Nguyễn Đình Chiểu để dự thi kỳ thi tuyển sinh 

đại học năm 2014. Khi đi thi nhớ mang theo: 

 Giấy báo thi 

 Giấy chứng minh nhân dân photo 

 Giấy báo tốt nghiệp PTTH 

Họ tên thí sinh Giờ thi Ngày thi Phòng thi 

    

Yêu cầu 2:Trình bày theo mẫu và dùng Link TextBox cho hai Text Box. 

 
 

 

Lặng xuôi năm tháng êm trôi 

Con đò kể chuyện một thời rất xưa 

Rằng người chèo chống đón đưa 

Mặc cho bụi phấn giữa trưa rơi nhiều 

Bay lên tựa những cánh diều 

Khách ngày xưa đó ít nhiều lãng quên 

Rời xa bến nước quên tên 

Giờ sông vắng lặng buồn tênh tiếng cười 

Giọt sương rơi mặn bên đời 

Tóc thầy bạc trắng giữa trời chiều đông 

Mắt thầy mòn mỏi xa trông 

Cây bơ vơ đứng giữa dòng thời gian... 

 

 

Tạo trích dẫn 

 Gôlôbôlin ( 2003 ) Danh ngôn về người Thầy 

mình vừa mới xây xong, người nông dân mỉm cười 

nhìn đồng lúa mình vừa mới trồng, thì người giáo 

viên vui sướng khi nhìn thấy học sinh đang trưởng 

thành, lớn lên. 

There are no sources in the current document. 

(Gôlôbôlin, 2013) 

Nếu người kỹ sư vui mừng nhìn thấy cây cầu mà 
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icrosoft Word 

2013 giúp cho 

việc cộng tác 

biên soạn tài liệu và việc 

liên kết xuyên suốt một tài 

liệu dài trở nên dễ dàng 

hơn. Khi nhiều người 

cùng biên soạn chung một 

tài liệu, điều thú vị là họ 

có thể cùng nhau làm việc 

ngay trên cùng một tài 

liệu, mà không cần phải 

làm việc trên các phiên 

bản sao chép khác nhau 

của tài liệu đó. Mặt khác, 

các tính năng mới cũng 

tập trung vào việc làm cho 

các tài liệu đã hoàn thiện 

trở nên bóng bẩy hơn so 

với phiên bản cũ. Phiên 

bản mới của Word 2013 

giúp 

bạn truy cập vào những 

tính năng mới rất phong 

phú và cũng rất quen 

thuộc của Word trên trình 

duyệt và trên điện thoại di 

động. Vậy là giờ đây bạn 

có thể làm việc ở bất cứ 

đâu, trên desktop, laptop, 

trên các máy tính không 

có ứng dụng Word, trên 

điện thoại di động.

 

 

M 

  Bộ (Sở):………..           Mẫu số S02A-H 

  Đơn vị:……….. 

CHỨNG TỪ GHI SỔ 

Số CTGS : .................................  Ghi chú: ................................................................  

Ngày CTGS:...............................................................................................................  

 

Ngày Số CT Trích yếu Nợ Có Số tiền 

      

      

Kèm theo:  .................................................................................................. chứng từ gốc 

 

Lập, ngày … tháng … năm … 

                                       Người lập                                              Phụ trách kế toán 

                                    (Chữ ký, họ tên)                                         (Chữ ký, họ tên) 

 

𝑔(𝑥) = (1 + 𝑥)∞ +
𝑛𝑥

1!
+ ∬ 𝑥𝑦2

∞

1

𝑛(𝑛 − 1)𝑥2

2!
 

𝑓(𝑥) = √𝑎2 + 𝑏2 ± ∫ 𝑒−𝑥
∞

1

+ ∑ (
𝑛

𝑘
) 𝑥𝑘𝑎𝑛−𝑘

𝑛

𝑘=0

 

EQUATION 
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PHẦN EXCEL 
BÀI TẬP EXCEL 1 

(Nội dung chính: hàm dò tìm (VLOOKUP), chức năng rút trích 

 

1. Điền dữ liệu cho cột “NGÀNH THI” dựa vào ký tự thứ 1 của “MÃ SỐ” được dò trong 

bảng “BẢNG TRA ĐIỂM CHUẨN”. 

2. Điền dữ liệu cho cột “KHU VỰC” là ký tự thứ 2 của “MÃ SỐ” và được chuyển về 

kiểu dữ liệu số. 

3. Điền dữ liệu cho cột  “TỔNG ĐIỂM” là tổng của “ĐIỂM TOÁN”, “ĐIỂM LÝ” và 

“ĐIỂM HÓA”. 

4. Sắp xếp bảng tính theo “MÃ SỐ” tăng dần. 

5. Điền dữ liệu cho “ĐIỂM CHUẨN” dựa vào ký tự đầu của “MÃ SỐ” được dò trong 

bảng “BẢNG TRA ĐIỂM CHUẨN” nhưng nếu “KHU VỰC” là 1 thì lấy “ĐIỂM 

CHUẨN 1” còn nếu “KHU VỰC” là 2 thì lấy “ĐIỂM CHUẨN 2”. 

6. Điền dữ liệu cho “KẾT QUẢ” nếu tổng điểm lớn hơn hoặc bằng “ĐIỂM CHUẨN” thì 

điền “đậu”, ngược lại điền “rớt”. 

7. Thống kê tổng số thí sinh ngành “Kế Toán” có kết quả đậu. 

THÍ SINH CÓ KẾT QUẢ ĐẬU 

Kế Toán  

8. Dùng Advance Filter rút trích ra tất cả các thí sinh có kết quả “đậu”. 

9. Thêm cột “LỚP TÀI NĂNG” bên phải cột “KẾT QUẢ” và điền dữ liệu như sau: Nếu 

tổng điểm thi lớn hơn hoặc bằng 18 và không có môn nào nhỏ hơn 5 thì điền là “lớp 

tài năng”, còn ngược lại thì điền là “lớp đại trà”. 
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BÀI TẬP EXCEL 2 

(Nội dung chính: hàm dò tìm , chức năng rút 

 trích dữ liệu, các hàm thống kê) 

 

 

Câu 1: Lập công thức để điền dữ liệu vào cột TÊN HÀNG dựa vào hai ký tự đầu của MÃ 

HÀNG và BẢNG 1.  

Câu 2: Lập công thức điền vào cột TÊN TỈNH dựa vào ký tự thứ ba của mã hàng và 

BẢNG 2.  

Câu 3: Lập công thức điền vào cột SỐ LƯỢNG là ba ký tự cuối của MÃ HÀNG và được 

chuyển thành dữ liệu kiểu số.  

Câu 4: Lập công thức điền vào cột ĐƠN GIÁ, nếu sản phẩn được mua trước tháng 5 thì 

lấy giá 1, còn lại lấy giá 2.  

Câu 5: Lập công thức điền vào cột THÀNH TIỀN (VND): =SỐ LƯỢNG * ĐƠN GIÁ. 

Định dạng đơn vị VND.  

Câu 6: Lập công thức điền vào cột THÀNH TIỀN (USD):  

= THÀNH TIỀN (VND) /19000. Nếu sản phẩm được mua trước tháng 7 

=THÀNH TIỀN (VND)/20000. Nếu sản phẩm được mua sau tháng 7 

Định dạng đơn vị USD.  

Câu 7: Sắp xếp bảng tính theo thứ tự tăng dần dựa vào cột THÀNH TIỀN (VND)  

Câu 8: Dùng Advance Filter lọc ra các dòng có TÊN HÀNG là FUTURE.  

Câu 9: Thực hiện bảng thống kê sau:  

Tên hàng Tổng số lượng Tổng thành tiền VND) 

FUTURE   

Câu 10: Tạo Header là Họ và Tên SV ở vị trí trung tâm (center)  

BÀI TẬP EXCEL 3 
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Nhập và trình bày bảng tính như sau: 

 

Yêu cầu: 

1. Thiết lập điều kiện cho ba cột Toán, Lý, Hóa: điểm nhập >=0 và <=10. 

2. Chèn thêm hai cột Ngành thi và Khu vực vào bên trái cột Toán; Hai cột Tổng điểm và 

Điểm Chuẩn vào bên trái cột Kết Quả; Cột Học bổng vào bên phải cột Kết Quả. 

3. Lập công thức cho biết Khu vực và Ngành thi cho từng thí sinh. Biết rằng kí tự thứ 2 

của SBD cho biết khu vực; kí tự thứ nhất của SBD cho biết ngành thi. 

4. Tính Tổng điểm là tổng cộng của 3 môn thi. 

5. Lập công thức cho biết điểm chuẩn dựa vào ngành thi và bảng 2, nếu thí sinh ở khu 

vực 1 thì điểm chuẩn là Điểm chuẩn 1, ngược lại là Điểm chuẩn 2. 

6.  Lập công thức cho cột kết quả, nếu tổng điểm lớn hơn hay bằng điểm chuẩn của 

ngành dự thi thì kết quả là “Đậu”, ngược lại là “Rớt”. 

7. Lập công thức cho cột học bổng, nếu tổng điểm lớn hơn hay bằng điểm học bổng của 

ngành dự thi thì học bổng là “Có”, ngược lại để trống. 

8. Thực hiện bảng thống kê như trên. 

9. Trích những thí sinh thi Đậu của khối thi A. 

10. Vẽ biểu đồ (PIE) so sánh thí sinh Đậu và Rớt. 

 

BÀI TẬP EXCEL 4 
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(Nội dung chính: các hàm thống kê, đồ thị)  

STT 
Mã  

Dự Án 

Mã 

Khu Vực 

Loại 

Dự Án 

Chủ 

Đầu Tư 

Vốn  

Đầu Tư 

Năm 

Bắt đầu 

Năm 

Kết thúc 

Mức 

 ưu tiên 

Tiềm 

Năng 

1 XD1MNIDC     2011 2018   

2 TH2MBFPT     2011 2015   

3 XD1MTIDC     2011 2013   

4 TH1MBFPT     2010 2013   

5 DL3MBSGT     2010 2020   

6 TH1MNFPT     2011 2016   

7 DL3MTMLI     2009 2014   

8 XD1MNIDC     2007 2013   

9 DL2MTMLI     2011 2018   

 

 

Học viên thực hiện các yêu cầu sau: 

1) Định dạng bảng tính như trên, tạo Header là Họ Và Tên của học viên. 

2) Mã khu vực là ký tự thứ 4 và thứ 5 của cột mã dự án 

3) Loại dự án dựa vào 2 ký tự đầu của Mã Dự Án và bảng loại Dự Án 

4) Chủ đầu tư dựa vào 3 ký tự sau của Mã Dự Án và bảng Chủ đầu tư & Vốn đầu tư 

5) Vốn đầu tư dựa vào mã dự án và mã khu vực, tra trong bảng chủ đầu tư & vốn đầu tư 

6) Mức ưu tiên dựa vào ký tự thứ 3 của mã dự án 

7) Nếu số năm hoạt động <5 & Mức ưu tiên =1 thì ghi "Dự Án Tiềm Năng",  Ngược lại 

ghi "Không tiềm năng". 

8) Trích ra danh sách các dự án thực hiện vào năm 2011 

9) Làm bảng thống kê sau  

 

 

 

10) Vẽ đồ thị cho bảng thông kê ở câu 9 

Bảng Chủ đầu tư & Vốn đầu tư 

Mã Chủ đầu tư MN MB MT 

IDC Cty XD IDICO 100  tỉ 200  tỉ 500  tỉ 

FPT Tập đoàn FPT 800  tỉ 1000  tỉ 750  tỉ 

SGT Sài Gòn Tourist 500  tỉ 350  tỉ 200  tỉ 

MLI Tập đoàn Mai Linh 1000  tỉ 1500  tỉ 800  tỉ 

Bảng loại dự án 

Mã Loại Dự Án 

XD Dự án xây dựng 

TH Dự án tin học 

DL Dự án du lịch 

   Tổng Vốn Đầu Tư 

Sài Gòn Tourist   

Tập đoàn FPT   
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BÀI TẬP EXCEL 5 

 

KẾT QUẢ TUYỂN SINH NĂM HỌC  ??? 

Mã Số Họ  Và Tên Ngành Thi Khu Vực Toán Lý Hóa Kết Quả 

H101X Thị Nhung   5.0 8.0 7.0  
H102S Hồng Nguyệt   6.0 5.0 5.0  
C203X Văn Thao   2.0 6.0 3.0  
D240X Quang Đạo   9.0 9.0 7.0  
M205S Thu Thảo   5.0 5.0 4.0  
C106X Thị Huyền   10.0 8.0 8.0  
D107S Hồng Nhung   8.0 6.0 5.0  
M208X văn Thắng   4.0 3.0 5.0  

BẢNG 1:       BẢNG 2: 

Mã Ngành M D C H 
 Ngành thi Máy tính Điện Tử Cơ Khí Hóa Dầu 

Điểm chuần 1 19 16 15 14 
Điểm chuần 2 20 18 16 15 
 
 
 

I. Nhập dữ liệu cho bảng tính và định dạng như sau:  

− Orientation:  Portrait, Margin:  Horizontally 

− Header:  Họ tên thí sinh (Left), Bài thi Excel (Right) 

− Footer:  Số máy (Left), Phòng thi (Right) 

II. Lập công thức cho các cột: 

Chèn vào trước cột kết quả ba côt: Tổng Cộng, Điểm Chuẩn và Học Bổng. 

1. Dùng hàm lấy ra năm hiện hành "KẾT QUẢ TUYỂN SINH NĂM ???"  . 

2. Lập công thức điền dữ liệu cho cột Khu Vực, khu vực là ký tự thứ 2 của Mã số.  

3. Ngành Thi: Dựa vào ký tự đầu của Mã Số (Mã ngành) và Bảng 1.  

4. Điểm Chuẩn: Dựa vào ký tự đầu của Mã số (Mã ngành), Khu vực và Bảng 1. Trong 

đó, nếu thí sinh thuộc khu vực 1 thì lấy Điểm chuẩn1, ngược lại lấy Điểm chuẩn2.  

5. Tính Tổng cộng là tổng điểm của 3 môn.  

6. Hãy lập công thức điền Kết quả như sau: Nếu thí sinh có điểm Tổng cộng >= Điểm 

chuẩn của ngành mình dự thi thì sẽ có kết quả là "Đậu", ngược lại là "Rớt". 

7. Cột Học bổng lập công thức điền vào đó là "Có" nếu điểm Tổng cộng của thí sinh 

>= Điểm học bổng, trường hợp ngược lại để trống.  

8. Sắp xếp lại danh sách Kết quả tuyển sinh theo thứ tự tăng dần của cột điểm Tổng 

Cộng. 

9. Rút trích: thông tin của các thí sinh thuộc ngành thi Máy Tính . 

Mã ngành 
Điểm 

Học Bổng 
M 25 
D 23 
C 21 
H 19 
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BÀI TẬP EXCEL 6 

Nhà sách XYZ có hệ thống 2 chi nhánh. 

 

Yêu cầu: 

1. Tạo một Sheet Tổng kết cuối năm để tínhTổng số lượng sách đã bán. ( Dùng chức 

năng Consolidate ). 

2. Sử dụng chức năng SparkLine vẽ  đồ thị cho bảng thống kê của 2 chi nhánh. 

3. Vẽ biểu đồ cột cho bảng tổng kết của cửa hàng. 

4. Thực hiện chức năng Conditional Formatting, để đánh dấu số lượng cao nhất của từng 

loại sách. 
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BÀI TẬP EXCEL 7 

Doanh Thu Bán Hàng 

      
Tỉ giá 21000 

 

STT 
MÃ 

HÀNG 

LOẠI 

HÀNG 

TÊN 

HÀNG 

XUẤT 

XỨ 

SỐ 

LƯỢNG 

ĐƠN 

GIÁ 

THÀNH TIỀN 

(VNĐ) 

THÀNH TIỀN 

(USD) 

1 AS200HK               

2 AS300TL               

3 BN450TL               

4 AN200TQ               

5 AQ300TQ               

6 AS500TQ               

7 BQ220TL               

8 AI175TL               

9 BS450TQ               

10 AI400HK               

Tổng Tiền     

Bảng tra tên hàng & đơn giá Bảng tra xuất xứ 

Mã hàng Tên hàng Đơn giá 

S Sony Ericson 500 USD 

N Nokia 700 USD 

Q Q-Mobile 400 USD 

I Iphone 900 USD 
 

Mã 

hàng HK TQ TL 

Xuất xứ Hồng Kông Trung Quốc Thái Lan 
 

 Lập công thức cho các cột: (mỗi câu 1 điểm) 

1) Cột loại hàng dựa vào ký tự đầu tiên của mã hàng  

2) Cột tên hàng dựa vào ký tự thứ 2 của mã hàng và bảng tra tên hàng & đơn giá. 

3) Cột xuất xứ dựa vào 2 ký tự cuối của mã hàng và bảng tra xuất xứ . 

4) Cột số lượng dựa vào các ký tự thứ 3,4,5 của mã hàng . 

5) Cột đơn giá dựa vào mã hàng và bảng tra tên hàng & đơn giá, định dạng tiền tệ 

giống bảng tra . 

6) Cột thành tiền VNĐ= số lượng * đơn giá, định dạng 

tiền tệ giống bảng tra  

7) Cột thành tiền USD = thành tiền VNĐ / tỉ giá, chỉ lấy 

giá trị nguyên.  

8) Thực hiện bảng thống kê. 

9) Vẽ biểu đồ cho  bảng thống kê ở câu 8.   

TÊN HÀNG 
TỔNG 

TIỀN(USD) 

Sony Ericson   

Nokia   

Q-Mobile   

Iphone   
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BÀI TẬP EXCEL 8  

BẢNG DOANH SỐ BÁN HÀNG 

STT 
Mã 

hàng 

Tên 

hàng 

Ngày 

mua 

Số 

lượng 

mua 

Đơn 

giá 

mua 

Ngày 

bán 

Số 

lượng 

bán 

Đơn 

giá 

bán 

Tiền 

chênh 

lệch 

Tiền 

hoa 

hồng 

1 S100X   01/01/2011     01/01/2011  100       

2 S150Y   02/01/2011     05/02/2011  120       

3 M300X   01/01/2011     03/01/2011  250       

4 N310X   04/01/2011     02/03/2011  300       

5 D120Y   05/01/2011     05/01/2011  125       

6 N250X   01/01/2011     01/01/2011  200       

7 M120Y   01/02/2011     07/02/2011  100       

8 D100X   01/01/2011     01/01/2011  95       

9 S200X   09/01/2011     09/01/2011  170       

10 S120X   01/02/2011     10/02/2011  120       

Bảng tra 1 
 

Bảng tra 2 

Mã hàng Tên hàng Đơn giá mua 
 

Mã hàng S M D N 

S Sữa 300,000 
 

Giá 1 350,000 200,000 300,000 100,000 

M Muối 150,000  
 

Giá 2 320,000 190,000 270,000 90,000 

D Đường 250,000  
      

N Nước khoáng 75,000 
      

Học viên thực hiện các yêu cầu sau: 

1) Định dạng bảng tính như trên, tạo header là họ và tên của học viên. 

2) Tên hàng dựa vào ký tự đầu tiên của mã hàng và bảng tra 1 . 

3) Số lượng mua dựa vào 3 ký tự giữa của mã hàng . 

4) Đơn giá mua dựa vào tên hàng và bảng tra 1 . 

5) Đơn giá bán dựa vào ký tự đầu của mã hàng và bảng tra 2. Chú ý rằng nếu ký tự cuối của 

mã hàng là X thì chọn đơn giá 1, nếu ký tự cuối của mã hàng là Y thì chọn đơn giá 2. 

6) Tiền chênh lệch = Tiền bán – Tiền mua . 

7) Cột tiền hoa hồng được tính như sau: Nếu như số ngày tồn kho <3 và các mặt hàng phải 

được bán hết, thì tiền hoa hồng bằng 10% tiền chênh lệch . 

8) Dùng Advanced Filter trích ra những mặt hàng có số lượng bán >=200 . 

 

9) Thực hiện  bảng thống kê bên dưới . 

10) Vẽ đồ thị cho bảng thống kê ở câu 9 . 

Tên hàng Sữa Muối Đường Nước khoáng 

Tổng tiền chênh lệch 
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BÀI TẬP EXCEL 9 

BẢNG DANH MỤC SẢN PHẨM 

Học viên định dạng bảng tính và thực hiện các yêu cầu bên 

dưới: 

Bảng tỉ giá 
 

Tỉ giá 1 21  
Tỉ giá 2 22  

STT 
Mã 

hàng 

Tên 

hàng 

Ngày 

nhập 

Số 

lượn

g 

Đơn 

 vị 

tính 

Đơn 

giá 

Thành 

tiền 

USD 

Thành 

tiền 

VNĐ 

Ghi 

chú 

1 CF01X   01/01/2011             

2 CF02X   01/02/2011             

3 DG01Y   01/02/2011             

4 DG01X   01/04/2011             

5 NC01X   01/05/2011             

6 SU02X   01/06/2011             

7 CF03Y   01/09/2011             

8 SU01Y   01/10/2011             

9 DG03X   01/10/2011             

Bảng tra dữ liệu 1 
 

Bảng tra dữ liệu 2 

Mã hàng CF DG NC SU 
 Mã hàng Đơn giá 1 Đơn giá 2 

Tên hàng Cà phê Đường Ngũ Cốc Sữa 
 

CF 100 USD 95 USD 

Số lượng 15 75 40 150 
 

DG 2 USD 2 USD 

Đơn vị tính Bao ký Thùng Lốc 
 

NC 60 USD 55 USD 

      
SU 3 USD 4 USD 

1) Cột tên hàng dựa vào 2 ký tự đầu của mã hàng và bảng tra dữ liệu 1 . 

2) Cột số lượng dựa vào tên hàng và bảng tra dữ liệu 1 .  

3) Cột đơn vị tính dựa vào tên hàng và bảng tra dữ liệu 1 . 

4) Cột đơn giá dựa vào mã hàng và bảng tra dữ liệu 2. Nếu ký tự ngoài cùng của mã 

hàng là X   thì lấy đơn giá 1, là Y thì lấy đơn giá 2 . 

5) Cột thành tiền USD = đơn giá * số lượng . 

6) Cột thành tiền VNĐ = cột thành tiền USD * tỉ giá, biết rằng nếu hàng nhập từ tháng 1 

tới tháng 7 thì lấy tỉ giá 1, còn lại lấy tỉ giá 2 (1đ). 

7) Cột ghi chú: Nếu ký tự ngoài cùng của mã hàng là X thì ghi Hàng Ngoại, là Y thì ghi 

Hàng Nội. 

8) Thực hiện bảng thống kê bên dưới . 

Tên hàng Cà phê Đường Ngũ Cốc Sữa 

Tổng tiền(VNĐ)         

9) Vẽ biểu đồ cho bảng thống kê ở câu 8 .  

10) Tạo Header có tiêu đề Bài Thi Excel, Footer có tiều đề Họ Tên của học viên . 
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BÀI TẬP EXCEL 10 

 

CƯỚC PHÍ BƯU ĐIỆN 

STT 
Mã bưu 

kiện 

Nơi 

đến 

Phương 

tiện 

Hình 

thức 

Trọng 

lượng 

(gram) 

Giá 

cước 

Thành 

tiền 

1 MBUSN       500     

2 TLUSE       200     

3 TTAUE       50     

4 TLSIE       250     

5 MBUSN       150     

6 TTSIN       800     

7 TLAUN       250     

8 MBAUE       600     

 

GIÁ VẬN CHUYỂN  LOẠI PHƯƠNG TIỆN 

Mã  Tên nước Giá 1 Giá 2 Giá 3  
Mã phương 

tiện 
MB TT 

TL 

US USA 19000 18000 17000  
Tên phương 

tiện 

Máy 

bay 

Tàu 

thủy 

Tàu 

lửa 

FR France 17000 16000 14500     
 

AU Australia 14000 12000 11200     
 

SI Singapore 12000 10500 10000     
 

Câu 1. Tạo Header là “họ và tên sinh viên” ở vị trí trung tâm (center).  

Câu 2. Nơi đến: Dựa vào hai ký tự thứ 3 và thứ 4 của Mã bưu kiện và dò tìm trong bảng GIÁ VẬN 

CHUYỂN.  

Câu 3. Phương tiện: Dựa vào 2 ký tự đầu trong Mã bưu kiện và dò tìm trong bảng LOẠI 

PHƯƠNG TIỆN. 

Câu 4. Sắp xếp bảng tính theo Trọng lượng tăng dần.  

Câu 5. Hình thức: Nếu ký tự cuối của Mã bưu kiện là N thì ghi là “Bình thường”, ngược lại ghi  

“Nhanh”.  

Câu 6. Giá cước: Dựa vào hai ký tụ 3 và 4 của Mã bưu kiện và dò tìm trong bảng GIÁ VẬN 

CHUYỂN.  

✓ Nếu hai ký tự đầu của Mã bưu kiện là “MB” thì lấy giá 1 

✓ Nếu hai ký tự đầu của Mã bưu kiện là “TT” thì lấy giá 2 
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✓ Nếu hai ký tự đầu của Mã bưu kiện là “TL” thì lấy giá 3 

Câu 7. Thành tiền: = Trọng lượng * Giá cước, nếu hình thức gởi là “Nhanh” thì tăng 10% 

thành tiền. Định dạng đơn vị tiền tệ là “VNĐ”.  

Câu 8. Thực hiện bảng thống kê theo 

mẫu:  

 

 

 

Câu 9. Trích lọc danh sách các bưu kiện đi USA và có trọng lượng > 300 (gram).  

Câu 10. Đếm tổng số bưu kiện được giao hàng bằng “Máy bay” và có trọng lượng >300 

(gram).  

DOANH THU CÁC HÌNH THỨC GỬI 

Phương tiện Bình thường Nhanh 

Máy bay ? ? 

Tàu thủy   

Tàu lửa   
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BÀI TẬP EXCEL 11 

 

BẢNG 1 

STT HỌ TÊN 
MÃ SỐ 

ĐƠN VỊ 

SỐ 

LƯƠNG 

TÊN SẢN 

PHẨM 

ĐƠN 

GIÁ 

GHI 

CHÚ 

THƯỞN

G 

MỨC 

LƯƠNG 

1 TRẦN MINH APX1 24      

2 LÊ NAM BPX2 22      

3 NGUYỄN HOA APX1 31      

4 LÝ LAN CPX1 37      

5 LÊ AN CPX2 43      

6 NGUYỄN VŨ BPX1 20      

7 PHAN MAI APX2 24      

8 TRẦN HÙNG CPX2 19      

 

BẢNG 2 

 A B C 

Sản phẩm Nón Túi Xách Dây nịt 

Đơn giá 15,000 20,000 5,000 

 

Yêu cầu 

1. Nhập liệu và trình bày các bảng được cho như trên 

2. Điền cột TÊN SẢN PHẨM: Dựa vào 1 kí tự thứ nhất của MÃ SỐ ĐƠN VỊ và 

BẢNG 2 

3.  Điền cột GHI CHÚ: nếu 1 kí tự cuối của MÃ ĐƠN VỊ là 1 thì ghi “Phân xưởng 1”, 

ngược lại  ghi “ Phân xưởng 2” 

4. Dựa vào BẢNG 3 tính cột THƯỞNG 

5. Tính tóan cho cột MỨC LƯƠNG= SỐ LƯƠNG * ĐƠN GIÁ + THƯỞNG 

6. Chèn thêm cột PHỤ CẤP, biết nếu MỨC LƯƠNG thấp hơn 600,000 thì sẽ phụ cấp 

thêm cho đủ 600,000 . 

7. Chèn cột THỰC LÃNH = MỨC LƯƠNG + PHỤ CẤP 

8. Thực hiện bảng thống kê sau: 

 

 

 

9. Trích  danh sách những nhân viên thuộc đơn vị A 

10. Tạo Header (canh trái) có nội dung là Họ Tên Học Viên; Footer (canh phải) là số 

trang. 

 

BẢNG 3 

Số lượng Thưởng 

15 150,000 

20 200,000 

30 300,000 

Sản phẩm Nón  Túi xách Dây nịt 

Tổng số luợng    



  Giáo Trình Tin Học B 

Trang 263 

BÀI TẬP EXCEL 12 

 

Mã hàng Phân loại Xuất xứ 

Số 

lượng 

(m3) 

Giá nhập Giá bán 
Doanh 

thu 
Thuế 

okal1m     20         

okal2m     23         

vnia1i     34         

okal1i     21         

vnia2i     41         

vnia1m     22         

okal2i     15         

vnia2m     35         

        
   

 
Bảng tra 

   

 
okal1 okal2 vnia1 vnia2 

   
m 100 80 200 180 

   
i 130 90 195 180 

   

        

   
Tổng lợi nhuận từng mặt hàng     

   
  okal1 okal2 vnia1 vnia2 

   
m         

   
i         

 

1. Dựa vào ký tự thứ 5 của mã hàng điền vào cột Phân loại 

2. Dựa ký tự cuối của mã hàng điền cột xuất xứ: nếu là "m" ghi là "malaysia", còn lại ghi 

"indonesia" 

3. Điền giá nhập dựa vào bảng tra 

4. Điền cột giá bán theo quy định sau:  

 - Đối với mặt hàng của "malaysia" : nếu hàng loại 1 thi giá bán > giá nhập 12%,  

 hàng loại 2 thi giá bán hơn giá nhập 8% 

- Đối với mặt hàng của indonesia: giá bán hơn giá nhập 15% 

5. Cột doanh thu được tính như sau: (giá bán - giá nhập).   số lượng 

6. Cột thuế được xác định: nếu hàng loại 1: 5%doanh thu, hàng loại 2: 3% doanh thu 

7. Cột lợi nhuận = doanh thu - thuế 

8. Thống kê theo bảng "Tổng lợi nhuận các mặt hàng" 

9. Trích các mặt hàng malaysia loại 1 có lợi nhuận >324 

10. Vẽ biểu đồ bảng thống kê 

 

 

BÀI TẬP EXCEL 13 
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BẢNG TÍNH TIỀN THUẾ 

STT Số CT 
Tên 

Vật Tư 

Đối  

Tượng 

Đơn  

Giá 

Số  

Lượng 

Thành 

Tiền 

Tiền 

Thuế 

 AC20       

 BM12       

 CC50       

 DM60       

 DK30       

 AL40       

 BC70       

 AM80       

 CM90       

 BC15       

 BẢNG 1 BẢNG 2 

MÃ TÊN ĐỐI TƯỢNG TL TRỢ GIÁ 

A Quốc Doanh 10% 

B Công ty Cổ Phần 7% 

C Công ty TNHH 5% 

D Tư Nhân 3% 

BẢNG THỐNG KÊ 

Tên Vật 

Tư 

Số 

Lượng 

Màn Hình  

Đĩa CD  

Bàn Phím  

Linh Tinh  

 

1. Nhập dữ liệu, điền số thứ tự theo 001,002,003… 

2. Tính tên vật tư dựa vào bảng 2, tính tên đối tượng dựa vào bảng 1. 

3. Tính đơn giá dựa vào bảng đơn giá. 

4. Tính số lượng dựa vào các cột trong CT , và đổi thành số. 

5. Thành tiền = SL* ĐG. 

6. Tính thuế = Thành tiền* TL Trợ Giá( Số liệu TL Trợ Giá của từng Công Ty lấy từ 

Bảng 1) . 

7. Sắp xếp bảng theo thứ tự giảm dần của số lượng . 

8. Trích ra danh sách các đối tượng là Công Ty Tư Nhân. 

9. Tính Bảng Thống Kê, vẽ biểu đồ cho bảng thống kê. 

 

BÀI TẬP EXCEL 14 

 

MÃ M C K L 

Tên vật 

tư 

Màn 

Hình 

Đĩa CD Bàn 

Phím 

Linh 

Tinh 

BẢNG ĐƠN GIÁ 

Mã M C K L 

A 200 400 20 300 

B 105 410 21 290 

C 102 415 20 310 

D 210 420 23 320 
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Số báo danh Mã điểm 
Khối 

thi 

Trường 

thi 

Điểm 

Toán 

Điểm 

Hóa 

Điểm 

Lý 

Điểm 

Sinh 

Tổng 

điểm 

Kết 

quả 

DNTU-359-A 2.00-4.00-2.50                 

KHAD-277-A 4.25-5.25-5.50                 

DNLS-318-A 5.00-6.50-6.50                 

QSBK-769-A 4.25-1.50-0.75                 

QSTH-479-B 3.50-8.00-3.00                 

DNTU-356-B 5.00-2.00-5.50                 

KHAD-427-A 3.50-3.75-4.25                 

DNLS-205-B 9.25-2.25-6.00                 

QSBK-949-A 2.50-6.75-2.25                 

QSTH-872-A 6.75-3.50-4.75                 

DNTU-363-A 7.50-5.00-6.00                 

QSBK-568-B 8.00-4.50-9.00                 

 

Bảng Mã Tên Trường Điểm Chuẩn 

Mã 

Trường Tên Trường 

 Khối 

A 

 Khối 

B 

DNTU ĐH Công Nghệ ĐN 16 16.5 

KHAD ĐH Kinh Tế Q Dân HN 19   

DNLS ĐH Nông Lâm HCM 15 15 

QSBK ĐH Bách Khoa HCM 18.5 17 

QSTH ĐH Khoa Học HCM 15.5 17.5 

Yêu cầu: 

Câu 1. Điền Khối thi dựa vào ký tự cuối cùng của số báo danh. 

Câu 2. Điền vào tên Trường thi dựa vào 4 ký tự đầu của Số báo danh và tra vào 

bảng Bảng mã Tên trường. 

Câu 3. Điền vào Điểm Toán dựa vào 4 ký tự đầu của mã điểm chuyển sang số. 

Câu 4. Điền vào Điểm Hóa dựa vào 4 ký tự giữa của mã điểm chuyển sang số. 

Câu 5. Điền vào Điểm Lý dựa vào 4 ký tự sau cùng của mã điểm chuyển sang số. Nếu 

khối thi là A  khác bỏ trống. 

Câu 6. Điền vào Điểm Sinh dựa vào 4 ký tự sau cùng của mã điểm chuyển sang số. 

Nếu khối thi là B  khác bỏ trống. 

Câu 7. Tổng điểm là tổng số điểm 3 môn thi của thí sinh. 

Câu 8. Kết quả ghi là Đậu nếu tổng điểm lớn hơn hay bằng điểm chuẩn theo khối. 

Ngược lại là Rớt. 

Câu 9. Rút trích danh sách các thí sinh thi đậu. 

Bảng thống kê 

 
A B 

Đậu Rớt Đậu Rớt 

ĐH Công Nghệ ĐN     

ĐH Nông Lâm HCM     

ĐH Bách Khoa HCM     
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BÀI TẬP EXCEL 15 

 

 

Yêu cầu: 

   

Câu 1. Dựa ký tự đầu của mã thí sinh dò theo bảng điền tên trường. 

Câu 2. Dựa ký tự sau của mã thí sinh điền môn thí sinh thi 

Câu 3. Dựa vào điểm thi xếp loại kết quả của thí sinh. 

Câu 4. Dựa vào tên trường và môn thi đếm danh sách thí sinh thi từng môn ( Dùng 

công thức mảng ).   

Câu 5. Dựa vào tên trường và kết quả môn thi đếm danh sách loại thí sinh theo kết quả 

từng trường  ( Dùng công thức mảng ). 

Câu 6. Rút trích danh sách thí sinh đạt loại giỏi hay trung bình. 

Câu 7. Vẽ đồ thị  thống kê thí sinh dự thi.  

Câu 8. Vẽ đồ thị thống kê kết quả thí 

sinh dự thi.  

Câu 9. Sắp xếp bảng tính theo trường 

và dùng Subtotal đếm số thí 

sinh dự thi mỗi trường. 

BÀI TẬP EXCEL 16 
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 Tạo một Form Control theo mẫu: 

 

 Và tạo một Form để hiển thị và cho kết quả được vay bao nhiêu tiền như sau: 

 

 

- Các thông tin được truyền trực tiếp khi ta nhập liệu từ Form nhập 

- Số tiền được vay :  

o Nếu là Nam và Tài chính dưới 10 triệu thì được vay 5 triệu 

o Nếu là nữ và Tài chính dưới 10 triệu thì được vay 4 triệu. 

Trường hợp còn lại được vay 10 triệu 


